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including, but not limited to, implied warranties of merchantability and fitness for a particular purpose.
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Medicare Remit Easy Print About Medicare Remit Easy Print

About Medicare Remit Easy Print

Medicare Remit Easy Print enables you to print Medicare Part B and DME MAC HIPAA
835v5010 and 835v4010AL1 files to a format that is similar to the Standard Paper
Remittances (SPRs).You can use Medicare Remit Easy Print to:

» view MREP Remittance Advices (see page 56)

» search MREP Remittance Advices (see page 81)

e print MREP Remittance Advices (see page 78)

e print reports about MREP Remittance Advices (see page 204).
You can install Medicare Remit Easy Print on a PC or on a network (see Pre-Installation
Checklist for Installation on a PC).

For general information about remittances, see
http://www.cms.hhs.gov/MLNProducts/downloads/RA_Guide_Full_03-22-06.pdf .
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Medicare Remit Easy Print What’s New

What's New

MREP adds a new Business Scenario (BS) field to the MREP Remittance Advice layout on the Claim
Detail screen and the Entire Remittance Report. When there is an adjustment at the service level or
claim level and the Claim Adjustment Reason Code (CARC) has an associated business scenario, the
business scenario number appears in the BS field on the same row with the Claim Adjustment Group
Code and the Claim Adjustment Reason Code (GRP/CARC).

Each CAQH CORE Code Combination Business Scenario associated with the selected claims;
remittance appears in the Claim Detail Glossary (when selected), the Glossary Tab, and the Entire
Remittance Report Glossary.

The MREP Code Description Tool title bar now displays the version number of the CAQH CORE
Code Combination list from which the business scenarios are derived.

The MREP Code Description Tool code list now includes the CAQH CORE Code Combination
Business Scenario numbers and their description text.

Core Business Scenario was added to the Notes window of the MREP Code Description Tool so that
when the details of a CARC appear, the associated Business Scenario, if applicable, appears.

Informational

MREP accepts remittances in the X12 835V5010A1 and X12 835V4010A1 formats. MREP no longer
accepts remittances in the X12 835Vv5010 format. However, since the X12 835V5010 format was only
used during the transition period from X12 835V40101A1 and was never implemented for use in
production, the User Guide refers to the X12 835V5010A1 format as X12 835V5010.

MREP Version 4.2 includes the CARC/RARC list published 10/1/2013. Future lists will be made
available individually and can be imported into MREP to keep the codes current. For more
information, see How to View the CARC and RARC Codes.
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Medicare Remit Easy Print Differences between MREP Remittance Advices and
Shared System SPRs

Differences between MREP Remittance Advices and Shared
System SPRs

It is important to understand that the Medicare Remit Easy Print Remittance Advice is a representation of the
HIPAA 835v4010A1 or the HIPAA 835v5010 transaction data. Although CMS has attempted to make the
Medicare Remit Easy Print generated Remittance Advice very similar to the Shared System Maintainer
generated SPR (received via mail), the printed information and data content at times may differ. So, the two
can be compared as long as there is an understanding of why they differ.

For example, the HIPAA 835v5010 transaction data contains reversal (mother) claim information and, in turn,
the Medicare Remit Easy Print Remittance Advice displays this information and uses it in the calculation of
the entire remittance “totals”. The CMS systems that create the file for the SPR received via mail have the
ability to “net” the claim information for adjustments prior to generating the SPR. The HIPAA 5010
transaction has no facility to convey the information to allow MREP to “net” the claim information for
adjustments prior to generating the Medicare Remit Easy Print Remittance Advice and, therefore, must do a
complete back-out of the original claim and “build” a new “adjusted” claim with the modified information.

Item Medicare Remit Easy Print Shared System

You must calculate the net. The net was calculated for you.
Claim Example #1 Claim Example #1
Original Claim 000000000001000 Adjustment Claim  000000000001001
Provider Paid -$100.00 Provider Paid -$20.00
Adjustment Claim  000000000001001
Provider Paid $80.00 Claim Example #2

Adjustments Provider Paid -$20.00 (overpayment) Adjustment Claim 000000000002001

Provider Paid $50.00
Claim Example #2
Original Claim 000000000002000

Provider Paid -$100.00

Adjustment Claim  000000000002001

Provider Paid $150.00

Provider Paid $50.00 (underpayment)

Always blank Is calculated for you
PREV PD
General Messages | Not displayed Is displayed

for Suppliers/
Providers (Provider
Bulletin Board)
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Medicare Remit Easy Print About This Guide

About This Guide

All personal health information has been replaced with fictitious information.
To use this guide, you need to have a working knowledge of Microsoft Windows.
For example, you need to know how to:

* access your desktop,

* use the Start menu, and

e use Microsoft Windows Explorer.

You also need to know common Microsoft Windows terminology. For example, Start >
Programs refers to the Programs option on the Start menu.

Need Assistance?
If you need assistance, please contact:

Email Your Medicare contractor

Phone Your Medicare contractor

PC Requirements

Recommended

Speed: 2.0 gigahertz (GHz) or faster
RAM (Random 256 megabytes (Mb) or above
Access

Memory)

Hard Disk 1 gigabyte (GB)

Space

Display 1024x768 High Color (16-bit)
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Medicare Remit Easy Print

Operating System Requirements

Operating System Requirements

Recommended:

Others:

.NET Framework:

Windows XP

Windows 7
Windows Vista
Windows 2000

2.0SP2

This application uses Visual Basic.Net, a Microsoft compatible language and,
like many applications that require an MS Windows platform, MREP requires a
.NET framework. More than likely one or more.NET frameworks were pre-
installed on your Windows operating system or Windows Update downloaded
a newer version on your PC. You must have .NET framework version 2.0 SP2
on each PC using the MREP Application.

Note: .NET frameworks 3.0, 3.5, and 4.0 include the 2.0 SP2 framework so
if one of these frameworks is present, .NET 2.0 SP2 does not need to
be installed separately. Windows 8 users may need to install or
enable the .NET 3.5 framework 3.5 on each PC that uses MREP.

If you do not have the necessary framework installed, you may receive a
message stating that this version of the framework is required during the
installation process and prompting you to install it.

i'.g!;l Medicare Remit EasyPrinkt 5I

Thig zetup requires the MET Framewark verzion 20, Please install the \MET Framework:,
and rur thig setup again. The MET Framewark can be obtained fram the web, ‘Would
wau ke to do this now’?

Yes Ma

By clicking Yes—and if you have access to the Internet—you are redirected to
the Microsoft web site to download the .NET framework 2.0 SP. Download
NetFx20SP2_x86.exe for 32-bit systems or NetFx20SP2_64.exe for 64-hit
systems. We do not recommend that you download a beta version of the .NET
framework if you are presented with this option on the Microsoft web site.

Outside of the application installation process, you may also visit the link to
Microsoft .NET Framework Version 2.0 Service Pack 2 at the Microsoft
website to transport directly to the location on the Microsoft web site to
download the 2.0 SP2 .NET framework version.

If you want to learn more about the 2.0 SP2 .NET Framework version and/or
determine if you need to install this version, you may visit

.Net Framework Developer Center at the Microsoft website.

Please follow the directions within the web site when using this link.

If you do not have access to the Internet and you receive a message to update
your .NET framework, you have to obtain a copy of the .NET framework from
Microsoft. The Medicare Remit Easy Print application does not work without
the appropriate .NET framework installed on each machine accessing the
application.
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Medicare Remit Easy Print Operating System Requirements

Decompression To download the Medicare Remit Easy Print program from your Medicare
Application: contractor’s web site, you must have the following:

* Access to the Internet.

* WinZip or a compatible decompression application to extract files. If you do
not have a decompression application, you can go to a number of web sites
to acquire one (For example: http://www.winzip.com/downwzeval.htm.)
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Medicare Remit Easy Print How Does Medicare Remit Easy Print Get Medicare
Remittance Info?

How Does Medicare Remit Easy Print Get Medicare
Remittance Info?

You have to import Medicare remittance information into Medicare Remit Easy Print. For
more information about importing, see Importing HIPAA 835 files.

The files that you import are the ANSI files. For more information about the format of these
files, see Appendix A: MREP RA/HIPAA 835v5010 Segment Field Crosswalk.

When Medicare Remit Easy Print reformats and saves a copy of an HIPAA 835 file, it is
called the Import file. For information about how EasyPrint names the Import files, see Import
File Name Format.

Medicare Remit Easy Print keeps all of the Import files in the Import folder in the Medicare
Remit EasyPrint directory.

Information for Administrators

Medicare Remit Easy Print can be installed on a PC or network.

To install MREP:
e onaPC, see PC Installations
e on a network, see Installing Medicare Remit Easy Print on a Network

Network Installations

Medicare Remit Easy Print Directory
There must be sufficient space on the network to save the Import file(s).
The Medicare Remit Easy Print software takes about 3000 KB.

Users must have Read/Write access to the directory where the software is installed because the
software creates files and saves them using the user’s security privileges to the directory.

Medicare Remit Easy Print Access

If you need to make Medicare Remit Easy Print available to all users who log on, you need to
indicate this during the installation procedure.

Group Code MSI file

When installing the application on a network, each PC that accesses the application must have
installed the Group Code MSI file.

© 2005 General Dynamics IT Company. All Rights Reserved.
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Medicare Remit Easy Print Network Installations

Pre-Installation Checklist for Installation on a Network

Before you install Medicare Remit Easy Print, you need to complete these steps:

Description Completed
v

1 Check that the network, all PCs, and printers meet all requirements.
2 Check that you are using one of the supported operating systems.
3 Find out where the Medicare Remit Easy Print installation software is located.

The file name is: Medicare Remit Easy Print.msi
Write the location here:

4 Find out where the Medicare Remit Easy Print Group Code .msi file is:
The file name is: GroupCode.msi
Write the location here:

Note: The GroupCode.msi must be installed on all PCs executing EasyPrint
from a network location or any PCs that access network locations
from within the application.

When installed on a network drive, only the EasyPrint shortcut and
the GroupCode.msi package need to be installed on PCs executing
the application. There is no need to install the application on each
individual PC.

In order for each client PC to access the application: From the client
PC, navigate to the network location where Medicare Remit Easy
Print is installed, right click on the EasyPrint.exe file, and select
“create shortcut”. This shortcut can then be copied to the desktop of
the client PC. This step is necessary in the event the network drive
mapping is different on the client PC.

5 Create a folder called HIPAA 835 files and make sure that all users know the
location.

This folder must have adequate security for PHI.
Write the location for the HIPAA 835 files here:

6 Create a directory on the server for the Medicare Remit Easy Print
installation.

This directory must have adequate security for PHI.
Note: Do not install Easy Print in the C:\Program Files directory.
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Medicare Remit Easy Print Network Installations

m Installing Medicare Remit Easy Print on a Network

When you install Medicare Remit Easy Print on a network:
» install Medicare Remit Easy Print on the network

» install the Medicare Remit Easy Print Group Code on every PC accessing the
application.

Before You Install Medicare Remit Easy Print on a Network
Before you install Medicare Remit Easy Print:

» complete the Pre-Installation Checklist for installation on a network.

How to Install Medicare Remit Easy Print on the Network
Download Instructions
On your contractor’s website:
Important! 1. Select the Medicare Remit Easy Print link.

If this download . . . ] o . ]
cannot get past 2. Click the Medicare Remit Easy Print zip file. The File Download window opens.

your network -
firewall, please File Download X|

contact your

Medicare Same files can harm pour computer. IF the file infarmation belaw

contractor locks suspizious, ar you da nat fully trust the source, da not apen ar
’ zave this file.

File name: . MedicareR emitE azyPrint_zip
File type:  *Winip File

Framm: OFMO. ¥IPE. COm

Wwiould pou like to open the fle or zave it to your computer?

Open |

W Always ask before opening this type of file

Cancel | tore Infa

I
3. Click the Open button. The WinZip window opens.
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Medicare Remit Easy Print

Network Installations

D 0 By [

Z [k 9 [y &

et Open Favorites Add Extract Mail Encrypk Wigw CheckOut Wizard
o Mame Type Modified Size  Ratio Packed Path
ﬁlGroupCode. i windows Ins...  7/Sf2011 11:27 AM 4,272 65% 19,097
ﬁll\’ledicare Remit W Windows Ins...  7/502011 11;29 &M 2,161, 12%  1,906,...

Wiew Skyle

Selected O files, O bytes

Total 2 fles. 2Y64KE

00

4. To extract the file to the network, highlight GroupCode.msi and click the Extract button.

The Extract window opens.

Extract 21 x|
E stract ko
M, - A
I J 3' gl Cancel

Filez Folders/drives:
) Selected files #-] CAST -
& Alfles -] CLASSED

. @] COB —
CoRes [

Fie=: {:l COMAMnoN

{:l Comman Developre
{:l Contractidrnir
{:l Contracts

{:l Corporate Security
&1 CREW

[ Ovenwrite existing files
[ Skip older filaz

¥ Use folder names

Kl

™ Open Explorer window

A

5. Select the directory on your network where you want the GroupgCode.msi file to be stored.
Click the Extract button. You return to the WinZip window.
6. On the following line, write the name of the folder where you gaved the GroupCode.msi
file:
- - - - - - - - l
7. Highlight the MedicareRemitEasyPrint.msi file and click Extract.
8. Select the same location on your network where you saved the GroupCode.msi file. Click

the Extract button.
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Medicare Remit Easy Print Network Installations

Installation Instructions

1. Make sure you know the location of the Medicare Remit Easy Print.msi file (Step 3 of the
Pre-Installation Checklist for Installation on a Network.

2. Open Microsoft Windows Explorer and find the Medicare Remit Easy Print.msi file.
3. Double-click the Medicare Remit Easy Print.msi file:

ﬁ%‘h’ledicare Femit Easy Prink, msi

The Medicare Remit Easy Print Setup Wizard opens.

Welcome to the Medicare Remit Easy Print Setup
Wizard

The installer will guide you thraugh the steps required ta install Medicare Remit E azy Print an your
computer.

WARMIMG: This computer program iz protected by copyright law and international treaties.
Unauthorized duplication or distibution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be prosecuted to the maximum extent possible under the law.

Cancel

4. Click the Next button.

© 2005 General Dynamics IT Company. All Rights Reserved.
This document contains GDIT confidential and proprietary information,
which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs.

17



Medicare Remit Easy Print

The Select Installation Folder window opens.

iis.j- Medicare Remit Easy Print

Select Installation Folder

The inzstaller will install Medicare Remit Eagy Print ta the following falder.

Taoinstall in this folder, click "Mest". Toinstall to a different folder, enter it below or click "Browse".

Folder:
T:\Easy Print Files\

Dizk Cost. .. |

o uzes this computer:

Install Medicare Remit Easy Print for pourself, or for angor

{e Everyone

O Just me

Cancel | < Back

Network Installations

5. Click Browse to find the network location for the install. The applications and associated

files are located in the T:\Easy Print Files\ folder.

6. On the following line, write the location where you are saving the application and where

all of the associated folders and files are to be saved:

Note: Do not install Easy Print in the C:\Program Files directory.

7. Select Everyone and click the Next button.

The Confirm Installation window opens.

iisj— Medicare Remit Easy Print

Confirm Installation

The installer iz ready to install Medicare Femit Eazy Print on your computer.

Click "Mext" ta start the installation.

Cancel ¢ Back
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Medicare Remit Easy Print Network Installations

Best Practice:
Make the shortcut
to the Medicare
Remit Easy Print
executable
available to all
users.

Important!
You must install
the Medicare
Remit Easy Print
Group Code on
each PC.

8. Click the Next button.
When the installation is finished, the Installation Complete window opens.

ii,? Medicare Remit Easy Print

Installation Complete

Medicare Remit Eazy Print hag been successfully installed,

Click "Close" to exit

Pleaze uze Windows | pdate to check for any critical updates to the .MET Framewark.

Cancel

9. Click the Close button.

The Medicare Remit Easy Print shortcut is available in the Medicare Remit Easy Print
directory. Copy this shortcut to your desktop.

10. Complete the Medicare Remit Easy Print Group Code installation on each PC.

What Happens During the Installation Process?

The following items are created and placed in the directory you designated under the Medicare
Remit Easy Print folder in Step 8 of the Installation Instructions:

» EasyPrint.exe
» Easy Print icon - shortcut
» Import folder - where all active converted HIPAA 835 files are stored

» Archive folder - where all inactive converted HIPAA 835 files are stored. (Inactive
files are files not currently viewed in the application.)

» Report Export folder - where all exported Report files are stored
» Resource folder - internal folder to application
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Installing the Medicare Remit Easy Print Group Code on the

PC

After you install the Medicare Remit Easy Print application on the network, you must install
the GroupCode.msi file on every PC that needs to access the application.

How to Install the Medicare Remit Easy Print Group Code

1.

Make sure you know the location of the Medicare Remit Easy Print Group Code file (Step
4 of the Pre-Installation Checklist for Installation on a PC.

Open Microsoft Windows Explorer and find the Medicare Remit Easy Print Group
Code.msi file.

Double-click the Medicare Remit Easy Print Group Code.msi file.

EE;E;! GroupCode. msi
The installation completes without opening any windows or displaying any messages.

How to Know that the Medicare Remit Easy Print Group Code Install
Completed Successfully

If the installation DID complete successfully, the PC user can open Medicare Remit Easy
Print.

If the installation DID NOT complete successfully, the PC user cannot open Medicare Remit
Easy Print is presented with an unhandled exception dialog.

Hint: -
If you see this error  LestdsilEsials X

& Application has generated an exception that could not be handled.

message on the PC,
you need to install
the Medicare Remit
Easy Print Group
Code.

You need a minimum
screen resolution of
1024 X 768.

Process id=0x828 (2088), Thread id=0x7b4 (1972].

Click, OF ko terminate the application.
Click CAMCEL ko debug the application.

Ik Zancel

-
v

Click OK and install the Medicare Remit Easy Print Group Code again.
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(]
.
PC Installations
Medicare Remit Easy Print Setup Software
For users to load the software on their PCs, they must know the location of the Medicare
Remit Easy Print Setup file.
Best Practice:  The file name is:
Create a folder ) . . .
called HIPAA Medicare Remit Easy Print.msi
835 files to

store your 835 HIPAA 835 File Location
files, and make Users must know the location from which to download the HIPAA 835 file they receive from

sure that all . .

users know the their Medicare contractor.

location. Medicare Remit Easy Print Directory
There must be sufficient space on the PC for Medicare Remit Easy Print to save the Import
file(s).

The Medicare Remit Easy Print software takes about 3000 KB. The size of the Import file(s) is
dependent upon the number of claims found in the HIPAA 835 file.

Medicare Remit Easy Print Access

The default for installing Medicare Remit Easy Print is to have it be accessible only to a single
user on a PC.

Getting Started
To get started:

1. Complete the Pre-Installation Checklist for Installation on a PC.

2. Install Medicare Remit Easy Print on your PC (see page 19).
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Medicare Remit Easy Print

Pre-Installation Checklist for Installation on a PC

Before you install Medicare Remit Easy Print, you need to complete these steps:

Description

1

Check to be sure that your PC and printer meet all requirements.

PC Installations

Completed
v

2

Check to be sure that you are using one of the supported operating systems.

Find out where the Medicare Remit Easy Print install file is located.
The file name is: Medicare Remit Easy Print.msi
Write the location here:

Find out where the HIPAA 835 files are located.
Write the location here:

Create a directory on the PC for the Medicare Remit Easy Print installation.
This directory must have adequate security for PHI.
Note: Do not install Easy Print into the C:\Program Files directory.
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Installing Medicare Remit Easy Print

Before You Install Medicare Remit Easy Print
Before you install Medicare Remit Easy Print:

e Complete the Pre-Installation Checklist for Installation on a PC

How to Install Medicare Remit Easy Print on Your PC
Download Instructions
On your contractor’s website:
Important! 1. Select the Medicare Remit Easy Print link.
If this download . ] . S
cannot get past 2. Click the Medicare Remit Easy Print zip file.

your PC security . .
settings, please The File Download window opens.

contact your File Download x|

Medicare carrier.
Some files can harm pour computer. IF the file information belaw
looks suzpicious, or you do nok fully trust the zource, do not open or

zave this file.

File narme: ...MedicareR emitE azyPrint. zip
File type:  *WinZip File

From: 02MO. vips. Com

Would pou like to open the fle or 2ave it to your compuber?

Cancel Fare Infa

¥ Alfays ask before opening thiz type of file

/
3. Click the Open button.
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Best Practice:

Create a folder
called HIPAA
835 files to
store your 835
files, and make
sure that all
users know the
location.

The WinZip window opens.

NinZip - MedicareRem asyPrin D u E
~ B = o S R N -
& 'ﬂ.nﬁ |@ e |Ls B | ﬁ 7 i“éj -
Q L 9 NoB \% KA N\ = gy giz|=
et Open Favorites Add Extract Mail Encrypk Wigw CheckOut Wizard Wiew Skyle
2| Mame Tvpe Modified Size  Ratio Packed = Path
ﬁlGroupCDde.msi WindowgIns...  7/5/2011 11:27 AM 54,272  65% 19,097
ﬁlMedicare Reggjt Easy Prink.msi  Windgfes Ins...  7/5/2011 11:29 AM 2,161,152 12% 1,906,...
< | >
Selected 1 file, 2111K5/ Total 2 files, 2Y64KE 00
=

4. To extracg({e file to the network, highlight Mediw\reRemitEasyPrint.msi and click the
Extract b(tton. The Extract window opens.

Extract (x|

Estract to:
M, ~
I J El =y Cancel |

Filez Folders/drives:
£ Selected files F-] CasT ﬂ Help |
Al files &+ CLASSED —

. w1 COB —
i~ Files: I {:I comfman
-y Commaon Developme
£ ] Contract&dmin

[ Dwerwiite existing files

[ Skip older fil=z % Contracts

- Corparate 5 ecurity
v Use falder names {:I CREW -
[ Open Explorer window ﬂ | L

A

5. Select the directory opryour network where you want the MedicareRemitEasyPrint.msi file
to be stored.

6. Click the Extract button. You return to the WinZip window.

7. On the following line, write the name of the folder where you saved the
MedicareRemitEasyPrint.msi file:

Because you are not installing the software on a network to be shared by other users, you
do not need to copy the GroupCode.msi file.
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Installation Instructions

1. Make sure you know the location of the Medicare Remit Easy Print.msi file (Step 3 of the
Pre-Installation Checklist for Installation on a PC.

2. Open Microsoft Windows Explorer and find the Medicare Remit Easy Print.msi file.
3. Double-click the Medicare Remit Easy Print.msi file:

ﬁ;E;r'Medicare Remit Easy Print. msi

The Medicare Remit Easy Print Setup Wizard opens.

Welcome to the Medicare Remit Easy Print Setup
Wizard

The inztaller will quide yau thraugh the steps required ta install Medicare Remit E azy Print ah pour
comnpLter.

WARMIMG: This computer program is protected by copyright law and international treaties.
Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be prozecuted to the maximurn extent possible under the law.

Cancel

4. Click the Next button.
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The Select Installation Folder window opens.

jil§! Medicare Remit EasyPrint = =]

Select Installation Folder B
St |

L |

The installer will inztall Medicare Remit EasyPrint ta the following folder.

Toingtall in thiz folder, click "Mest". Taoinztall o a different folder, enter it below or click
"Browse',

Folder:

|T:\Eas_l,l Print Files Browse. .. |
Dizk. Cost... |

Install Medicare Remit EasyPrint for yourself, or for anyone who uses this computer:

{~ Eweryone
i Justme

Cancel | < Back | Meut > I

A

11. Click Browse to find the location of the Easy Pyint files on your PC. This is where the
application and all the associated files are stgred.

12. On the following line, write the location where you are saving the application and where

to save all of the associated folders and

Note: Do not install Easy Print in the C:\Program Files directory.
13. Select Just me and click the Next button.
The Confirm Installation window opens.

ii,? Medicare Remit Easy Print

Confirm Installation

The installer iz ready to install Medicare Remit Easy Print on pour computer.

Click "Nest"" ta start the installation.

Cancel < Back
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14. Click the Next button.
When the installation is finished, the Installation Complete window opens.

ii,? Medicare Remit Easy Print

Installation Complete

Medicare Remit Eazy Print hag been successfully installed,

Click "Close" to exit

Pleaze uze Windows | pdate to check for any critical updates to the .MET Framewark.

Cancel

15. Click the Close button.

The Medicare Remit Easy Print shortcut is available in the Medicare Remit Easy Print
directory. Copy this shortcut to your desktop.

What Happens During the Installation Process?

The following items are created and placed in the directory you designated under the Medicare
Remit Easy Print folder in Step 8 of the Installation Instructions:

EasyPrint.exe
Easy Print icon (shortcut)
Import folder (where all active converted x835 files are stored)

Archive folder (where all inactive converted x835 files are stored. Inactive files are
files not currently viewed in the application)

Report Export folder (where all exported Report files are stored)

Resource folder (internal folder to application)
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Starting Medicare Remit Easy Print

You can find shortcuts to the Medicare Remit Easy Print program in 2 places:

* Your PC desktop:

L , q .
e The Start > Programs menu; 5= Medicare Remit Easy Prink

Before You Start Medicare Remit Easy Print
Before you start Medicare Remit Easy Print, you must:
» Install Medicare Remit Easy Print (page 19).

* To determine the location of the HIPAA 835 folder or where your HIPAA 835 files
are stored, complete Step 4 of the Pre-Installation Checklist for Installation on a PC.

How to Start Medicare Remit Easy Print
1. To start Medicare Remit Easy Print, double-click the Medicare Remit Easy Print shortcut.

The first time that you start Medicare Remit Easy Print, or when you don’t have any
Remittance files in the Import folder you see the “No Remittance Files Found” dialog.
Click or select the OK button to close the dialog.

NO REMIT FILES FOUND El

@ Mo REMITTANCE FILES FOUMD

Click 0K, then select the IMPORT option ko
impaort an electronic remittance.

Click the OK button.

© 2005 General Dynamics IT Company. All Rights Reserved.
This document contains GDIT confidential and proprietary information,
which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs.

28



Medicare Remit Easy Print PC Installations

Medicare Remit Easy Print opens with the Import button ready:

Ep Medicare Remit EasyPrint ¥2.40

2. Click the Import button.
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A file dialog window opens permitting you to select the HIPAA 835 file to import.

Import ANSI x12 835 ERA K1 E3

Look in: Im Desktop j & =k B
|
2 A
My Network Acrobat Adobe Q53270 Shaglt B

Places Distiler 6.0 Reader 7.0 PLUS

Snaglt Studio  Documentsz EazpPrint  Framebdaker Tracl T-Rex

E
|,
WiebEx Player  ‘windows
tedia Flayer

Filz name: I j DOpen I

Files of type: I j Cancel |
7

3. Select the HIPAA 835 file that you want to import by double-clicking it.
Medicare Remit Easy Print starts the import to let you know that it is importing:

Importing electronic remittance(s)...
ANNRNEN
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Menus

Toolbar —

List of
Remittance
Advices

Claim List
tab is active

List of claims
for the
highlighted
Remittance

After the import is finished, the Remittance Advice List window appears.

.Medicare Remit EasyPrint ¥3.2 10l x|

File Tab ‘iew Report Search Tools Help

. f Impart

_PReport - _Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List

Payer Name Payee Mame Filens
ARES INSURANCE TANS INC, ] 04 ; 451.7 005

K | ]
Claim List Clairn Detail I Rermit Summary Data Yiew I Search I Glossary I
Narne | ACNT | jan] | Biled Amount | Paid amourt | From Date | ToDate | A
Ooce, sally 1111111 123456789012345 -910.50 -402.53 2/10/2004 2j10/2004 :
Ooce, saly 1111111 123456789012345 910,50 55728 2/10/2004 2/10/2004 .
DDDE, Sally 1111111 123456789012345 358,20 12,50 2{11{2005 2/11/2005 b
DRight, Samuel 1111111 123456789012345 237.60 159,36 3{28{2005 3/28/2005 b
DDDE, Sally 1111111 123456789012345 406,20 32.67 2{10{2005 2/10/2005 b
Oooe, saly 1111111 12345678901 2345 148,80 92,42 3i9/2005 3/9/2005 :
DOright, Samuel 1111111 12345678901 2345 40,00 000 12/220200% 12/22/2003 :
V'S V'S V'S A A A
4] | H
L Print | A checkAl | [JunCheck Al I pata

Segment dount = =206 12/6/2011

Bene Internal ! nternall Total Total Earliest Latest

namef(s) account cort;tro billed provider From To Date
number(s) numl er(s) amount paid Date of of

N(C al;m for the amount  service service

umber) claim for the on the on the

claim claim claim
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Medicare Remit Easy Print Locating MREP and MREP File Locations on Your PC/Network

Locating MREP and MREP File Locations on Your PC/Network

Locating the MREP Application on Your PC/Network — Icon
Available

1. With your mouse, right click on the icon on your desktop.
LN

AL

EaswPFrink

Q Open

Send To 3

Cuk
Copy

Create Sharkouk
Delete
Fename

Properties
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2. Go to Properties, Shortcut, Start in and you see the directory where the Medicare Remit
Easy Print directory is located.

r ™)
#=| EasyPrint Properties M

Security | Details I Previous \ersions
General | Shortcut | Compatibility

IJE% EasyPrint

Target type: Application

Target location:

Target: Medicare Remit EasyPrint

Start in: "C\Medicare Remit EasyPrirt™."

Shortcut key:  MNone

Run: [ Momal window - ]

Comment:

COpen File Location Change lcon...

OK || Cancel Apply
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Locating the MREP Application on Your PC/Network — Icon not
Available

1. Click the Start menu.

2. Select the ‘Search’ function.

3. Select “For Files or Folders’.

m Prograrns b

e Favorit »

1. Favorites
= 2 Documents b
=y
A [l Settings 3
2
C 8 .. | ForFiles or Folders, ..
R e <

h &) Onthe Internet, ..

o
e ﬂ,-' Help and Support &‘] Find Printers...
0
E =7 Run... '@ Using Microsaft Gutlook. ..
-E € For People. ..
Ed | 0] shut Down, ..
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4. Select “All files and folders’.

B Search Results =101 x|
J File Edit Wiew Favorites Tools |J "‘jﬁ kd r ”ﬁi!_'::' | & (32X B | - | #
| address | ] Search Results / =
Search Companion X IName | In Folder | Size | Type | [

To start wour search, Follow the instructions in the left pane.

What do you want to
search for?

Pickures, music, of Aideo

Documents (wgrd
processing, spreadsheet,
ekc.)

all Files a

Printers, computers, ar
people

) Information in Help and
Support Cenker

‘fou may also wank ko,

Q Search the Internet
Change preferences

l

A

|0 objects
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5. Type ‘Medicare Remit Easy Print’ or the name you saved your MREP software under in
*All files and folders’.

6. Select ‘My Computer’ from the ‘Look In’ drop-down box.

(S _inix)
| Fle Edt Wiew Favorites Tools Help |J Q-5-2 Hﬁ |l @ X 9| @ | 2

J Address Id Search Results j
Search Companion % | | Mame | 1n Folder | Size | Type |t

To skart yt{)\{ search, follow the instructions in the [eft pane.

Search by any or all of
the criteria below.

all or part of the File name:

| Medicare Remit Easy Print

& word or phrase in the File:

Look in:

I ff My Computer j
When was it modified? b
What size is it? [ 4

More advanced »
options

Back | Search I

=g
N

0 objects \

7. Click the S\earch button.
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Identifying Easy Print File Locations

This tool contains the current path to folders containing the files that Medicare Remit Easy Print
uses. In most cases, these paths never need updating. But, in certain situations, the user may want
to override the default locations of these folders.

1. To identify the necessary files/resources that Medicare Remit Easy Print is using, select
Path Name Editor from the Tools menu.

OMedicare Remit EasyPrint ¥3.2 -10] x|
File Tab Wiew Report Search | Tools Help

’Import | PReport - :Delete q Search | Prink List

Payer Name Payee Name Restofe heck Date i Version
AREA INSURANCE | ACME PHYSICIRREELLAVEEE !

I%rt Code Descriptions

Kl | |
Claim List | Claim Detai I Remit Summary Data Yiew | Search | Glossary |
Marne | ACHT | Jan] | Biled Amaunt | paid amourt | From Date | ToDate | A
Ooce, sally 1111111 123456789012345 -910.50 -402.53 2/10/2004 2/10/2004 :
Ooce, sally 1111111 123456789012345 910,50 55728 2/10/2004 2/10/2004 .
Ooce, sally 1111111 123456789012345 38.20 12.50 2(11/2005 2j11/2005 .
DRight, Sarmuel 1111111 123456789012345 237.60 159,36 32812005 3f28/2005 b
Ooce, sally 1111111 123456789012345 406.20 32,67 2{10/2005 2j10{2005 .
Ooce, sally 1111111 123456789012345 148,80 92,42 3i9/2005 3/9/2005 .
Oright, saruel 1111111 123456789012345 40.00 0,00 12i222003 12/22/2003 .
1] | B
Print EA check all [Juncheck &l @ Data
Segment count = =206 12f6f2011
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2. The folder locations window appears showing the current folder location settings.

e it
Medicare Remit Easy Print Path Mame Editor .
This dialog contains the current paths to the folders Easy Print uses to locate the resources as indicated. In
mast cases, the values here will never need updating. In certain situations, you may want to override the
default locations of thesefolders.
Imported files : |C: \Medicare Remit EasyPrint\Import)| | | Browse |
Archive files : |C: \Medicare Remit EasyPrint\archive’, | | Browse |
Exported reports : |C: \Medicare Remit EasyPrint\ReportExport! | | Browse |
X835 native files : |C: \Medicare Remit EasyPrint\Matived3s) | | Browse |
Resource files : |C: \Medicare Remit EasyPrint\Resource’, | | Browse |
Save Default Cancel
L -

The Imported files: folder contains those files once the native 835 files have been
imported into Medicare Remit Easy Print.

The Archive files: folder contains those files that have been archived from Medicare
Remit Easy Print.

The Exported reports: folder contains those report files where the user chose to export
the reports rather than printing them.

The X835 native files: folder contains the native 835 files that are imported into
Medicare Remit Easy Print.

Note: When an issue is reported and the GDIT MREP Team requests that the file be sent
for further investigation, this is the type of file that needs to be sent. The file has a
“.txt” extension.

Identify the file/remittance advice that is in question or causing an issue.

For the provider/supplier community, send a copy of this file to your contractor
and your contractor should send the same file to the GDIT MREP Team.

The Resource files: folder contains the necessary internal files (004010X091A1.FLD or
005010x221A1.FLD and loop.str) for Medicare Remit Easy Print to run. The Codes.ini
file is also in this folder, but it is not required for Medicare Remit Easy Print to run. (Note:
The Codes.ini file contains the descriptions of the Reason and Remark codes. If it is not
present, the user receives a generic default message for each Reason and Remark code.)
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Buttons
Save changes made to the folders
Save
Default Reset the values for the files back to what they were when the
Medicare Remit Easy Print application was initially installed
Cancel Exit the Medicare Remit Easy Print Folder Locations display box
without saving changes
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Medicare Remit Easy Print

Uninstalling Medicare Remit EasyPrint

Uninstalling Medicare Remit EasyPrint

1. Navigate to the Windows Control Panel Add/Remove Programs.

From the taskbar, click Start > Control Panel.

The control panel window opens.

B Confraol Panel

File  Edit Wiew Fawvorites Tools  Help
e & @ X ) > |i Address |G- Caontral Panel V|
{ \‘;. A - e
Faolder Faorits Mhail Acceszibility Addar Eroadeom Eroadcom
Cptions Options Remow..  ASFComfi.. Control Sui...
= & Fa N L5
= ; \_) \%b ‘ Install or retove programs and vindows con
Add Internet Maouse Keyboard MNetwork Portable  Printers and
Hardware Options Connections  Aedia.. Faxes
@ » 2 P 9 @A ® G
@ S8 U 9 4 |
Regiohal and Gane Scankers and  Scheduled  Sounds and Taskbar and User Powrer
Language ... Cowtrollers Cameras Tasks Audio e Start Menu Accounts Options
@ ¥ L 2 O F P B
QuickTime System Phone and Durte and Security Speech Symantec W indowrs
Modemn Titne Center LiveUpdate aedia ..
X { i
¢ % e @ <
Jawa, Automatic Windows  Intel(R)GMA  Wireless Corel
Updates Firewall Driver Metwa... Wersions 2
38 ohjects ' My Computer

Windows 2000/XP control panel
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2. Remove the Medicare Remit Easy Print Application.
» Double click the Add/Remove Programs icon in the Control Panel.

» Select Medicare Remit Easy Print from the resulting list.

L
\E‘ﬂ Currently installed programs: [ Show updates Sort by
Chqngg ar T LIVEUPOUIE &0 | IYIOre s COTpoTaimor a1Ze FrEAE A
Retmove -
Pragrams ﬁl Macromedia Shockwave Player
%‘
Add Mew Last Used O
Programs .
from your computer, I
E] #3 Micrasoft NET Framewark 1.1 ¢ 36.15ME
Add/Remave q Microsoft Office 2000 SR-1 Professional Size 325.00ME
Windows
Camponents 6' Microsoft Office 97, Professional Edition Size  33.94ME
‘? Microsoft Office HTML Filter 2.0 Size 0.3ZME —
@ q Microsoft Office Sounds Size 0.56ME
Set Program
Access and ﬁ! Microsoft PYK Import (Remove only)
Defaults . . :
Microsoft Visio Web Component Tgetfology Preview Size 5.55ME
% Microsoft Visual Basic 6 @frofessional Edition Size L267.00ME
A ahirensnft Yisughd® WET Redistributahle Baskaos 11 Size e

 Click Remom click Yes on the confirmation dialog.

The Uninstall process is complete!
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Online Help System

The Medicare Remit Easy Print (MREP) Help online system allows you to look up
information about MREP from MREP itself instead of referring to the Medicare Remit Easy
Print User Guide. The online Help system is geared to the day-to-day tasks in MREP. It does
not include information regarding the technical aspects of installing or running MREP on a PC
or network.

How to Access the Online Help System
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon

]

The Medicare Remit Easy Print Claim List tab opens.

OMedicare Remit EasyPrint ¥3.2 -10] x|

File Tab Wiew Report Search Tools Help

.’Import | P Repark -

( Search | Prink List
Q |

A Arch% 7 Restore x Delete

Payer Name Payee Name Check Date Check/EFT ... Check{EFT Number Filenz
AREA INSURANCE | ACME PHYSICIANS INC. ] 04/23{05 005010x2214

Kl | i
Claim List Claim Det4l I Remit Summarty Data Yiew | Search | Glossary |
Name 1] ACHT | IcH | Biled Amourt | Paid Amount | FromDate | ToDate | &
Ooce, salky 1111111 123456789012345 -910.50 -402.53 2(10/2004 2/10/2004 :
Ooce, sally 1111111 123456789012345 910,50 55728 2/10/2004 2/10/2004 .
Ooce, sally 1111111 123456789012345 38.20 12.50 2/11/2005 2j11/2005 .
DRight, Sarmuel 1111111 123456789012345 237.60 159,36 32812005 3f28/2005 b
Ooce, sally 1111111 123456789012345 406.20 32,67 2{10/2005 2j10{2005 .
Ooce, sally 1111111 123456789012345 148,80 92,42 3i9/2005 3/9/2005 .
Oright, saruel 1111111 123456789012345 40.00 0,00 12i222003 12/22/2003 .
1] | B
Print EA check all l [J Unicheck all @ pata
Segment count = =206 ’ 12f6f2011

|

2. Click Help.
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Online Help System

Medicare Remit Easy Print opens the Medicare Remit Easy Print Help window and
displays the introduction.

Note: Be sure that the Medicare Easy Print Help dialog box is displaying the Contents tab
in the left frame of the window.

w = & O

=h

=& x|
Hide  Back  Frt  Opfions
LContent: - m - - ;I
Corlent |l | geach | What is Medicare Remit Easy Print?
>3 Intraduc edicare Femit |
@ Making sense o

s Medicare Remit Easy Print (MREP}) is an Electronic
@ How 0. Remittance Advice (ERA) Search/Display tool for
B otking vih Reparts Windows 2000, Windows XP.
@ Maintainence :
[£] Uninstal

MREP allows healthcare providers to view, search, and

report claim payment information received from
Medicare electronically.
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How to Use the Contents Tab

1. To see what’s inside a book, click the + sign.

lslx]
n - & 0

Hide  Back  Pint Options

Cerlentz |l | geach | What is Medicare Remit Easy Print? 2
» Medicare Remit Easy Print (MREP) is an Electronic
[£) Medivare Remit Easy Print window Remittance Advice (ERA) Search/Display tool for
% DembisTab Windows 2000, Windows XP.
lsim Detail Tal
] Remit Summary Tab + MREP allows healthcare providers to view, search, and
5] DataView Tab report claim payment information received from
% g?amh TT‘ahb Medicare electronically.
lossary Tal
@ Houto
@ Working with Reports
@ Maintainence
[£] Uninstal
< | E
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2. Click a topic to display the topic.

E? Medicore Remit Easy printHelp = -loix

Hide Back Frint  Options

Contents s = < i =
= | ndes | Search | Medicare Remit Easy Print Main
@ Introduction - what iz Medicare Remit indow
= [ Making sense of...
Biftedicare Remit Easy Print window
£] Claim List Tab : aE :
% |:|::$ DIZtaiIaTab The main application window:
=] Remit Summary Tab
E] DataView Tab Bg Medicase Renit Ea:
B Men Hepat Sst
E] Search Tah atr # .
£] Glossary Tah Toolbar s | L
e — ]
@ Howto. ATITT"Q‘:':M :
@ Working with Reports Rearit List ﬂf:iéﬁg x
@ Maintainence L %
[£] Urinstal | o
A
Claim List tab
is active
4| | 3
g |
At this point, you can:
Print the topic =
Click Print
View Options
Click - Qtions
Return to the previous view
P &
Click =~ Bask
Hide the tab P
=
Click -~ Hide

3. To close the book, click the minus (=) sign on the keyboard.
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How to Use the Index Tab
1. Click the Index tab.

=1
‘What is Medicars Remit Easy Print?

» Medicats Ramit Easy Peint (NREP) b am Ebsctisade
Remittance Advice (ERA) Seasch Display tesl fos
i Windows 7000, Windows XP.

g

& MREP allows haalthears peovidins 1o view, warch, and

:th 3 Medicare elecwonically.
BILLED ANOUNT

f

CHEDK DATE

DT TRACE MM R

cham ot

[ELAB IFORMATION FORrWSEL D E0

CLam TOTALS
Coa

=

=
‘What is Medicars Remit Easy Print?
» Medicats Ramit Easy Peint (NREP) b am Ebsctisade
Remittance Advice (ERA) Seasch Display tesl fos
Windows 7000, Windows XP.

= MREP allows haalthears peovidirs 1o view, warch, and

Medicare elecmonically,

TOTAL Pl T FROVCE
TEIFAL MASCN CE0 AL THENT a0
rwetsl =

b |
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3. Select a keyword by double clicking on it or click the display.

=E
Hide Back Frint  Optionz
PROC: Thig is the HCPCS proced;'
Qonte_nts Index |§eamh| codes is available here:
Type in the keyward to [:gdf http: i, o, hhs. gowT
[proc MODS: These are all the maodifiers
_ BILLED: This is the amount the pra
PROY PD
PROVIDER # = e :
PROVIDER MAME ALLOWED: This is the allowed amaoun
PTRESF )
RARC DEDUCT: This the amount of any de
REND PROV claim. This is the amount -
i‘:gﬁ:tcse other insurer, if applicable)
resource files the provider.
Hestorf]e COINS: Thig is the amount that the
LA = 5 - H g
SERY DATE |nsu_r§r, if applicable) is res
starting provider,
surmmary GRP/RC: These are any Group Code
tzglbar Reason Codes for the ser
TOTAL ALLOWED AMOUNT Bt AMT: This is the amount of any
TOTAL C1AIMS the Group and Claims Adj
Display | PROV PD: This_is the amount the p_ro|ﬂ
4| | »

How to Use the Search Tab
1. Click the Search tab.

e 181
Certerts | lpsten Soimch | =
‘What is Medicars Remit Easy Print?

Frpn it keyepond o It
] M it Eany Print (MREP) i am Ebectionic

R Advice [ERA) fa Display tesd bos

Wi 1000, Windows
‘Select Tope ba drclay « MREP allows haalthcare peovidars 1o view, search, and

Medicare slscuonically.

=
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2. Type a keyword to find, then click the List Topics button ﬂl or type Alt +

algizl

) ey
tick g

ok =
|l I ‘What is Medicars Remit =Zay Print?
Troa e o et
== — " it Eany Print (MREP) bs am Edectissic

& Femi vice [EIUA) Saasch Display taad fos
Ui Topin Windorws 2000, Windows XP.
Bt Tapie s sapley « MREP allows healthcars paovibers 1 view, snarch, and
Medicats slecwanically,
¢

3. Once the list of topics appears, double click the one you want.

E? Medicare Remit Easy Print Help o =10l %

T ¢ & @

Hide Back Frint  Options

Eontentsl Index  Search |

Type in the keyword ta find:

Claim Detail Tab

|beneficiary Making Sense of the ClainyDetail

List Tpp% |

8 sinficarm Romil EasyPrint v 30
s few froot Sewch [ook e
ot [Pt -

Select Topic to display:

LClairn Detal Tab
Clairn List Tab Pares e

AR W5 SNCE
AFES NP ANCE

ARER INRRACE
<

e Lt
|AnBA THEURANCE

28 Mats Briwat
|oamsarvaiie, T

Dizplay |

i
i
-

4]

How to Close the Medicare Rémit Easy Print Help Window
Click the close window button 2 or type Alt + F4.
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Importing HIPAA 835 files

The first time that you start Medicare Remit Easy Print, you must import an HIPAA 835 file.

For the procedure for the first import, see Step 1 of How to Start Medicare Remit Easy Print.

The first time you start Medicare Remit Easy Print, or when you don’t have any Remittance
files in the Import folder you see the “No Remittance Files Found” dialog. Click or select the
OK button to close the dialog.

Before You Import the HIPAA 835 File
Before you import an HIPAA 835 file, you must:

» Install the Medicare Remit Easy Print program. (See PC Installations or Network
Installations)

» To determine the location of the HIPAA 835 folder or where your HIPAA 835 files
are stored, complete Step 4 of the Pre-Installation Checklist for Installation on a PC.

Import File Name Format

When you import the HIPAA 835 file, Medicare Remit Easy Print makes a copy of it, renames
it, and stores it in the Import file folder.

The file-naming format is as follows:

PPPPPPPPPPPPPPPPPPPPPPPPPPPPP Payer Name — 30 bytes maximum
Ccccceecececcececececcce Check/EFT # — 15 bytes maximum

If a file has been imported successfully and you attempt to import the same file, an error
record is written to the Import Exception Summary Window/Report and the file is not imported
into the MREP application. Importing a file format other than HIPAA 835v5010A1 or
835v4010A1, or a non-compliant version of a HIPAA 835-formatted file also writes a record
to the Import Exception Summary window/report and the file is not imported into the MREP
application.

NOTE: With the release of MREP v2.9 (April 2011), the only acceptable versions of the
HIPAA 835 file that can be imported into MREP are 835v5010A1 and 835v4010AL1.
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How to Import the HIPAA 835 File

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon

The Medicare Remit Easy Print Claim List tab opens.

E Remit EasyPrint ¥3.2 ;Iglll

File Tab Wiew Report Search Tools Help

. ’ Irnpork

A Archive 3 Restore x Delete

PReport - q Search | Prink List

Payes Name Check Date CheckiEFT ... Check/EFT Number Yersion Filens
ACME PHYSICIANS INC, E 78 04 5 451.7 0050 B

Kl | |
Claim Lis\ | Clairn Detail I Remit Summary Data Yiew I Search I Glossary I

Marne \ | ACHT | Jan] | Biled Amount | paid amourt | From Date | ToDate | A
Ooce, salky 1111111 123456789012345 -910.50 -402.53 2/10/2004 2/10/2004 :
Ooce, salky 1111111 123456789012345 310,50 587,28 2(10/2004 2}10/2004 .
Ooce, sally 1111111 123456789012345 38.20 12.50 2/11/2005 2j11/2005 .
DRight, Samuel 1111111 123456789012345 237.60 159,36 3282005 3282005 b
Ooce, sally 1111111 123456789012345 406.20 32,67 2{10/2005 2j10{2005 .
Ooce, sally 1111111 123456789012345 148,80 92,42 3i9/2005 3/9/2005 .
Oright, saruel 1111111 123456789012345 40.00 0,00 12i222003 12/22/2003 .
< | ©H
L Print 4 Check all \D Uncheck &l @ Data

Segment count = =206 \ 12f6f2011

2. Click the Import button or go to the File menu option and select Import.

© 2005 General Dynamics IT Company. All Rights Reserved.
This document contains GDIT confidential and proprietary information,
which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs.

50



Medicare Remit Easy Print Importing HIPAA 835 files

Medicare Remit Easy Print opens a window for you to select the HIPAA 835 file to

import:
Import ANSI x12 835 ERA B3
Look jn: Im Desktop j & l:j( =
a7
3 B |
r y Metwork Acrobat Adobe WS 3270 Shaglt B

Places Distiler .0 Reader 7.0 PLUS

7N
e O .
82 SPI: /
Snaglt Studio  Documents E azpPrint Frametd aker Track T-Rex
B
£ D

WiebEx Plager  Windows

Media Flayer
File nane: I j Open I
Filzz of type: | j Caticel |

i

3. Select the HIPAA 835 file that you want to import by double-clicking it
Medicare Remit Easy Print starts the import and lets you know that it is importing:

i lectronic remittance(s)...
HNNENEN

After the import finishes, the MREP Remittance Advice List window appears.

At this point, you can:
Work with the MREP Remittance Advices  See Working with MREP Remittance Advices

Work with Reports See Working with Reports

Note: Medicare Remit Easy Print reformats and saves a copy of the HIPAA 835 file.
This copy is the Import file. If you import the same HIPAA 835 file more than once,
Medicare Remit Easy Print bypasses the duplicate file and displays the Import
Exception Summary Report indicating duplicate remittances were detected.

For information about making sense of the Import file name, see Import File Name Format.
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How to Automatically Import the HIPAA 835 File

1. Close Medicare Remit Easy Print Right click on the Easy Print icon and click Properties.
The EasyPrint.exe Properties window appears.

EasyPrint.exe Properties id |

General  Shartout | SEcurit_l,II

-
L 84

E asyFrint. exe

T arget type: Application

T arget location: Eazyp Print

Target: we' - "CAMREPYFiles to be importedino_phi bt

" Funin separate memom space [ Fun as different user

Stark in; IHHE azy Print"'

Shaortout key: IN-:une

Bun: I M ormal window j

Comment: I

FEind Target. .. | Ehangelcun...l

2k, I Cancel | Apply |

Note: The values in the various fields vary for each MREP user.

2. The Target: value needs to be modified to indicate the location of the files that are to be
imported. The user must enter a space after the last double quote, the value of —I or —i (not
case sensitive), followed by another space and the pathname. The pathname must be in
double quotes. For example, "I:\Easy Print\EasyPrint.exe" —i "C:\MREP\Files to be
imported\no_phi.txt"

© 2005 General Dynamics IT Company. All Rights Reserved.
This document contains GDIT confidential and proprietary information,
which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs.

52



Medicare Remit Easy Print Importing HIPAA 835 files

3. To save the changes you made to the Target: value, you must click the Apply button.

EasyPrint.exe Properties ﬂil

General Sharteut | Securit_l,ll

L# |
E asyFrint. exe

T arget bype: Application

Target location: Eazy Print

Target: we' - "CAMRBEPYFiles to be impartedno_phi bt

[ Bunin zeparate memomy space [ Bun az different uzer

Start in: I"I:'xE azy Print"'

Shaortout ke IN-:une

Bur: I Marmnal window j

Comment; I

Find Target... | Ehangelcnn...l

k. :I Cancel | gppl_u¢ |

4. Once you click the Apply button, then you must click the OK button. The Properties
window then disappears.
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5. You can restart the MREP software.

Notes:

» If the user updates the Target field with a file path that does not exist, a message
dialog appears stating the target file does not exist. Once the user chooses to close this
window by clicking the OK button, the MREP software continues to run with the files
that have already been imported.

EasyPrint ﬂ

Auto import Funckion has been abaorked,
File :Z:\MREPYFiles tolno_phi.txt does not exisk,

» Each time that the MREP software is invoked, it always accesses the import pathname
to attempt to import the data that is contained in the specified file.

*  When a duplicate remit file or a file with an invalid data format (not 835v4010A1 or
835v5010) is encountered, the Import Exception Summary window appears. The user
can choose to Print or Close this window. Once the user chooses to close this window,
the MREP software continues to run with files that have already been imported.
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What to Do with an Import Error Message
There are two error messages that you may see:

For this error message: You need to:

Invalid File Format Select the correct HIPAA 835 file to import.

You have either selected an ERA not in a HIPAA 835 format or an
ERA that is a HIPAA 835 with invalid delimiters. If you continue to
receive this error, contact your contractor.

Path / File Access Error Check with your network/PC administrator.

You need to have read/write access rights to the Medicare Remit
Easy Print directory.
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Import Exception Summary Window/Report

The Import Exception Summary window/report helps to identify duplicate files, file
formats other than 835v5010 or HIPAA 835v4010A, non-compliant HIPAA 835-
formatted files, and prevents the posting of “junk” files to the import folder. If any of
the scenarios that are described above are encountered while attempting to import files
to the MREP application, an Import Exception Summary dialog displays a list of
invalid files by Payee and Check/EFT #, in addition to a brief description of the issue
encountered.

=181

The feliwsng remits wens not imporbed For the reason(s) indcated :

EEEE

Payes

wadd
(EL]
Tt
sag
4
(2R ]
(RE|
i

Pile: Coilocuments and Settings’Jan-HyDeskeop) INULLIE. THT

Chack/EFT 3 LEL L]

Varsion Iovalid ; 004010XD31AZ
Variion Ievalid @ 004010X031AZ
Het an B3E Eramssstion @ BE7

Varmaon Irvmlid ; 0030010605 14T
Version Irvalid ;@ 00SD10X0F 1AL
Version Ievalid : 0O4010X051ALZ
Version Iovalid @ 004010XD51AI
Variion [ovalid @ 004010X031AZ
Varsion [evalid @ 00010X031AT
Varmaon I[ralid ;@ 004010M0514%
Version Irealid ;@ D04D10X0FLAZ
Versiom Iovalid : 004010X051AZ
Version Iovalid @ 004010XD51AI
Varsion Iovalid @ 004010X051AZ
Vardion [ewvalid @ 005010X031AZ
Vermion Irwmlid : 004010M0514%
Versaom Irvralid @ 0D4010X0¥1LAZ
Version Invalid : 004010X0F1AZ
Version Iovalid @ 004010XD51AI
Varsion Iovalid @ 004010805 1AD
Vatsion Isvalid @ 00Q010MD51AT

i B i C R R Ihaplicats csaik
it il L I miiiai U Ihaplicats remit
[ETF “HEEE T 1w T Igplicate pemic
=T BETE T EL N e T Ingplicate remic
o BEREEE R izt 1 Dugplicere Famirc
dmadk 3 caEct S i Digplicata Eamie
T T S ¥ Ihplicats cemikt
T T_NEIT > L Iaplicats remit

Eid B W s ST 2 Inplicate remic
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You have the option of closing the window or printing the Import Exception Summary. If you
choose to print the Import Exception Summary report, the window does not close
automatically once the report prints. You need to close the window using the close button or
“X-ing” out (top right corner of the Import Exception Summary window). The printing
functionality for the Import Exception Summary report follows the existing printing
functionality within MREP. Please note that if the window is closed prior to printing the
report, the list of import error(s) is lost. To eliminate the need for file space management, a
decision was made to not save the MREP Import Exception errors. To recreate the Import
Exception Summary window, the files need to be imported again.

The Import Exception Summary window and report contains three columns of information.

e The first column of information is entitled “Payee”. Depending on what type of error
is encountered during the import process, this field could contain data or spaces. The
maximum number of bytes of data that can appear is 40.

e The second column of information is entitled “Check/EFT #”. Depending on what type
of error is encountered during the import process, this field could contain data or
spaces. The maximum number of bytes of data that can appear is 15.

e The third column of information is entitled “Reason”. Depending on what type of error
that is encountered during the import process, there is the possibility of three different
messages appearing.

Prior to the three columns of data, the Import Exception Summary window and report
contains a heading with the title “File:”. The information following the “File:” heading is the
location and name of the file that the attempt is being made to import into the MREP
application.

When the Import Exception Summary report prints, the printed version contains an additional
heading prior the “File:” heading. It is the first heading on the report. On the left side of the
page, the heading displays “Import Exception Summary”. In the center of the page, the
heading displays the date and time stamp when the summary report was printed. The format
of the date is MM/DD/CCYYY. Please note that the leading zero in the month and day do not
appear — for example: 2/15/2006. The format of the time is HH:MM:SS XX (XX represents
AM or PM). On the right side of the page, the heading displays the version of the MREP
application that is being used (for example: Easy Print v1.7).
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Working with MREP Remittance Advices

How to View a List of Claims for an MREP Remittance Advice

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon
The Medicare Remit Easy Print Claim List tab opens.
2. Select the Remittance Advice by clicking on it.

Medicare Remit Easy Print highlights the Remittance Advice and lists the associated
claims below.

.Medicare Remit EasyPrint ¥3.2 ;Iglll

File Tab “iew Report Search Tools Help

.'Import | P Report -

( Search | Prink List
Q =

CheckfEFT ...

B, Archive 7. Restare X pelste

Payer Name Payee Mame Check{EFT Number Version

Check Date

This is the AREA INSURANCE [ ACME PHYSICIANS INC. G (14/23{05 D0S010K22 14
Remittance
Advice for
this claim.
You clicked
Payee 1. 4| | 0|
Claim List Clairn Detail I Rermit Sumimary Data View | Search | Glossary |
_ | Mame | ACHT | I | Billed Amaurk | Paid amourt | From Date | ToDate | A
Ooae, sally 1111111 1234567609012345 -910,50 402,53 2{10/2004 2}10/2004 :
Oooe, sally 1111111 123456769012345 910,50 587.28 2{10/2004 2}10/2004 :
Oooe, sally 1111111 123456769012345 38,20 12,50 2{11}2005 2j11/2005 :
COright, samuel 1111111 123456769012345 237,60 159,36 3(28/2005 3j28/2005 :
Oooe, sally 1111111 123456769012345 406,20 32,67 2{10/2005 2}10{2005 :
Oooe, sally 1111111 123456769012345 148,80 92,42 3p9/2005 3/9/2005 :
right, samuel 1111111 123456769012345 40,00 0,00 124222003 12j22(2003 :
These are  —
the claims
for Payee 1
Tl | 2
Print EA Check al [Juncheck &l 12, Data
Segment count = =206 12f6/2011
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Note:

Working with MREP Remittance Advices

Some screen reading applications may not be able to read all of the values on the claim list tab.
Function key F1 displays an accessibility informational message allowing the screen reading
application to recite the field names and values displayed in the listview for the highlighted
claim. Please note the Patient’s Name appears the Last Name first, followed by a comma and

then the First Name:

At this point, you can:

Find out more about this tab

Print the list

View claim details

View a Summary for the Remittance
Advice

View the data that feeds the Remittance
Advice

Search

View the CARCs, RARCs, Group Codes,

and Business Scenarios for the
Remittance Advice

See page Making Sense of the Claim List Tab

_ Prink
Click Q or go to the Tab menu

option and select Print Claim List, or type Alt + B
+P.

For more info, see How to Print a List of Claims.

Click| C i Cul] or go to the View

menu option and select Claim Detail

For more info, see How to View the Detail for a
Claim

Click Remit Summary or go to the View
menu option and select Remit Summary

For more info, see How to View the Total
Amounts for a Remittance Advice.

Click| Data View or go to the View

menu option and select Data View

For more info, see Making Sense of the Data
View Tab.

Click| Search or go to the View
menu option and select Search

For more info, see How to Search Payment
Information.

Click B or go to the View

menu option and select Glossary.

For more info, see Making Sense of the Glossary
Tab.
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How to View the Detail for a Claim

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon

The Medicare Remit Easy Print Claim List tab opens.
2. Select the Remittance Advice by clicking on it.

Medicare Remit Easy Print highlights the Remittance Advice and lists the claims below.

OMedicare Remit EasyPrint ¥3.2
File Tab ‘iew Report Search Tools Help

~=lolx|

_'Import | P Report - || B, Archive . Restore | X Delete | q Search | EPrlnt List
Payer Name Payee Mame Filens
TR e I gl|RE s 1sURANCE [ ACME PHYSICIANS INC.
Payee 1
L | i
Claim List Clairn Detail I Rermit Summary Data Yiew I Search I Glossary I
[ ame | ACNT | jan] | Biled Amount | Paid Amourt | From Date ToDate | A
Ooce, salty 1111111 123456789012345 -910.,50 -402.53 2}10f2004 2}10/2004 .
Ooce, saly 1111111 123456789012345 910,50 587,28 2}10f2004 2}10/2004 L
Ooce, saly 1111111 123456789012345 38,20 12.50 2{11f2005 2{11j2005 L
Oright, samuel 1111111 123456789012345 237,60 159,36 3j28{2005 3j28/2005 L
Ooce, saly 1111111 123456789012345 406,20 32,67 2{10{2005 2}10/2005 L
Ooce, saly 1111111 123456739012345 148,80 92,42 3i9(2005 3/9f2005 1
Oright, samuel 1111111 123456739012345 40,00 0,00 12/22j2003 12{z2}2003 1
These  —
are the
claims for
— | o
. Print | A checkAl | [JunCheck Al 'i!i.'?\ Data
Hint: — : . .
You can click Segment count = =206 1zfgfz011
on a column
heading to
change the
sort order.
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Medicare Remit Easy Print Working with MREP Remittance Advices

Hint:

You can use
the Check All
and Uncheck
All buttons to
help you select
the claims.

Click to print /

the detail

3. Check the checkpox next to the claim(s) that you want to see detail. Detailed information
only appears fof claims that are checked.

OMedicare Remit EasyPrint ¥3.2 =]
File Tab Wiew Report|Search T#ols  Help

’Import | PReport 'J/Anrchive 7 Restore X pelste q Search | Print List
1=

| Payes ID | Check Date | Check/EFT ... | Check/EFT ... | Claims | Check/EFT MNumber | Version | Filenz
YSICIAMNS IMC, 12345675 04/23/05 481.71 EFT 7 12345 00S010x22141 ARESA

Payer Name
AREA INSURAMCE  ACME,

;ém List Clairn Detail

I Remik Summary Data Yiew Search Glossary |

Billed Amount Paid Amounk From Date To Date /

Doe, Sally 1111111 5 -910.50 2 zfiojzone |
Ooce, saly 1111111 123456789012345 38,20 12.50 2/1142005 24112005 v
Oright, samuel 1111111 123456789012345 40,00 0.00 12{22i2003 12{22{2003 v
Ooce, saly 1111111 123456789012345 148,50 92,42 3i9(2005 3j9(2005 v
DRight, Samuel 1111111 123456759012345 237.60 159.36 3/28/2005 3/28/2005 b
Ooce, saly 1111111 123456789012345 406,20 32,67 2/10{2005 2{10/2005 v
Ooce, saly 1111111 123456789012345 910,50 557,28 2/10{2004 2}10/2004 v
il | ©i

Print EA Check all CJunched Al @ Data

Selgment count = >206 1282011

4, Click the Claim Detail tab.
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Working with MREP Remittance Advices

The detail appears for the claim you selected:

-9’ - - . -
ia: Medicare Remit EasyPrint v4.2

e O [

Find out more about this tab
Print the detail

Return to the Claim List

File Tab View Report Search Tools Help
o import P report ~| | M\ archive | 7 Restore | 3E Delete Q Search Print List
Payer Name | Payee Name Payee ID | Check Date | Ched/EFT ... | Chedk/EFT ... | Claims | Cheds/EFT Number Version Filename
AREA INSURANCE ~ ACME PHYSICIANS INC. 12345678 10/10/12 48171 EFT 7 12344 005010%221A1 MNOPHI_2012.X...
Claim List Claim Detail Remit Summary Data View Search Glossary
-
DAYER BUSINESS CONTACT INFORMATION:
Jane Doe
{300)555-5555
ACME PHYSICIZNS INC. NPI & 1234587830
225 Main Street DATE 10/10/2012
Centerville, PR 17111 PRGE §: 1
CHECK/EFT #: 12344 E
REND-PROV SERV-DATE POS PD-PROC/MCDS ED-NOS BILLED ALLOWED DEDUCT COINS PROV-FD
RARC SUB-NCS SUB-FROC GRE/CRRC CARC-AMT ADJ-QTY BS
MAME:Right, Samuel HIC:SJD11111l RCNT: 7722338 ICN:11227500001400 ARSG:Y MOR:MROT MAOL
1234587850 0913 091312 12 REZ03AZ 24.000 194.40 178.52 a.00 25.50 l43.82
REE] co-108 14.88 03
CHTL #: 01
12234587230 0512 051312 12 RE44ERZ 42.000 42.20 15.&88 o.oo 2.54 15.74
REE] Co-4z 23.52
CHTL £: 02
BT RESE 35 84 CRRC 38_40 CLATM TOTALS 237 &0 158 _ 20 a_oo 35 84 155 _3&
ADJ TO TOTRLS: PREV FD INTEREST 0.00 LATE FILING CHRRGE Q.00 NET 155.3%

See page Making Sense of the Claim Detail.

Print
Click the print button, ﬁ

or go to the Tab menu option and select Print
Claim Detall, or type Alt + B + P.

For more info, see How to Print the Detail for a
Claim.

Click the claim list tab Claim List

or go to the View menu option and select Claim
List.

For more info, see How to View a List of Claims
for an MREP Remittance Advice.
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Medicare Remit Easy Print

View a Summary for the Remittance Advice

View the data that feeds the Remittance
Advice

Search

View the CARCs, RARCs, Group Codes,
and Business Scenarios for the Remittance
Advice

Option to print or suppress the printing of
the glossary of CARCs and RARCSs for the
Remittance Advice (not available for
Remittance Advices printed from the menu
bar or toolbar)

Working with MREP Remittance Advices

Click the summary tab Rernit Summary

or go to the View menu option and select Remit
Summary.

For more info, see How to View the Total
Amounts for a Remittance Advice.

Click the Data View tab Data View

or go to the View menu option and select Data
View.

For more info, see Making Sense of the Data
View Tab.

Click the Search Tab Search

or go to the View menu option and Search.
For more info, see How to Search Payment
Information.

Glossary

Click the Glossary Tab

or go to the View menu option and select
Glossary.

For more info, see Making Sense of the
Glossary Tab.

A check box with the word Glossary appears in
the lower right side of the Claim Detail tab.
When this check box is checked, the glossary
of CARCs and RARC:s involved with a
particular MREP Remittance Advice prints on a
separate page. When the check box is not
checked, the glossary of CARCs and RARCs
involved with a particular MREP Remittance
Advice does not print.

The user also has the option via the Tab menu
option to show or not show the glossary of
CARCs and RARCs involved with the MREP
Remittance Advice.
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Click the print
button
or type Alt + B +
P to print the
summary

Medicare Remit Easy Print

How to View the Total Amounts for a Remittance Advice

Working with MREP Remittance Advices

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon

The Medicare Remit Easy Print Claim List tab opens.
2. Select the Remittance Advice by clicking on it.

Medicare Remit Easy Print highlights the Remittance Advice and lists the claims below.

3. Click the Remit Summary Tab Remit Summary lor type Alt +V + S,
Medicare Remit Easy Print displays the totals, for example
B8 Medicare Remit EasyPrint v3.3 =] 3]
File Tab View Report Search Tools Help
.flmpcrt | P Report = A Archive | i Restore | 3§ Delete | q Search ‘ EPrintList
Payer Name | Payee Name | Payee ID | Check Date | Check/EFT ... | ChedckfEFT ... | Claims | Check/EFT Number | Version | Filename
AREA INSURAMCE ~ ACME PHYSICIAMS INC. 12345678 10/10/12 48171 EFT 7 12344 005010x221A1 NOPHI_2012.X...
Claim List I Claim Detail Remit Summary Data View Search Glossary

EasyPrint v3.3 PROVIDER PAYMENT SUMMARY REPORT VER: 005010X22121
PROVIDER NAME : ACME PHYSICIRNS INC.
NET £ : 1234587830
CHECE DATE : 10/10/12
CHECE/EFT TRRACE £ : lz344
TOTAL CLRIMS = 7

BILLED AMOUNT : 870.80

TOTAL REASON CODE ADJUSTMENT AMOUNT - 213.14

TOTAL RLLOWED RMOUNT : 912.7¢

TOTAL COINSURANCE AMOUNT : 120.43

TOTAL DEDUCTIELE AMOUNT : 55.53

TIOTAL PRID TO PROVIDER : 481.70

TOTAL INTEREST AMOUNT : 0.01

TOTAL CHECE/EFT ARMOUNT : 481.71
PLE RDJ DETAILS: RERSON FCN/OTHER IDENTIIFIER RMOUNT

L& -1.23
Wo 1200122225%00012001222299000 111223332 456.78
\Tprint Q Zoom In Q Zoom Out —4- Zoom Reset
9/13/2012
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Medicare Remit Easy Print Working with MREP Remittance Advices

At this point, you can:

Find out more about this tab See Making Sense of the Remit Summary Tab.

Print the summary Print
Click the print button -

or go to the Tab menu option and select Print
Claim Detail or type Alt + B + P.

View claim details Click the Claim Detail Tab | e
or go to the View menu option and select Claim
Detail
For more info, see How to View the Detail for a
Claim.

Return to the Claim List Click the Claim List tab Claim List
or go to the View menu option and select Claim
List

For more info, see How to View a List of Claims
for an MREP Remittance Advice.

. . . . [iaka Wi
View the data that feeds the Remittance Click the Data View tab aLa view
Advice or go to the View menu option and select Data
View
For more info, see Making Sense of the Data
View Tab.
Search Click the Search tab Search

or go to the View menu option and select Search
For more info, see How to Search Payment

Information.
) . Glossary
View the CARCs, RARCs, Group Codes, Click the Glossary tab
and Business Scenarios for the or go to the View menu option and select

Remittance Advice Glossary

For more info, see Making Sense of the Glossary
Tab.
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Medicare Remit Easy Print Working with MREP Remittance Advices

How to View the Data in the Import File

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon

]

The Medicare Remit Easy Print Claim List tab opens.
2. Select the Remittance Advice by clicking on it.

Medicare Remit Easy Print highlights the Remittance Advice and lists the claims below.

3. Click the Data View Tab | Data iew or type Alt + VV.

Medicare Remit Easy Print displays the file format:

OMedicare Remit EasyPrint ¥3.2

~=lolx|

File Tab Wiew Report Search TO0I5|Help
'Import P Report = | | M Archive 7 Restore X Delete q Search | EF'r'int Lisk

Payer Name I Payee Name | Payee ID | Check Date | Check/EFT ... | Check/EFT ... | Claims | Check/EFT Mumber | ‘ersion | Filenz
AREA INSURAMCE  ACME PHYSICIANS INC, 12345678 04)23/05 451,71 EFT 7 12345 005010522141 AREA

4

Clairn List Claim Detail I Remit Summary

Search | Glossary
| Description | Walue

HDRE : 5T 01 Transaction Set Identifier Code 835
Selectaloop W

HDRE : BPR. oz Transaction Set Control Mumber 00d1
& segment HORE : TRM

HDRE : REF
HORE : REF b
HDRE @ DTM
10004 : 11
10004 ;M3
10004 : M4
10004 : REF
10004 : PER.
10008 : M1
10008 : M3
10008 : M4
1000 : REF
2000 Lx
2100 CLP
2100 : MM1
2100 : NM1L
2100 ¢ MOA
2100 : DTM
2110 5vC
2110: DTM
2110 CAS
2110 REF
2110 REF
2110 AMT
2110 5vC
2110: DTM
2110 CAS

2110 REF -
Aain . nos
«| |L|_I < | ol

1

Segment count > 206 /

The contents of the loop J

& seament appear here

Loop & Segment || Field ID

12/6/2011

At this point, you can:
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Find out more about this window See page Making Sense of the Data View Tab.

View claim details Click the Claim Detail tab | Clairn Detail

Or, go to the View menu option and select
Claim Detail.

For more info, see How to View the Detail for a
Claim.

Return to the Claim List -
Click the Claim List tab Claim List

Or, go to the View menu option and select
Claim List.

For more info, see How to View a List of Claims
for an MREP Remittance Advice.

View a Summary for the Remittance Click the Summary tab Remit Summary
Advice
Or, go to the View menu option and select
Remit Summary.
For more info, see How to View the Total
Amounts for a Remittance Advice.
Search Select the Search tab | Siziail

Or, go to the View menu option and select
Search.

For more info, see How to Search Payment
Information.

View the CARCs and RARC:s for the lSeIect the Glossary tab

. X Glossar
Remittance Advice E

Or, go to the View menu option and select
Glossary.

For more info, see Making Sense of the
Glossary Tab.
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How to View the CARC and RARC Codes

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon

The Medicare Remit Easy Print Claim List tab opens.
2. Select the Remittance Advice by clicking on it.

Medicare Remit Easy Print highlights the Remittance Advice and lists the claims below.

3. Click the Glossary Tabl clocsiy or type Alt +V + G,

Medicare Remit Easy Print shows the Reason and Remark codes for the Remittance
Advice:

r— = = "
’Medlcare Remit EasyPrint v3.2 ;Iglll

File Tab ‘iew Report Search Tools Help

'Import P Report  + | | ) Archive . Restore X Delete | Q Search | Print List
Paver Mame | Pavee Mame | Pavee ID | Check Date | CheckfEFT ... | CheckfEFT ... | Claims | CheckfEFT Mumber | ersion I Filenz
AREA INSURAMCE  ACME PHYSICIANS INC, 12345675 04/23{05 481.71 EFT 7 12345 00S010x22141 ARESA

4| | ]

Claim Lisk Claim Detail I Reemik Summary Data Yiew Search Glossary

=l
4 1125 } - The information Furnished does not substantiate the need For this level of service, IF vou believe the service should have been Fully covered as billed, or if you did not know and
could not reasonably have been expected ko know that we would not pay For this level of service, or if you notified the patient in writing in advance that we would not pay For this level of
service and hefshe agreed in writing to pay, ask us to review your claim within 120 days of the date of this notice, IF you do not request an appeal, we will, upon application fram the
patient, reimburse himfher For the amount you have collected From himfher in excess of any deductible and coinsurance amounts, We will recover the reimbursement From you as an
overpayment.

4 Ma0L } - Alert: If vou do not agree with what we approved For these services, you may appeal our decision. To make sure that we are Fair to you, we require another individual that did
nok process your initial claim to conduct the appeal. Howewver, in order to be eligible for an appeal, wou must write ko us within 120 days of the date you received this notice, unless you
have a good reason For being late,

{ MA03 } - If vou do not agree with the approved amounts and $100 or more is in dispute {less deductible and coinsurance), you may ask for a hearing within six months of the date of this
notice, To meet the $100, you may combine amounts on other claims that have been denied, including reopened appeals if you received a revised decision, You must appeal each claim on
kirne,

{ MAO7 } - Alert: The claim information has also been Forwarded to Medicaid For review,

4 1MA13} - Alert: You may be subject to penalties if vou bill the patient For amounts nok reported with the PR (patient responsibility) group code.

4 MALE } - Alert: The claim information is also being forwarded to the patient's supplemental insurer. Send any questions regarding supplemental benefits to them,

{ MAGT } - Correction ta a prior claim,

4 M102 } - This claim has been denied without reviewing the medical record because the requested records were not received or were not received timely,

||

Q Zoom In Q Zoom Cuk ~4- Reset Wiew |97 Codes
X

12(6/2011

Click the Codes button or
type Alt + B + Cto seea
comprehensive list of
codes and descriptions.
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At this point, you can:

Find out more about this tab See page Making Sense of the Glossary Tab.
View claim details Click the Claim Detail tab | Claim Detai
or go to the View menu option and select Claim
Detail.
For more info, see How to View the Detail for a
Claim.
Return to the Claim List Click the Claim List tab Claim List
or go to the View menu option and select Claim
List.

For more info, see How to View a List of Claims
for an MREP Remittance Advice.

View a Summary for the Remittance Click the Summary tab i
Advice or go to the View menu option and select Remit
Summary.

For more info, see How to View the Total
Amounts for a Remittance Advice. on page 91.

View the data that feeds the Remittance Select the Data View tab | Data View

Advice or go to the View menu option and select Data
View.
For more info, see Making Sense of the Data
View Tab.

Search Select the Search tab | Sizalian

or go to the View menu option and select Search.

For more info, see How to Search Payment
Information.

View the CARCs and RARCs for the . S0 Codes
Remittance Advice Click the Codes button at the
bottom of the tab or type Alt + B + C.

For more information, see How to View the
CARC and RARC Codes.
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How to Look up a CARC/RARC Code, Group Code, or CORE

Business Scenario

Type a specific
code or click a
code to display
its description
and notes

102
103
104
105
106

1. Open Medicare Remit Easy Print by double-clicking m
The Medicare Remit Easy Print Claim List tab opens.
1. On the menu Select Tools > Code Descriptions.

The Code Descriptions window opens.

“ Easy Print Code Descriptions (CAGC/CARC/RARC 11/01/2013) (CORE version 3.0.3) — =ARE X
| Description :
. |Procedure postponed, canceled, or delayed.

1
1 (CORE BUS. SCENARIO)

100
101

107
108

109 Note :

11 Effective Date :1/1/1995

110 Deactivated Date g

111 Date Last Modified :9/30/2007

112 Motes :

Hi CORE Business Scenario  :3
-

Code count > 1372

\ The Note window

displays any notes
about the
CARC/RARC Code
and CORE Business
Scenario
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Medicare Remit Easy Print Working with MREP Remittance Advices

How to Update (Import) the CARC/RARC Codes, Group Codes,
and CORE Business Scenarios

At a minimum, the ANSI Claim Adjustment Reason Code (CARC) and Remittance Advice
Remark Code (RARC) file requires an update three times a year. When the list of codes is updated
per Washington Publishing Company, GDIT provides an updated file on the VIPS Assist website
for the contractors and CMS provides a link to the updated file on the CMS website for the
provider/supplier community. When the user finds it necessary to import this updated file into
MREP, follow these instructions:

1. Access the list of the latest codes from the VIPS Assist or CMS website.
2. Save the list of latest codes so that they are easily accessible.

Note: The file name must be saved as Codes.ini for MREP to successfully find the code
file.

3. Select “Import Code Descriptions” from the Tools menu.

[ Medicare Remit EasyPrint v4.2 C e —— T - - —_—— (=0
File Tab View Report Search
fImport PReport - Al Archive Search ';_PrintList
Delete =
Payer Name [ Payee Name eck/EFT ... | Check/EFT ... | Claims | Check/EFT Mumber Version Filename
AREA INSURANCE  ACME PHYSICIANS R 46L71 EFT 7 12344 005010X221A1  NOPHI_2012.X...

Code Descriptions

Import Code Descriptions
Path Name Editor

Claim List I Claim Detail ] Remit Summary Data View Search Glassary

{18} - Exact duplicate daim/service (Use only with Group Cade OA except where state workers' compensation regulations reguires C0)

{23 } - The impact of prior payer(s) adjudication induding payments and/or adjustments. (Use only with Group Code OA)

{2 (BS) } - Additional Information Required - Missing/Invalid/Incomplete Data from Submitted Claim

{3 (BS) } - Billed Service Not Covered by Health Plan

{42} - Charges exceed our fee schedule or maximum allowable amount. (Lise CARC 45)

{50 } - These are non-covered services because this is not deemed a ‘medical necessity’ by the payer. Note: Refer to the 835 Healthcare Policy Identification Segment (loop 2110 Service Payment Information REF), if present.

m

{ 57 } - Payment denied,reduced because the payer deems the information submitted does not support this level of service, this many services, this length of service, this dosage, or this day's supply.

€O } - Contractural Obligations

{ CR } - Correction and Reversals

{L6 } - Interest Owed

{{M25} - The information furnished does not substantiate the need for this level of service. If you believe the service should have been fully covered as billed, or if you did not know and could not reasonably have been expected to know that we would not pay
for this level of service, or if you notified the patient in writing in advance that we would not pay for this level of service and he/she agreed in writing to pay, ask us to review your daim within 120 days of the date of this notice. If you do not request an
appeal, we will, upon application from the patient, reimburse him/her for the amount you have collected from him/her in excess of any deductible and coinsurance amounts. We will recover the reimbursement from you as an overpayment.

{{MAD1} - Alert: If you do not agree with what we approved for these services, you may appeal our dedsion. To make sure that we are fair to you, we require another individual that did not process your initial claim to conduct the appeal. However, in order
to be eligible for an appeal, you must write to us within 120 days of the date you received this notice, unless you have a good reason for being late.

{MAO3 } - If you do not agree with the approved amounts and $100 or more s in dispute ess deductible and coinsurance), you may ask for a hearing within six manths of the date of this notice. To meet the $100, you may combine amounts on other dlaims
that have been denied, including reopened appeals if you recsived a revised decision. You must appeal each daim on time.

{MAD7 } - Alert: The daim information has also been forwarded to Medicaid for review.

[{MA13 } - Alert: You may be subject to penalties if you bill the patient for amounts nat reported with the PR (patient responsibility) group code.

{MA18 } - Alert: The daim information is also being forwarded to the patient's supplemental insurer. Send any questions regarding supplemental benefits to them.

Q Zoom In Q Zoom Qut < ResetView ™9 Codes

2/20/2014
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A dialog window appears asking to confirm the code import.

=
@ WARMIMG: Completing this operation will replace your existing CARC/RARC infarmation.
COMTIMUE ¥
Yes
To replace the existing If you don’t want to replace
CARC/RARCs, click Yes. the existing CARC/RARCs,

click No.

If you select the NO button, the dialog box disappears and no updates are made to
MREP. If you select the YES button, a file dialog box appears.

Import New Code Information e
[ j

|_IMREP Data Files
I:I Startup
Ej Shortcut o EasyPrink_IMSTALL

File name: I j Open
Files of type: | Code File [Cades. ini] =l Cancel /|
<
4. Navigate to the fosder or area you saved the file under step 2. Select the Codes.ini

file and then click the Open button.
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Look jre | {2 MREP Data files ~| « ®cf E-
Codes.ini
File name: I j‘ Open
Files of type: [ Code File [Codes.ini) 5] Cancel |
F

/

Click the Open button.

5. After you press the Open button, a dialog displays confirming the code import was
successful. Click, or select the OK button to close the dialog.

EasyPrinkt ﬂ

Code import Successul

/

Click OK.

6. The latest list of CARC/RARCS exists in the MREP application. To verify that the latest
version exists, select “Code Descriptions” from the Tools menu.
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7. The Easy Print — Reason/Remark/Group Codes dialog box appears.

Note: The Easy Print — Reason/Remark/Group Codes dialog box includes the date of the
latest version of the code list.

.
= Easy Print Code Descriptions [CAGC/CARC/RARC 11/01/2013) (CORE version 3.0.3) PU— [(= [ B fZom

| Description :

1 »  |Procedure postponed, canceled, or delayed.
1 (CORE BUS. SCENARIO) M
10 —

100
01
102
103
104
105
106
107
08

109 Note :

1 Effective Date :1/1/1995
110 Deactivated Date g

111 Date Last Modified :9/30/2007
112 Notes :

Hi CORE Business Scenario  :3

E— -

Code court »> 1372
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How to Print a List of Claims
1. View the list of claims.

For the steps to follow, see How to View a List of Claims for an MREP Remittance Advice.

Pririt

2. Click the print button w at the bottom of the tab or type Alt + B + P.
The Print remit listing window opens.

3. Print the detail listing in one of the following ways:

A. From the Print remit listing window, click Print to print the detail without previewing
it.

u 0 L

Frint “ Prewview Cancel

The Print dialog opens.

Pt 2(x|
-~ Printer
Marme: Broperties...
Status:  Rieady
Type:  HP Laserlet 4200 PS
Wwhere:  TC-B-020
Comment: I” Fiint to file
~Pint rang Copi
o Al Mumber of copies: 1 33
© Pages  from: o
: : I | Collate
£ Selection

| Wik I Cancel

If you neew the properties, click Properties and make changes as necessary.
Click OK. Medicare Remit Easy Print prints the detail at your default printer.

B. From the Print remit listing window, click Preview to view a preview of the printed
page before printing.

Print remit listing

; . &
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The Print Preview window opens.

=
SL- DEEB B o :

Click printer button =" at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.

At this point, you can:

View claim details Click the Claim Detail tab| ~ Clam Detai
or go to the View menu option and select Claim
Detail
For more info, see How to View the Detail for a
Claim.

Search Click the Search tab | Search

or go to the View menu option and select Search
For more info, see How to Search Payment

Information.
View a Summary for the Remittance Click the Summary tab Rl !
Advice or go to the View menu option and select Remit
Summary

For more info, see How to View the Total
Amounts for a Remittance Advice.

View the data that feeds the Remittance Click the Data View tab | Data View
Advice or go to the View menu option and select Data
View
For more info, see Making Sense of the Data
View Tab.
| Glossary

View the CARCs, RARCs, Group Codes, Click the Glossary tab

and Business Sg:enarios for the or go to the View menu option and select
Remittance Advice Glossary

For more info, see How to View the CARC and
RARC Codes.
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How to Print the Detail for a Claim
1. View the detail for the claim.
For the steps to follow, see How to View the Detail for a Claim.

Print
2. Click the print button w at the bottom of the tab, or type Alt + B + P. The
Print remit listing window opens.

Print remit listing x|

Print ¥ Preview Cancel

3. Print the detail listing in one of the following ways:

A. Click Print to print the detail without previewing it.
The Print dialog opens.
Pt L 2]

- Printer
Properties.

MHarne;
Status: Ready

Tupe: HP Laserlet 4200 PS
wherer  TC-6-020

Comment: [~ Piintto fils
;- Print rang Copi
& Al Murber of coples: |1 =]
) Pages fiom o
E - ¥ Collate
| Selection
| ok I Cancel

If you HEW the properties, click Properties and make changes as necessary.
Click OK. Medicare Remit Easy Print prints the detail at your default printer.
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Working with MREP Remittance Advices

B. Click Preview to view a preview of the printed page before printing.

x

LCancel

The Print Preview window opens.

ﬂgPrint preview

S0 DODBBE o | o

8 [] 3]

\

Click printer button = at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.
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How to Print the Remittance Advice Summary
1. View the Remittance Advice Summary.

For the steps to follow, see How to View the Total Amounts for a Remittance Advice.

2. Click the print button ﬂ at the bottom of the tab, or type Alt + B + P.
The Print remit listing window opens.

3. Print the detail listing in one of the following ways:
A. Click Print to print the detail without previewing it.

Print remit listing x|
The Print dialog opens.
print 21|
r— Frinter
MName: Wwoapyrush TCG Properties... |
Status: Feady
Type: HF Lazer et 4200 PS5
Where:  TC-E-020
Comment: [~ Print ta file
— Frint range Copies
LOWY| MNumber of copies: |1 3:
) Pages [rom:l ;o:l
¥ Collate
= Selection
; Ok, I Cancel |

If you need to Oe the properties, click Properties and make changes as necessary.
Click OK. Medicare Remit Easy Print prints the detail at your default printer.
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B. Click Preview to view a preview of the printed page before printing.

Print remit listing =]

. A

The Print Preview window opens.

59 OD@BBB oo

Fage

Click the printer button & at the top of the window.
Medicare Remit Easy Print prints the detail at your default printer.
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Searching Payment Information

You can search by:

e HICN
e Bene Last Name
« |CN

e Bene Account Number
*  Procedure code

» Service date (range of dates in the format MM/DD/YY, MM/DD, MM/YY, DD/YY,
MM, DD, or YY; forward slashes are not required when entering a value in the ‘Value
to Find’ field)

* Rendering Provider Number
e Adjusted Lines

* COB Claims

* Non-COB Claims

* Deductible/Coins Lines
» Coinsurance Lines

* Deductible Lines

e Other Adjustments

e Denied Lines

« NDC

* MSP Claims

¢ Non-MSP Claims
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How to Search Payment Information
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

L

The Medicare Remit Easy Print Claim List tab opens.

.Medicare Remit EasyPrint v3.2 ;Iglll

File Tab ‘iew Report Search Tools Help

. ' Impart

Pavyer Name Payee Mame
AREA INSURAMCE | ACME PHYSICIANS INC,

_Anrchlve [, Restore _XDeIete | q Search | EPrlnt List

| P Report -

Filenz

‘ersion

L | i |
Clairn List Clairn Detail I Rermit Summary Data Yiew I Search I Glossary I

Narne | ACHT | Jtan] | Biled Amount | Paid amourt | From Date | ToDate | A
Obae, sally 1111111 123456739012345 -910.50 -402,53 2{10/2004 2{10/2004 :
Oooe, sally 1111111 123456739012345 910.50 5a7.28 2{10/2004 2{10/2004 .
Oooe, sally 1111111 123456739012345 38.20 12,50 2{11{2005 2112005 .
DRight, Samuel 1111111 12345675901 2345 23760 159.36 32af2005 328/2005 b
Oooe, sally 1111111 123456739012345 406.20 3267 2/10/2005 2{10/2005 .
Oooe, sally 1111111 12345673901 2345 148.80 92,42 319(2005 3(9(2005 .
Oright, Sarmued 1111111 12345673901 2345 40,00 000 12M22i2003 12(22(2003 .
< I B
L Print £ Check all CJuncheck &l |2 Data

Segment count = =206 12/6/2011
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Search tab

Use the drop-
down list to
select the field
you want to
search on.

When
applicable,
enter the value
to find.

If available,
select the radio
button that
corresponds
with your entry
in the Value to
find: field.

2. Click the Search button or the Search tab.
The Search tab opens.

Working with MREP Remittance Advices

—_—

B Medicare Remit EasyPrint v3.2 =]
File Tab Wiew Report Search Tools Help

_’Import | | P Report - | B, Archive | 7 Restore | X pelste q Search | Prink List

Payer Marne I Payee MName | Payes ID | Check Date | Check/EFT ... | Check/EFT ... | Claims | Check/EFT MNumber | Version | Filenz
AREA INSURAMCE  ACME PHYSICIANS INC, 12345675 04/23/05 481.71 EFT 7 12345 00S010x22141 ARESA
< | b

Claim Lisk | Claim Detail I Remik Summary | Data Yiew Search Glossary |
Search Walue ta find: Search Type
I j I = Epact Match = Beins 'Wwith = Cortains ‘

IE Brimt: Results E:Iclaim Detail

12f6(2011
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Hint:

You cannot use

a wild card
character in
the search.

3. Use the drop-down list to select a search field.

Working with MREP Remittance Advices

If applicable, enter the value to find. The Search tab includes three radio buttons for how

the field should be searched (Exact Match, Begins With, or Contains).

To display the “searched” data, you must select one of the radio buttons before clicking
the Search button. The Exact Match, Begins With, and Contains radio buttons are only
available for the HICN, ICN, Bene Account Number, Bene Last Name, NDC, Procedure

Code, and Rendering Provider fields.

If the Search: field is not one of these fields, the Exact Match, Begins With, and Contains

radio buttons are not available.

If you select one of the Service Date formats from the drop-down menu, you can:

» Enter the date in the Value to find field
» Use the drop-down list only to access the Calendar picker for the MM/DD/YY
format only. Use the left and right arrows to select the month, and then click on
the date you want.

.Medicare Remit EasyPrint ¥3.2 =]
File Tab ‘iew Report Search Tools Help
. I t | R tv. Archi .=_':5Rt . Delet ( Si h Prink Lisk
’ T |P epor] A rchive | [, Restore x elete q eart | o Print Lis
Payer Marne I Payee MName | Payes ID | Check Date | Check/EFT ... | Check/EFT ... | Claims | Check/EFT MNumber | Version | Filenz
AREA INSURAMCE  ACME PHYSICIANS INC, 12345675 04/23/05 481.71 EFT 7 12345 00S010x22141 ARESA
| | b
Claim List | Claim Detail I Remik Summary | Data Yiew Search Glossary |
Search Walue to find: Search Type
ISEF\"iCE Date (MM{DD)Y) j I Ij " Exact Match £ Begins With ! Eontains ‘
Sun Mon Tue Wed Thu Fri Sat
26 27 28 29 30 301
2 3 4 5 & 7 8
9 10 46k 12 13 14 15
16 17 1§ 19 20 21 22
23 24 25 26 27 2§ 29
;w12 3 o4 5 6
T aToday: 12/6,/2011
Iﬁ Brimt: Results E:Iclalm Detail
12f6(2011
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The search was
for Sally Doe’s
claims.

Hint:

You can change
the sort order
by clicking a
column
heading.

Hint:

If you cannot
see all the
columns, use
the horizontal
scroll bar at the
bottom of the
screen.

5. Click the Search type to start the search.

Medicare Remit Easy Print returns all of the claim lines/info that match the search.

Working with MREP Remittance Advices

For example, imagine you needed to view all of Sally Doe’s claims. If the remit contains
any claim lines with the name Doe, the Search Tab listview is updated with those claim
lines matching the criteria.

SMedicare Remit EasyPrint v3.2 -8l x|
File Tab Wiew Report Search Tools Help
_'Import | P Report = | | M, archive [ Restore | X pelete | q Search | EF'r'lnt List

Paver Name | Pavee Mame | Pavee ID | Check Date | Check/EFT ... | Check/EFT ... | Claims | Check/EFT Mumber | ersion | Filens
AREA TMNSLIRAMNCE  ACME PHYSICIANS INC, 12345675 04/23/05 451,71 EFT 7 12345 00501 0x22141 AREA
| |

Clairn List Claim Detail I Remit Summary Data View Search Glossary I
ikl
Bene Last Name % Exact Match " Begins With = Contains Search

Mame HICH I Product)Service ID Service Dateis)
Doe, Sally 1111141 SIDii1111 123456759012345 A4450 20040210 - 20040210 12 -15.00
Doe, Sally 11111 SIDi1111 123456759012345 AG196 20040210 - 20040210 1z -235.50
Doe, Sally 111111 SIDi1111 123456759012345 AGBZSS 20040210 - 20040210 1z -411.00
Doe, Sally 111111 SIDiiilt 123456789012345 AB402 20040210 - 20040210 12 -13.05
Doe, Sally 1111111 SIDi1i1t 123456758901 2345 AR44E 20040210 - 20040210 1z -216.00
Coe, Sally 1111111 SaDi1iit 12345675901 2345 AB402 20040210 - 20040210 1z -13.95
Doe, Sally 1111111 SIDii111 123456759012345 A4450 20040210 - 20040210 1z 15.00
Doe, Sally 1111111 SIDii1111 123456759012345 AG196 20040210 - 20040210 12 235,50
Doe, Sally 1111111 SIDi1111 123456759012345 AGBZSS 20040210 - 20040210 1z 411.00
Doe, Sally 1111111 SIDi1111 123456759012345 AG402 20040210 - 20040210 1z 13.05
Doe, Sally 1111111 SIDiiilt 123456789012345 AG446 20040210 - 20040210 12 216.00
Doe, Sally 1111111 SIDi1i1t 12345675901 2345 AB40Z 20040210 - 20040210 1z 13.95
Coe, Sally 1111111 SaDi1iit 12345675901 2345 A4310 20050211 - 20050211 1z 15,40
Doe, Sally 1111111 SIDii111 123456759012345 A4335 20050211 - 20050211 1z Z2.80
Doe, Sally 1111111 SIDi1111 123456759012345 A4450 20050210 - 20050210 1z &.00
Doe, Sally 1111111 SIDi1111 123456759012345 AGOZ1 20050210 - 20050210 1z 375.00
Doe, Sally 1111111 SIDi1111 123456759012345 AG44E 20050210 - 20050210 1z 25.20
Doe, Sally 1111111 SIDiiiit 123456789012345 AB446 20050309 - 20050309 12 28.80
Doe, Sally 1111111 SIDi1i1t 12345675901 2345 AB456 20050309 - 200503509 1z 120,00
| | 2
F Print Results Clairn Detail \

\ \ 12/8/2011

Click the print

button or type Click the Claim Detail

Tab ortype Alt+B +C

+B+
;ﬁ::]t tEis |i':ttgf to display the details for
claims these claims
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Working with MREP Remittance Advices

Making Sense of the Claim List Tab

For the procedure to view the claim list, see How to View a List of Claims for an MREP
Remittance Advice.

Claim List —————» daimlList

tab

sort order.

Hint:

Key F1 displays a
dialog containing
the listview field
names and
values. This
enables screen
reading programs
to read all the
listview fields for
a highlighted
claim.

The claim list tab displays a summary of all of the claims found within the selected remittance:

OMedicare Remit EasyPrint ¥3.2
File Tab Wiew Report Search Tools Help

~lojx|

. ’ Irnpork

| P Repark -

. A Archive

7 Restore X pelete

( Search | Prink List
Q |

Payer Name Payee Mame

AREA TMSLIRARMC ACME PHYSICTANS TNC,

4| | |
Claim Detail I Remik Summary Data Yiew I Search I Glossary I
Marne | ACHT | Jan] | Biled Amount | paid amourt | From Date | ToDate | A
Ooce, sally 1111111 123456789012345 -910,50 -402.53 2/10/2004 2/10/2004 :
Ooce, sally 1111111 123456780012345 310,50 55728 2/10/2004 2}10/2004 .
Ooce, sally 1111111 123456780012345 35,20 12.50 2/11}2005 2j11{2005 .
D Right, Samuel 1111111 123456759012345 237.60 159.36 3fz8/2005 3/28)2005 b
Ooae, saly 1111111 12345675901 2345 406,20 32,67 2}10{2005 21042005 .
Ooae, saly 1111111 12345675901 2345 143,50 9z,42 349/2005 3/9/2005 .
Cright, samuel 1111111 12345675901 2345 40,00 0.00 1212212003 12222003 .
| | 2l
Print fAcheckal | [Juncheckal 1@ pat

ey P | A Chec | [J unchecl (B Data

Segment count = =206 12f6f2011

Name

ACNT
ICN

Billed Amount

Paid Amount

This is the name of the beneficiary that the claim was processed for.
The name field is defined as Last Name followed by the First Name.
A comma separates the two names.

This is any internal number assigned to the claim by the provider.

This is the Internal Control Number (ICN), the uniqgue number
assigned to the claim when it is received by the contractor.

This is the total claim dollar billed amount.

This is the total claim provider billed amount.
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From Date
To Date
ASG

Buttons

Prink
& Check all

[ ] unCheck &l

Display Claim(s)

Working with MREP Remittance Advices

This is the earliest From Date of service on the claim.

This is the latest To Date of service on the claim.

This indicates whether or not the provider has accepted assignment

for the claim.

Print the list. (type Alt + B + P)

Select all of the claims. (type Alt + B + C)

Unselect all of the claims. (type Alt + B + U)

From the Select claims in the claim list by enabling the checkbox for the corresponding claim. To
Tab menu display the selected claims, from the Tab menu option select Display Claim.
option select
Display
Claim Name | AONT | ICN Biled fmount | Paid Amount | From Diste ToDate | =
Ooee, saly 722337 119932404 007301 56.72 33.06 af1afz008 316/ 2005
Dl:lnla. Saly TPE2337 119932404007301 26.50 AES 4f7iz005 4[7iZ005
DFUQH:, Samuel TI22337T 119932404 007301 397.50 184.77 3142005 3142005
D right, Samuel ke 11993240400 7801 397.50 184.77 4005 A 24 00s
BEoce, saly 122337 119932404 007301 264 18.90 621 /2004 61212004
E Right, Samuel TPE2337 119932404007301 397.50 184.77 2182005 Z/18/z005
DF‘.IEIH;; Samusl TrEEaT 119932404007301 397.50 184.77 3lafz00s L2005
Oooe, Saly ke 11993240400 7801 +8.78 e e a2l fanns 1S
[ ooe, sy 122337 119932404 007301 57.74 .35 12j4/2004 124/ 7004
Dl:ln-a. Saly 7722337 119932404007301 26.50 12.69 1442005 1)4i2005 s
DDB. saly TrEEaT 119932404007301 26.50 12.839 2J4fzm08 242005
Oooe, saly TrEENT 119932404 007801 26.50 965 A42005 J4yzo0s
Ooee, saly 77E23I7 119932404007801 26.50 965 442005 4/4f2005
EDM. Saly 7722337 119932404007301 90,60 45.69 2f19/z005 {19 Z005
DDD&!. saly TrE2T 1199324007301 2377 160,20 3flafzons N Bl
Oooe, saly TN 119932404007801 26.50 965 472008 A Ti2005
Ooee, saly 77E23I7 119932404007801 397.50 191.54 121512004 12/15{2004
O right, Saemel TIZZ3IT 113932404007301 57.74 33.85 1)6f2005 1/6§2005
DF‘.IEIH;, Samuel TrE237 11993240M007301 26.50 12.569 2lefzms 2]eizms
DO right, Samue! TNy 119532404007801 26.50 12.69 Aei2005 LT
O right, Semuel TTE2EIT 119932404007801 26.50 .66 462005 4/6f2005
DDE&, Saly TI22337 113932404007301 397.50 184.77 3f15/z005 3152005
HDD@. Saly 7722337 119932404007301 397.50 184,77 A0S 3|‘23|‘|2£II:6 _’ﬁl
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EasyPrint displays the claim(s) information in a vertical line-by-line format.

i 5ally Doe - I € N:119932404007801 _[Ofx

CLAIM
ICH: 119932404007801

Datient Name : #ally Doe
assimmed 'Y

HICH : $JD11111
|ACCNT § T 77EZ3I3T
Claim RBemark Code 1 : MAD7
Clain Remark Code : Ma0L
Clsim Remark Code 3 :

Claim Remark Code ¢

Claim Remark Code & H

Claim Level From Date : 20050407 s
Claim Level To Date 20050407
Patient Responsibility Amount : ooz
Toral Billed Ameunt : z39.83
Total Allowed Amount B U R-4
Toral Deductible Amount B

Total Co-Insurance Amount : .oz
Total Group Code Amount © 238,71
Toral Provider Paid Amount B
Total Interest Amount o

Toral Lave Filing Amounc B

Net Amount 0.1

Forwarded To :
Claiu Status HSE:)
Group & Reason codes & amounts

Service Line £ 1

Rendering Provider : 1135310001
Frow Date : zZO050403
To Date : Z0050403 LI

This format provides the claim data at a glance and allows screen reading software to
interpret the data more easily.
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Claim Detail tab

Service
line

headers \
\AE:ME PHYSICIZNS INC.

Service lines

Working with MREP Remittance Advices

Making Sense of the Claim Detail Tab
For the procedure to view claim detail, see How to View the Detail for a Claim.

The claim detail tab displays all the claim information for each claim(s) that has been checked
on the Claim List tab.

-7 R - - -
laz Medicare Remit EasyPrint v4.2

o ) [

File Tab View Report Search Tools Help
Import Report Archive 7! Restore Delete Search Print List
W iro P re A X Q i
Fayer Name | Payee MName Payee ID | Check Date | Ched/EFT ... | Check/EFT ... | Claims | Chedk/EFT Number Version Filename
AREA INSURANCE ~ ACME PHYSICIANS INC. 12345673 10/10f12 48171 EFT 7 12344 005010X221A1 MNOPHI_2012.X...
Claim List Claim Detail Remit Summary Data View Search Glossary
-
PAYER BUSINESS CONTACT INFORMATION:
Jane Doe
{900)555-5555
NPI £ 1234567830
5 Main Street DATE: 10/10/2012
Cenderville, DA 17111 DACE g 1
CHECE/EFT #£: 12344 E
REND-PROV SERV-DATE DOS DPD-DPROC/MODS DD-NOS BILLED ALLOWED DEDUCT COINS DPROV-DD
RARC SUB-NOS SUB-PROC GRE/CARC CARC-IMT ADJ-QTY BS
MAME:-Right, Samuel HIC:SJD11111 ACNT:7722338 ICH:-11227500001400 ASG:-Y MOR:MAOT MaOl
1234567890 0913 091312 12 REZ0SRZ 24.000 194.40 178.52 0.00 35.30 143.82
12EE co-108 14.88 03
CNTL £: 01
1234567890 0913 031312 12 RE446R2 48.000 43.20 15.68 0.00 3.94 15.74
REE cO-42 23.52
CNTL §: 02
T RESE 33.84 CARC 38.40 CLAIM TOTALS 237.80 199.20 0.00 33.84 159.36
ADJ TO TOTALS: PREV DD INTEREST 0.00 LATE FILING CHARGE 0.00 NET 15536

INFORMATION FOR THE CLAIM:

Note: This is an image of the lower part of the window.

First Line of Claim Line

NAME This is the name of the beneficiary for whom the claim was
processed.

HIC This is the Health Insurance Claim (HIC) number of the beneficiary
for whom the claim was processed.

ACNT This is any internal number assigned to the claim by the provider.
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ICN

ASG

MOA
REND-PROV
SERV-DATE
POS

PD-PROC

MODS
PD-NOS
BILLED
ALLOWED
DEDUCT

COINS

PROV-PD

Working with MREP Remittance Advices

Internal Control Number (ICN); the unique number assigned to the
claim when it is received by the contractor.

Shows whether or not the provider has accepted assignment for the
claim.

Remark codes at the claim level.
Performing provider's ID number.
Date(s) of service.

Two-digit Place of Service (POS) code.

A list of POS codes is available here:
http://www.cms.gov/manuals/downloads/cim104c26.pdf

HCPCS procedure code.
A list of these codes is available here:
https://www.cms.gov/CLIA/downloads/Subject.to.CLIA.pdf

Modifiers billed with the procedure.
Number of services rendered.

Amount the provider billed for the service.
Allowed amount for the service.

Amount of any deductible applied to the claim.

This is the amount that the beneficiary (or other insurer, if applicable)
is responsible for paying the provider.

Amount that the beneficiary (or other insurer, if applicable) is
responsible for paying the provider.

Amount the provider was paid for the service.

Second Line of Claim Line

RARC
SUB-NOS
SUB-PROC
GRP/CARC

CARC-AMT

ADJ-QTY
BS

CNTL #
HCPI

Remittance Advice Remark Codes at the line level.
Submitted number of services.
HCPCS procedure code.

Group Codes and Claim Adjustment Reason Codes for the service
line.

Amount of any adjustment made based on the Group and Claims
Adjustment Reason Code.

Quantity of units of service being adjusted.

CORE-defined Business Scenarios associated with the Claim
Adjustment Reason Code

Line item control number.

Healthcare Policy Identification number.
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Medicare Remit Easy Print

Totals

PT RESP
CARC

CLAIM TOTALS

ADJ TO TOTALS:
PREV PD
INTEREST

LATE FILING
CHARGE

NET

CLAIM
INFORMATION
FORWARDED TO:

CORRECTED
PRIORITY PAYER
INFO:

OTHER CLAIM REL
IDENTIFICATION:

GLOSSARY

Print
frln

Q Zoam In |

Q Zoarn Ok

“ Reset Zoom

[~ Glossary

Working with MREP Remittance Advices

Total amount that the beneficiary owes the provider for this claim
Total amount of all claim adjustments on all service lines

Totals for all service-line level amounts:
BILLED

ALLOWED

DEDUCT

COINS

PROV-PD

Blank in Medicare Remit Easy Print
Interest amount paid for claims processing time

Late filing charge
Amount that Medicare owes the provider for this claim
Appears when the claim is forwarded to a beneficiary’s supplemental

insurer

Corrected priority payer name and/or id number

Additional information relevant to the adjudication of the claim and a
qualifier identifying the type of reference information

Reason, Remark, Group codes, and Business Scenarios that are
also shown on the Glossary tab

Print the claim detail. (type Alt + B + P)

Zoom in to make the size of the type larger. (type Alt + B + 1)

Zoom out to make the size of the type smaller. (type Alt + B + O)

Reset the type to the original size. (type Alt + B + R)

Shows CARCs/RARCs and Business Scenarios with descriptions for

the selected claims when checked. (type Alt + B + S)

© 2005 General Dynamics IT Company. All Rights Reserved.
This document contains GDIT confidential and proprietary information,

which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs.

91



Medicare Remit Easy Print Working with MREP Remittance Advices

Making Sense of the Remit Summary Tab

For the procedure to view the Remittance Advice detail, see How to View the Total Amounts
for a Remittance Advice.

The Remit Summary Tab displays total dollar amounts, claim counts, and provider adjustment
information if present in the selected remittance.

& Medicare Remit EasyPrint v3.3 o [=] 3]
File Tab View Report Search Tools Help
| Import | Report = | Archive R Restore Delete [ Search Print List
W import | [P report ~| [ A Xoeee | Q | m
I Payer Name | Fayee Mame | Fayee ID | Check Date | Check/EFT ... | Check/EFT ... | Claims | Chedk/EFT Mumber | ersion | Filename
Remit AREA INSURAMNCE ~ ACME PHYSICIAMNS INC, 12345678 10/10f12 48171 EFT 7 12344 00501022141 MNOPHI_2012.X...
Summary
tab
Claim List I Claim Detail Remit Summary Data View Search Glossary
EasyPrint V3.3 PROVIDER PAYMENT SUMMARY REPORT VER: 005010XZzZ121
DPROVIDER NAME : ACME DPHYSICIANS INC.
NPT £ : 1234587830
CHECE DATE : 1lo/10/12
CHECE/EFT TRRCE # : lz344
TOTAL CLAIMS = 7
BILLED RMOUNT : 870.80
TOTAL REASON CODE ADJUSTMENT AMOUNT - 213.14
TOTAL ALLOWED AMOUNT : 81z.7&
TOTAL COINSURRNCE AMOUNT : 120.43
TOTAL DEDUCTIBLE AMOUNT : 55.53
TOTAL DPRID TO DROVIDER : 481.70
TOTAL INTEREST AMOUNT : o.01
TOTAL CHECE/EFT RMOUNT : 481.71
PLB ADJ DETAILS: RERSON FCN/OTHER IDENTIFIER RAMOUNT
Le -1.23
Wo 1200122223500012001222233000 111223338 456.78
Print Q Zoom In Q Zoom Out I 4 Zoom Reset
9/13/2012

PROVIDER NAME
PROVIDER #
CHECK DATE

CHECK /EFT TRACE
NUMBER

TOTAL CLAIMS
BILLED AMOUNT

TOTAL REASON
CODE ADJUSTMENT

This is the provider's name.
This is the provider’'s ID number.
This Is the date of the check.

This is the tracking number for the check or EFT.

This is the total number of claims.
This is the total billed amount.

This is the total adjustment amount.
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AMOUNT

TOTAL ALLOWED
AMOUNT

TOTAL
COINSURANCE
AMOUNT

TOTAL DEDUCTIBLE
AMOUNT

TOTAL PAID TO
PROVIDER

TOTAL INTEREST
AMOUNT

TOTAL CHECK /EFT
AMOUNT
PLB ADJ DETAILS

Buttons

Prirk
. rim
Q Zoarm In ‘

Q Zoarm Cuk

« Reset Zoom |

Working with MREP Remittance Advices

This is the total allowed amount.

This is the total amount of coinsurance applied.

This is the total deductible amount.

This is the total amount paid to provider.
This is the total amount of interest applied.
This is the total amount of the check.

This is the remittance-level (PLB) adjustment. This field only appears
if a remittance-level adjustment is present.

Print the summary. (type Alt + B + P)

Zoom in to make the size of the type larger. (type Alt + B + 1)

Zoom out to make the size of the type smaller. (type Alt + B + O)

Reset the type to the original size. (type Alt + B + R)
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Making Sense of the Data View Tab

For the procedure to view the data, see How to View the Data in the Import File.

The Data View Tab displays the remittance fields as they are stored internally in MREP. The

data are stored in what are referred to as Segments. Each segment contains a varying number
of elements or fields.

OMedicare Remit EasyPrint ¥3.2

~lojx|

File Tab Wiew Report Search TO0I5|Help

.’Import | P Repark -

A Archive Tf Restore x Delete

( Search | Prink List
Q |

Paver Mame I Payee Name | Payee ID | Check Date | Check/EFT ... | Check/EFT ... | Claims | Check/EFT Mumber
AREA INSURAMCE  ACME PHYSICIANS INC, 12345675 04/23/05 451.71 EFT 7 12345

| Wersion | Filenz
00501 0x22141 AREA

4

Claim Lisk Claim Detail I Remik Summary

Loop & Segment || Field ID | Description
HDRE @ 5T o1
HDRE : BPR 0z
HORE : TRM
HORE : REF
HORE : REF i
HORE : DTH
10004 @ M1
10004 @ M3
10004 : M4
10004 : REF
10004 : PER.
10008 : M1
10008 : M3
10008 : N4
10006 : REF
2000 Lx
2100 CLP
2100 : MMl
2100 : MMl
2100 : MOa
2100 : DTM
2110 5vC
2110 DTM
2110 CAS
2110 REF
2110 REF
2110 AMT
2110 sV
2110 DTM
2110 CAS

2110: REF .
PPl
1| |L|_I 4 | 2l

Segment counk == 206

Search I Glossary

| ‘alug
Transaction Set Identifier Code 335
Transaction Set Control Number 0001

12f6(2011

The HIPAA 835v4010A1 and 835v5010 formats separate data into segments and loops. To
understand how to read segments and loops, refer to the X12 835 Implementation Guides.
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Making Sense of the Search Tab

For the procedure to view the data, see How to Search Payment Information.

The Search Tab displays a summarized list of claim information that matches the criteria of
the user’s search. The Name field’s format is the beneficiary’s Last Name, followed by a
comma and then the First Name.

Medicare Remit EasyPrint ¥3.2 -10] x|
File Tab Wiew Report Search Tools Help
.’Import | P Report - | A Archive | + Restore | x Delete q Search | EPr'int List
Paryer Name I Payee Name | Payee ID | Check Date | Check/EFT ... | Check/EFT ... | Claims | Check/EFT Mumber | Wersion | Filenz
AREA INSUIRAMCE  ACME PHYSICTIANS INC, 12345678 04/23/05 481,71 EFT 7 12345 00501 0k22141 AREA
| |

Claim Lisk I Claim Detail I Remik Summary I Data Yiew Search | Glossary I

Search ‘alue to find: Search Type

IBEHE Lask Name j IDOE & Euact Match " Beging With  Containz ‘

harme | ACHT | HICH | Jan] | ProductjService I | Service Date(s) | pos | Eilled |
Doe, Sally 1111111 51011111 123456769012345 £4450 20040210 - 20040210 1z -18,00
Doe, Sally 1111111 SID11111 12345676901 2345 6196 20040210 - 20040210 12 238,50
Doe, Sally 1111111 51011111 123456768901 2345 86253 20040210 - 20040210 1z 411,00
Doe, Sally 1111111 51011111 123456769012345 6402 20040210 - 20040210 1z -13.05
Doe, Sally 1111111 51011111 123456769012345 BG4 20040210 - 20040210 12 -216,00
Doe, Sally 1111111 51011111 12345675001 2345 G402 20040210 - 20040210 1z -13.95
Doe, Sally 1111111 SID11111 1234567689012345 14450 20040210 - 20040210 12 18,00
Doe, Sally 1111111 SID11111 123456769012345 6196 20040210 - 20040210 12 238.50
Doe, Sally 1111111 SID11111 123456769012345 6253 20040210 - 20040210 1z 411,00
Doe, Sally 1111111 51011111 123456768901 2345 G402 20040210 - 20040210 1z 13.05
Doe, Sally 1111111 51011111 123456769012345 Prrre) 20040210 - 20040210 1z 216.00
Doe, Sally 1111111 51011111 123456769012345 G402 20040210 - 20040210 12 13.95
Doe, Sally 1111111 51011111 12345675001 2345 £4310 20050211 - 20050211 1z 15.40
Doe, Sally 1111111 SID11111 123456759012345 4338 20050211 - 20050211 1z 22,80
Doe, Sally 1111111 SID11111 123456769012345 £4450 20050210 - 20050210 12 6,00
Doe, Sally 1111111 SID11111 123456769012345 AGOZL 20050210 - 20050210 1z 375,00
Doe, Sally 1111111 51011111 123456768901 2345 BG4 20050210 - 20050210 1z 25.20
Doe, Sally 1111111 51011111 12345676901 2345 BG4 20050309 - 20050309 1z 268,80
Doe, Sally 1111111 51011111 123456769012345 16456 20050309 - 20050309 12 120,00
1] | i
P Print Results Clairn Detail

12{6(2011

Buttons

) Print the list of claims from the search. (type Alt + B + P)
Print Results

) . View details for all of the claims from the search. (type Alt + B + C)
Claim Detail
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Making Sense of the Glossary Tab

For the procedure to view the data shown in the Glossary Tab see How to View the CARC and
RARC Codes.

The Glossary tab displays the CAGC/CARC/RARC code and Business Scenario with
descriptions for the selected remittance.
£ Medicare Remit EasyPrint v4 2 A — - T || & i)

File Tab View Report Search Tools Help

W mport P Report | | i\ Archive | [ Restore | JK Delete Q Search Print List

Payer Name | Payee Name PayeelD | CheckDate | Chedd/EFT ... | Check/EFT... | Claims | Check/EFT Number Version Filename

AREA INSURANCE  ACME PHYSICIANS INC. 12345678 10/10/12 8171 EFT 7 12344 005010X221A1  NOPHI_2012.X...
Claim List | Claim Detail | Remit Summary Data View Search Glossary

{ 18 } - Exact duplicate daim/service (Use anly with Group Code OA except where state workers' compensation regulations requires CQ)

{23} - The impact of prior payer(s) adjudication induding payments andjor adjustments. (Use only with Group Code OA)

{2 (BS) } - Additional Information Required - Missing/Invalid/Incomplete Data from Submitted Claim

13 (B5) } - Biled Service Not Covered by Health Plan

{42} - Charges exceed our fee schedule or maximum allowable amount. {Use CARC 45)

{ 50 } - These are non-covered services because this is not deemed a 'medical necessity' by the payer. Note: Refer to the 835 Healthcare Policy Identification Segment (loop 2110 Service Payment Information REF), if present.

m

{ 57} - Payment denied/reduced because the payer deems the information submitted does not support this level of service, this many services, this length of service, this dosage, or this day's supply.

{CO} - Contractural Obligations

{ CR } - Correction and Reversals

{16} - Interest Owed

{M25 } - The information furnished does not substantiate the need for this level of service. If you believe the service should have been fully covered as billed, or if you did not know and could not reasonably have been expected to know that we would not pay
for this level of service, or if you notified the patient in writing in advance that we would not pay for this level of service and hefshe agreed in writing to pay, ask us to review your daim within 120 days of the date of this notice. If you do not request an
appeal, we will, upon application from the patient, reimburse him/her for the amount you have collected from him/her in excess of any deductible and coinsurance amounts. We will recover the reimbursement from you as an overpayment.

{{MAD1} - Alert: If you do not agree with what we approved for these services, you may appeal our dedision. To make sure that we are fair to you, we require another individual that did not process your initial daim to conduct the appeal. However, in order
to be eligble for an appeal, you must write to us within 120 days of the date you received this notice, unless you have a good reason for being late.

{{MAD3 } - If you do not agree with the approved amounts and $100 or more is in dispute (less deductible and coinsurance), you may ask for @ hearing within six months of the date of this notice. Te meet the $100, you may combine amounts on other dlaims
that have been denied, induding reopened appeals if you received a revised dedision. You must appeal each daim on time.

{MAD7 } - Alert: The daim information has also been forwarded to Medicaid for review.

{Ma13} - Alert: You may be subject to penalties if you bill the patient for amounts not reported with the PR {patient responsibility) group code.

{{MA18 } - Alert: The daim information is also being forwarded to the patient's supplemental insurer. Send any questions regarding supplemental benefits to them.

@ zoomIn (2 ZoomOut |« ResetView % Codes

27202014

Buttons
Q T T Zoom in to make the size of the type larger. (type Alt + B + 1)

Q Zaanm Cut Zoom out to make the size of the type smaller. (type Alt + B + O)

© 2005 General Dynamics IT Company. All Rights Reserved.
This document contains GDIT confidential and proprietary information,
which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs.

96



Medicare Remit Easy Print Working with MREP Remittance Advices

W Reset the type to the original size. (type Alt + B + R)

| Displays CARCs/RARCs and descriptions for the selected claims

SO Codes when checked. (type Alt + B + S)
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Working with Reports
Medicare Remit Easy Print provides 11 different reports, including:
» Denied Service Lines
* Adjusted Service Lines
» Deductible Service Lines
» Coinsurance Service Lines
» Deductible/Coinsurance Service Lines
e COB Claims Report
* Non-COB Claims Report
e MSP Claims Report
e Non-MSP Claims Report
*  Other Adjustment Report
* Entire Remittance
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Making Sense of the Denied Service Lines Report

This report displays claim service lines that have an allowed amount equal to zero and are
associated with a claim that does NOT have a claim status 22 (reversed claim). The report
includes only the lines on the claim that meet these criteria.

Denied Service Line(s) Report
Generated: 922 2009 9:26:34 AM

Carwer: ALRE2 INSURANCE

Fagee #: 0208350001

Payee Wame:  ACME PHYSICIANE INC.

Chik Date: e

Chk /EFT # 12345

Zaeq # FProuH/NFI ACHT # / Name ICH/HICH Lok ZFerrice Date(s) Frod/fexv ID Filled Allowed Deduct Coins Fd to Prow

00001 0203950001 7722227 119932404007601 01 12/22/02-12/22/ 02 aB2E1 a0 .00 0.0 000 o_o0 n.o0
Right Zamuel EJD11111 Al Reason Code: CO-15 Remark Codes: Nili

40,00 0.0 0. 00 o.00 0.00
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Making Sense of the Adjusted Service Lines Report
This report displays claims that have a status of 22 (reversed claim).

This report does NOT show the adjustment claim that reflects the corrected dollar amounts.

Adjusted Service Line(s) Report
Generated: 97212009 12:24:21 PM
Carrier: ARER INSTURANCE
Payee §: 0z0G980001
Payee Hame: ACME PHYSICIANS INC.

Chk Date: 04/23/05

Chk/EFT #: 12345

Seq # Drov# /NPT ACNT # 7/ Name ICNSHICH ILn# Service Date(s) Prod/sServ ID Billed Allowed Reduct Coina Ird to Prov

0000l 0208980001 7122337 119332404007801 01 02/10404-02/10/04  Ad450 -158.00 -13.20 0.00 -2.64 -10.56
Doe Sally AJD11111 AT Reason Code: CR-42 CR-2 Remark Codes:

0pooz  0zZosss0001 7122337 119332404007801 02 02/10404-02/10/04 45196 -238.50 0.00 0.00 0.00 0.00
Doe Sally AJD11111 Al Reason Code: CR-50 Remark Codes: M25 H102

00003 0208980001 7122337 119332404007801 03 02/10404-02/10/04 AGZ253 -4ll.00 -380.40 0.00 -76.08 -304. 32
Doe Hally SID11L11 F Reason Code: CR-42 CR-2 Remark Codes:

00004 0208950001 TI22337 119932404007801 04 02/10/04-02/10/04 Af402 -13.058 0.00 0. o0 0.00 0.00
Doe Sally AJD11L11 a1l Reason Code: CR-57 Remark Codes: M23 H115

00005 0208950001 TI22337 119932404007801 05 02/10/04-02/10/04 46446 -216.00 -95.40 0. o0 -19.68 -78.72
Doe Sally AJD11L11 A2 Reason Code: CR-42 CR-2 Remark Codes:

00006 0208950001 TI22337 119932404007801 08 O02/10/04-02/10/04 46402 -13.95 -11.14 0. o0 -2.23 -8.93
Doe Sally AJD11L11 a1l Reason Code: CR-42 CR-2 Remark Codes:

-910. 50 -503.16 0.00 -100.63 -402.53
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Making Sense of the Deductible Service Lines Report

This report shows claim service lines that have deductible amounts greater than zero, as well
as those service lines with only deductible amounts greater than zero. It includes only the lines
on the claim that meet these criteria.

Deductible Service Line(s) Report
Generated: 97212009 12:36:43 PM
Carrier: AREA INSURANCE
Payee #: 0z08880001
Payee Hame: ACME PHYSICIANS INC.

Chk Date: 04/23/05

Chk/EFT #: 12345

Seq # IProv#/NPI ACNT # / Name ICN/HICN Lu# Service Date(s) ErodsServ ID Billed Allowed Deduct ki to Pror

00001 0208950001 TIEZE33T 119932404007801 01 02/11/05-02/11/05 A4310 15.40 13.12 13.12 0.00
Doe Sally SID11111 Ex Reason Code: PR-1 CO-42 Remark Codes:

00002 0208950001 TIEZE33T 119932404007801 02 02/11/05-02/11/05 A4333 22.60 22.80 .17 1Z.50
Doe Sally SID11111 Ex Reason Code: PR-1 FR-2 Remark Codes:

00003 0208950001 TIEZE33T 119932404007801 01 02/10/05-02/10/05 A4450 6.00 4.40 4.40 0.00
Doe 3ally 5ID11111 AT Reason Code: PR-23 PR-1 Remark Codes:

CD-42 DA-23

00004 0208980001 7722337 119932404007501 02 02/10/05-02/10/05 ABOZL 375.00 315.30 30.384 31.53

Doe Sally SID11111 A1 Reason Code: PR-23 PR-1 Remark Codes:

PR-2 CO-42 OR-23

419. 20 3556.62 55.53 44.03

© 2005 General Dynamics IT Company. All Rights Reserved.
This document contains GDIT confidential and proprietary information,
which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs.

101



Medicare Remit Easy Print Working with Reports

Making Sense of the Coinsurance Service Lines Report

This report shows claim service lines that have coinsurance amounts greater than zero, as well
as those service lines with only coinsurance amounts greater than zero. It includes only the
lines on the claim that meet these criteria.

Coinsurance Service Line(s) Report
Generated: 9/21/2009 12:39:21 PM
Carrier: AREAR INSURANCE
Payee #: 0208950001
Payee Hame: ACME PHYSICIANS INC.

Chk Date: 04723705

Chk/EFT #: 12345

Seg # Prov#/NPI ACNT # / Name ICN/RICH Ln# Service Date(s) Prod/Serv ID Billed Allowed Coins 3 to Prov

0000l 0Z08930001 7722337 119932404007801 01 02/10/04-02/10/04 A4450 15.00 13.20 2.64 10. 56
Doe Hally SID11111 AW Reason Code: PR-2 C0-42 Remark Codes:

o000z 0zZ08930001 7722337 119932404007801 02 02/10/04-02/10/04 AG196 238. 50 2z0.50 44.10 176. 40
Doe Sally BID11111 Al Reason Code: PR-2 C0-42 Remark Codes:

00003 0208930001 7722337 119932404007501 03 02/10/04-02/10/04 ABZ53 411.00 380.40 76.08 304,32
Doe Sally SID11111 Az Reason Code: PR-2 C0-42 Remark Codes:

00004 0zZ08930001 7722337 119932404007801 04 02/10/04-02/10/04 Ag402 15.05 10.44 2.09 8. 35
Doe Sally SID11111 al Reason Code: PR-2 C0-42 Remark Codes:

00005 0Z08930001 7722337 119932404007801 05 02/10/04-02/10/04 Ag446 216.00 95.40 19.66 78.72
Doe Hally BID11111 Az Reason Code: PR-2 C0-42 Remark Codes:

00006 0208980001 7722337 119932404007801 06 02/10/04-02/10/04 Af402 15.95 11.16 2.23 8.93
Doe Hally BID11111 AlCC Reason Code: PR-2 C0-42 Remark Codes:

Qo007 0208980001 77a23ar 119932404007801 02 02/11/05-02/11/05 A4336 22.80 22.80 3.13 12.50
Doe Sally SIDL1111 KX Reason Code: PR-1 PR-2 Remark Codes:

00006 0208980001 77a23ar 119932404007301 01 03/28/05-03/28/05 AG209 194, 40 179.52 35.90 l43.62
Right Samuel SID11111 Az Reason Code: PR-2 C0-42 Remark Codes: H§d

0Oo0oe  0Z08980001 772233 119932404007801 02 03/25/05-03728/05 A6446 43. 20 19.68 3.94 15.74
Right Samuel SID11111 Az Reason Code: PR-2 C0-42 Remark Codes: H§d

00010 0Z08980001 772233 119932404007801 02 0Z2/10/05-02/10/05 AGOZ1 375.00 315.30 T.65 31.53
Doe 3ally 3ID11111 Al Reason Code: PR-23 PR-1 Remark Codes:

FR-2 CD-42 OR-23

0001l 0zZ08930001 7722337 119932404007801 03 02/10/05-02/10/05 Af446 25.20 11.43 0.32 1.14

Doe Sally SID11111 al Reason Code: PR-23 PR-2 Remark Codes:
C0-42 0R-23

ooolz 0zZ0gS8000L1 772233 119832404007301 01 03/09/05-03,09/05 AGddE 28.80 13.1z2 2.62 10.50
Doe Hally SID11111 al Reason Code: PR-2 C0-42 Remark Codes:

00013 02089530001 7722337 119932404007501 02 03/09/05-03/09/05 A6456 1zo.00 loz.40 20.48 8l.92
Doe 3ally 3ID11111 Al Reason Code: PR-2 CD-42 Remark Codes:

1719.90 1398.40 221.06 884.23
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Medicare Remit Easy Print

Working with Reports

Making Sense of the Deductible/Coinsurance Service Lines Report

This report shows claim service lines that have both deductible and coinsurance amounts

greater than zero, as well as those service lines with only coinsurance and deductible amounts

greater than zero. It includes only the lines on the claim that meet these criteria.

Carrier:
Dapes #:
Payee Name:
Chk Date:
Chk/EET #:

Seg #  ProvisNrr

AREA INSURANCE
0205950001

ACME PHYZICIANS INC.
04/ E2i05

lzzas

ACNT F S Weme

00001 0205950001 TMezeaT
Doe Bally
00002 0205950001 TreeEaT
Doe Bally
00002 0205950001 TMezeaT
Doe Bally
00004 0205950001 TMezeaT
Doe Bally
00005 0205950001 TMezeaT
Doe Sally
00006 0205950001 TMezeaT
Doa Bally
00007 0205950001 TMezeaT
Doe Bally
00005 0205950001 TMezeaT
Doe Bally
00008 0205950001 TMezeaT
Bight Sammel
00010 005950001 TrEzEIT
Bight Sammel
00011 0205950001 TMezeaT
Doe Bally
00012 0205950001 TMezeaT
Doe Bally
0001 0205950001 TMezeaT
Doa Bally
00014 0205950001 TMezeaT
Doe Bally
00015 0205950001 TMezeaT
Doe Bally

Deductible/Coinsurance Service Line(s) Report

ICHHICH
119222404007501
2JD011111
1199 22404007501
2JD011111
119222404007501
2JD011111
119222404007501
2JD011111
119222404007501
5J011111
119222404007501
2J011111
119222404007501
2JD011111
119222404007501
2JD011111
119222404007501
2JD011111
1199 22402007501
2JD011111
119222404007501
2JD011111

119222404007501
2JD011111

119222404007501
2J011111

119222404007501
2JD011111
119222404007501
2JD011111

L
01

Generated: 9/11,/2009 11:46:15 AM

Service Datefs)
02/ 10/ 04-027 10/ 04

ogf 10/ 04-02/ 10/ 04

0gf 10/ 04-02/ 10/ 04

0gf 10/ 04-02/ 10/ 04

0gf 10/ 04-02/ 10/ 04

0gf 10/ 04-02/ 10/ 04

0/ 11/ 05-08/11/ 08

0/ 11/ 05-08/11/ 08

03/ 28/ 05-02/ 28/ 08

0 zsf 0503 25/ 05

0&f 10/ 05-02/10/ 05

0/ 10/ 05-02/10/ 05

0/ 10/ 05-02/10/ 05

03/ 09/ 05-02/03/05

03/ 09/ 05-02/03/05

Prod/ferv ID

43350
AT
A6196
Al
ABZ 52
AZ
A630Z
Al
AE3 A6
B
A630Z
aloo
43210
K
&3228
K
A6203
AZ
ELEET
AZ
43350
AT

AB0Z21
Al

AE3 A6
al

AE3 A6
Al
AE2 56
Al

Billed Allopwmed
ls.00 1z.20
Reason Code: PR-2 CO-42
235.50 zzo. 50
Reason Code: PR-2 CO-42
4l1.00 250_ 40
Reason Code: PR-2 CO-42
lz2.05 10. 44
Reason Code: PR-2 CO-42
Zls.00 5.40
Reason Code: FPR-2 CO-42
1235 11,16
Reason Gode: PR-2 00-42
15_40 1z.1:2
Reason Code: PR-1 CO-42
Zz.&0 Zz.80
Reason Code: PR-1 PR-2
134._40 17352
Reason Code: PR-2 CO-42
4320 19. 68
Reason Code: PR-2 CO-42
E.00 4. 40
Reason Code: PR-23 PR-1
CO-42 0R-23
275.00 215.20
Reason Code: PR-23 PR-1
PR-2 C0-42 OR-23
Z5.z0 11.43
Reason Code: FR-23 FR-2
CO-42 0R-23
25.80 1z.1:2
Reason Code: PR-2 CO-42
lza.aa l0z._ 40
Reason Code: PR-2 CO-42
1741.30 1415. 392

Deduct
0.00
Remark
0. 00
Remark
0.00
Remark
0.00
Remark
0.00
Remark
0.00
Remark

13,12
Remark
7.17
Remark
0.00
Remark
0.o0
Remark
440
Remark

0. 84

Remark

0.00

Remark

0.00
Remark
0.00

Remark

55.53

Coins
.64
Codes:
44.10
Codes:
TE.08
Codes:
.09
Codes:
19.68
Codes:
Z.23
Codes:
0.00
Codes:
.12
Codes:
25.90
Codes: NE&
294
Codes: NE&
0.00
Codes:

T.85
Codes:

0.2z
Codes:

Z.62

Codes:
Z0.48

Codes:

221.086

P2 to Prov
lo.s56

2l.52

lo.sa

sl.3:z

G54, 23
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Medicare Remit Easy Print Working with Reports

Making Sense of the COB Claims Report

This report shows those claims on the HIPAA 835v4010A1 or 835v5010 file that were crossed
over. The requirement for crossover claims to print on the report is that the 2100 loop, CLP02
data field must contain one of the following values:

19 Processed as Primary, Forwarded to Additional Payer(s)
20 Processed as Secondary, Forwarded to Additional Payer(s)
21 Processed as Tertiary, Forward to Additional Payer(s)

COB Claims Report
Generated: 9/11/2009 12:04:5% PM

Carxier: AREA INEURANCE

Fayes #: 0206950001

Payee Hame: ACME FPHYSICIANS INC.

Chk Date: 0422 05

Chk/EFT #: lzzas

Seqh LCHT# Hame HICH ICH Eilled Rllowed Deductible COINR: Paid
0000l 7722337 Doe, Sally SID11111 119922404007501 910 50 724 10 o_o0 146 52 58728

Processed a5 primary, forwarded to SVPPLEMENTAL INSURER

non0z  77EEEeT Right, Bammel EJD11111 119922404007601 z27_ 60 199 .20 0.0 29.54 15926
Processed as primary, forwerded to UNENOWHN

o000z ez Doe, Bally 3J011111 119922402007501 las._ &0 115 .52 o.ao &2.10 qz.4az
Processed a5 primary, forwarded to BCES OF SOUTH CAROLINA (FEP)

12496, 90 1045 .82 .00 209.76 &39. 06
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Medicare Remit Easy Print Working with Reports

Making Sense of the Non-COB Claims Report

This report shows those claims on the HIPAA 835v4010A1 or 835v5010 file that did not cross
over. The requirement for claims to print on the report is that the 2100.CLP02 data field does
not contain one of the following values:

19 Processed as Primary, Forwarded to Additional Payer(s)
20 Processed as Secondary, Forwarded to Additional Payer(s)
22 Processed as Tertiary, Forward to Additional Payer(s)

WON COB Claims Report
Gernerated: 9/11/2009 12:05:31 PM

Carxier: AREA INEURANCE

Payee #: 0Z08950001

[P agee Hame: ACME PHYSICIANS INC.

Chk Date: 04/ 2208

Chk/EFT #: lz345

2 e gl LONT# Hame HICH ICH Eilled Allowed Deductible COIRE Paid
o0oal wRzEeen Dee, Sally 3J011111 119922404007501 25,20 25 .92 Zn.z9 2.1 lz_50
o000z 772237 Doe, Eally SJD11111 119922404007801 A0E. 20 231.1% 25.29 5.17 22,87
o0oaz  rzEaen Right, Samrmel 2JD11111 119322404007501 40.00 0.00 o.ao 0.00 0.0a0

454, 40 367.10 55.53 11.30 45.17
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Medicare Remit Easy Print Working with Reports

Making Sense of the MSP Claims Report

This report contains those claims, within a remittance, on the HIPAA 835v4010A1 or
835v5010 file that were processed by Medicare as secondary. The claims have a value of 2

(Processed as Secondary) or 20 (Processed as Secondary, Forwarded to Additional Payer(s)) in
the 2100 loop, CLPO2 data field.

MSP Claims Report
Generated: 117232000 9:37:07 aM

Carrin:: PAYER INC,

Pagwe #: SBTE 543210

Paywe Name:  JOHNSON PHATIACY INC

Chi Date: 04424410

Chi/EET W: 00050045578

Saghl  RCNTH i HICH ICH Billed B el Deductible  COINS Padid

00001 245YET GARY, MATTHEW SEEESEEESA L1234 EETES000 1082 13 676.2% 0.00 135, 26 £41.03
108z 13 T 2N 000 135, 26 F4l. 00
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Medicare Remit Easy Print Working with Reports

Making Sense of the Non-MSP Claims Report

This report contains those claims, within a remittance, on the HIPAA 835v4010A1 or
835v5010 file that were processed by Medicare as primary. The claims have a value of 1

(Processed as Primary) or 19 (Processed as Primary, Forwarded to Additional Payer(s)) in the
2100.CLPO02 data field.

NON MSP Claims Report
Generated: 11[Z3/2010 9:17:19 AM

Coxrier: PAYER IHC.

Payee #: SRTEE4IZL0

Pajwe N JOHNEON PHARMLACY INC

Chk Date: 0d/244 10

ChiJEFT §i: OOD500 34567

Segil  RCNTH N HICH ICH Billed Ml Loweed Deductible COINS Padd
00001 1AIBAC THOMAS, CHARLES 2399959594 101234567 23000 1082 13 B76. 29 a.on 135. 26 54103

168213 676 29 a.on 135, 26 S41.0%2
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Medicare Remit Easy Print

Making Sense of the Other Adjustments Report

Working with Reports

This report shows those claims on the HIPAA 835v4010A1 or 835v5010 file that had some
type of adjustment. Claims that have Late Filing and Interest and remittances that have
Withholding and a Forwarding Balance print on the report.

Carrer: ALFER INSURANCE

Payee #: 1224567690

Payee Fame:  ACME PHYS ICIANE INC.

Chk Date: 04/ zz/05

Chk /EFT #: lzz4s
Taqh Mame
o001 Doe, Fally
o000z Right, Samusl
o000z Dee, Bally
LRITEY Doe, Fally

RCHTH

MEz R
722337
7722337
TTEZEIT

Withhelding/Capitation (PLE=EZ) :
Withholding/Reeel. Pmt (FLE=RE)

Tithholding/IRS (FLE=IE] :
Drerpayment Resovery (PLE=WD) -
Forwarding Falance [PLE=FE] :

Other Adjustments Report
Generated: 7/15/2011 12:08:00 EM

HI CH

SJD11111
2J01L111
2J01L111
SJ011111

IcH

119322404007801
119932404007501
119932404007501
119932404007501

13

13,
24 .
15.

42
33.

a1
i
30

33

Rdjustment

2

1
1
2

-5
-5
.75
.22

Dasaription
Interest
Intezest
Intaezest
Interesn
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Medicare Remit Easy Print Working with Reports

How to Print the Denied Service Lines Report

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

S

The Medicare Remit Easy Print Claim List tab opens.

OMedicare Remit EasyPrint ¥3.2 -10] x|
File Tab “iew Report | Search Tools Help

’Import | P Report A A Archive 7 Restore x Delete Q Search | Prink List

Paryer Name I Payee Namé | Payee ID | Check Date | Check/EFT ... | Check/EFT ... | Claims | Check/EFT Mumber | ersion | Filenz

AREA INSURAMCE  ACME PHYSTOTANS IMC, 12345678 04/23/05 451.71 EFT 7 12345

005010522181 AREA

| i
Claim Deté‘ I Remik Summary Data Yiew | Search | Glossary |
Name [\ ACHT | ICH | Billed Amount: | Paid mount | FromDate | ToDate | &
[bae, sally 1111111 123456759012345 -910.50 -402,53 2{10/2004 2/10/2004 :
Ooae, sally 1111111 123456759012345 38.20 12.50 2{11/2005 /112005 :
Oright, samuel 1111111 123456759012345 40,00 0,00 12f22j2003 12(22{2003 :
Ooae, sally 1111111 123456759012345 148.80 92,42 3f9(2005 3(9(2005 :
Oright, samuel 1111111 123456759012345 237.60 159,36 3f28/2005 328/2005 :
Ooae, sally 111111 123456759012345 406.20 3267 z{10/2005 2/10/2005 :
Ooae, sally 123456759012345 910.50 587.28 2{10/2004 2/10/2004 :
4 | H
Print EA Check all CJuncheck Al i@ Data \

\ 12/8/z011

\

A. Click the down arrow on the Report button.
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Medicare Remit Easy Print Working with Reports

The Report List appears.

\ :Medicare Remit EasyPrint ¥3.2

(ol x|
File Tab ‘iew Report Search Tools Help

.flmport | P Report Iv

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List
f

Payer Mame Adjusted Service Lines Flen | checkDate | checkierT ... | checkiErT ... | laims | CheckiEFT Mumber | version | Fileriz
AREA INSURAN OO [ Mon-COE Claims L) T 04/23(05 481,71 EFT 7 12345 005010%22141 AREA

Deductible | COINS Service Lines ¥

Jenied 5 » Print

ISP | Mon-MSP Claims: 3 Export

Cther Adjustrments »]

Erntire Remittance \
| | i

Claim List Clairn Deta\ I Rermit Summary Data Yiew I Search I Glossary I
Name I\ ACHT | IcH | Biled Amount | PaidAmount | FromDate | ToDate | &
Doe, Sally 1111111 123456789012345 -910.50 -402.53 2/10/2004 2j10/2004 :
Doe, Sally 1111111 123456789012345 38.20 12.50 2(11/2005 2j11/2005 .
Oright, Sarmuel 111111 123456789012345 40.00 0,00 12fz2{2003 12{22{2003 :
Doe, Sally 111111 123456789012345 148.30 az.42 3f9/2005 3f9/2005 :
D Right, Samuel 1111111 123456759012345 237.60 159.36 3{28{2005 3/28/2005 b
Doe, Sally 1111111 123456739012345 406.20 3267 2/10/2005 2{10/2005 .
Doe, Sally 1111111 123456739012345 910,50 5a7.28 2{10/2004 2{10/2004 .
l | ©
Print A Check all ] Uncheck &l \[!?\ Data
\ 12{5{2011

\
3. Select Denied Service Lines.
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Medicare Remit Easy Print Working with Reports

4. The Print and Export options appear:

OMedicare Remit EasyPrint ¥3.2 1Ol x|
File Tab Wiew Report Search Tools Help

( Search | Print List
q =]

CheckiEFT ...

.'Import | P Report Iv

Payer Narme Adjusted Service Lines
IETSNE, OB [ Mon-COE Claims
Deductible | COING Service Lines
Deni Lines

B, rchive 7 Restore ¥ pelete
"

CheckiEFT Murber

Check Date
0

Wersion
00s0

* vEd v v -
)

MSP | Mon-MSP Claims Vialali

Other Adjustments

Entire Remittance

K | |
Claim List Clairn Detail I l Remit Summary Data Yiew I Search I Glossary I

harme | achT | Jan] | Biled Amount | Paid amourt | From Date | ToDate | &
Ooce, saly 123456789012345 -910.50 -402.53 2110/2004 2/10/2004 :
Ooce, saly 123456789012345 310,50 587,28 2(10/2004 2/10/2004 :
Ooce, saly 123456789012345 38.20 12.50 2{11/2005 2/11/2005 .
Oright, sarmuel 123456789012345 237.60 159.36 3(28/2005 3/28/2005 .
Ooce, saly 123456789012345 406.20 32.67 2(10/2005 2}10/2005 .
Ooce, sally 123456789012345 148,80 92,42 3i9/2005 3j9/2005 .
Oright, saruel 123456789012345 40.00 0,00 124222003 12}22/2003 .

1]
L Print | BAcheckal | I:JUr/:heck all ﬂ’\ Data

| ©i

Segment count = >206 I 12/7/2011

I
5. Select Print.

The Print denied line report window opens.

Print denied line report k|
| Frint 1\'_\ Presigw Caricel

6. Print the detail listing in one of the followr S:

A. From the Print denied line report window, click Print to print the detail without
previewing it.
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Medicare Remit Easy Print Working with Reports

The Print dialog opens, for example:

Print 21|
— Frinter
Mame: \papurush T CE Properties... |
Statuz: Ready
Type: HP Laserlet 4200 PS
“Where:  TC-E-020
Commernt I™ Print to fls
— Frint range Copies
Lol MNumber of copies: |1 3:
 Pages from: I b I
V¥ Collate
| {7 Selection
I LS I Cancel |

If you need to chan
necessary.

€ properties, click Properties and make changes as

Click OK. Medicare Remit Easy Print prints the detail at your default printer.

B. From the Print denied line report window, click Preview to view a preview of the
printed page before printing.

Print denied line report K|
'
| Presiew Cancel

| Print

The Print Preview window opens.

OOB® 8 | oo

Click the printer button = at the top of the window.
Medicare Remit Easy Print prints the detail at your default printer.
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Medicare Remit Easy Print

How to Export the Denied Service Lines Report
You export the report in .csv (comma separated values) format.

Working with Reports

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon

&

The Medicare Remit Easy Print Claim List tab opens.

&8 Medicare Remit EasyPrint v3.2 =[]
File Tab ‘Wiew Report | Search Tools Help
_'Import | P Report - | | B aechive [ Restore | X Delete | q Search | EF'r*lnt List
Paver Mame | Pavee Nanﬁ | Pavee ID | Check Date | Check/EFT ... | Check/EFT ... | Claims | Check/EFT Mumber | ‘ersion | Filene
AREA INSURAMCE  ACME PHYSTOTANS INC, 12345675 04/23/05 451.71 EFT 7 12345 0050105221481 AREA
| 0
Claim Detajl I Remit Summary Data View I Search I Glossary I
Marne [\ ACHT | Jan] | Biled Amount | Paid amourt | From Date | ToDate | &
Oooe, sally 111111 123456759012345 -910,50 402,53 2/10{2004 2}10/2004 .
Ooce, saly 111111 12345675901 2345 38,20 12.50 2/11f2005 2}11j2005 .
Cright, Samuel 111111 12345675901 2345 40,00 0.00 1242242003 12{22}2003 .
Ooce, saly 111111 12345675901 2345 145,80 92,42 349(2005 3/9(2005 .
Oright, samuel 1111111 123456759012345 23760 159,36 3f28/2005 3/28)2005 i
Oooce, saly 12345675901 2345 408,20 32,67 2/10{2005 21102005 v
Ooce, saly 123456758901 2345 910,50 557,28 2/10{2004 2}10/2004 v
| | ©
L Print A Check Al [ Uncheck &l 1D Data \
\ 12j8/2011

\
2. Click the down arrow on the Report button.
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Medicare Remit Easy Print Working with Reports

The Report List appears.

B8 Medicare Remit EasyPrint v3.2 10l x|
File Tab ‘iew Report Search Tools Help
flmport P Report |- | | M Archive . Restare X Delete | q Search | Print List
Payer Mame Adjusted Service Lines Flen | checkDate | checkierT ... | checkiErT ... | laims | CheckiEFT Mumber | version | Fileriz
AREA INSURAN OO [ Mon-COE Claims L) T 04/23(05 481,71 EFT 7 12345 005010%22141 AREA
Deductible | COINS Service Lines ¥
3 Print
MSP | Mon-MSP Claims A 3 Export
Cther Adjustrments »]
Erntire Remittance
| | i
Claim List Clairn Detail I Rermit Summary Data Yiew I Search I Glossary I
Narne | ACNT | jan] | Biled Amount | Paid amourt | From Date | ToDate | A
Doe, Sally 1111111 123456789012345 -910.50 -402.53 2/10/2004 2j10/2004 :
Doe, Sally 1111111 123456789012345 38.20 12.50 2(11/2005 2j11/2005 .
Oright, Sarmuel 111111 123456789012345 40.00 0,00 12fz2{2003 12{22{2003 :
Doe, Sally 111111 123456789012345 148.30 az.42 3f9/2005 3f9/2005 :
D Right, Samuel 1111111 123456759012345 237.60 159.36 3{28{2005 3/28/2005 b
Doe, Sally 1111111 123456789012345 406,20 32.67 2{10{2005 2{10/2005 :
Doe, Sally 1111111 123456789012345 310,50 587.28 2{10{2004 2/10/2004 :
4| | ®
Print EA Check al O undheck &l 1@ Data
12{5{2011

3. Select Denied Service Lines.
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Medicare Remit Easy Print Working with Reports

The Print and Export options appear.

B Medicare Remit EasyPrint v3.2 =]
File Tab Wiew Report Search Tools Help

( Search | Prink List
q |

.’Import | P Report Iv

B Archive 7 Restore X pelete

Payer Mame Adjusted Service Lines LT | checkDate | CheckierT ... | checkierT ... | Claims | Check/EFT Number | version | Filens
AREA INSURaR D08 f Mon-COE Claims ¥ fse7s 04/23(05 481.71 EFT 7 12345 005010422141 AREA

Deductible / COINS Service Lines  #

3

MSP | Mon-MSP Claims 3

Other Adjustments 3

Entire Remittance
/ | i
Claim Detail I / Remik Summary Data Yiew | Search | Glossary |
Name | AGNT | IcH | Biled Amount | Paid Amount | FromDate | ToDate | &
Ooce, sally 1171111 123456789012345 -910.50 -402.53 2/10/2004 2/10/2004 :
Ooce, sally 11111 123456789012345 38.20 12.50 2(11/2005 2j11/2005 .
Oright, saruel 11111 123456789012345 40.00 0,00 12i222003 12/22/2003 .
Ooce, sally 11111 123456789012345 148,80 92,42 3i9/2005 3/9/2005 .
D Right, Samuel 1111111 123456789012345 237.60 159,36 32812005 3f28/2005 b
Ooce, sally 1111111 123456789012345 406.20 32,67 2{10/2005 2j10{2005 .
Ooce, sally 1111111 123456789012345 910,50 55728 2/10/2004 2/10/2004 .
4 | O
Print [ check " [Juncheck Al |1 Dat
tir | EA checl 7‘ | [J Unichexl | !:P\ ata

/ 12/8/2011

/
4. Select Export.
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Medicare Remit Easy Print

Hint:

When you export,
the default folder
is the ReportExport
folder in the
Medicare Remit
Easy Print
directory.

You can select
another location
using the Save in
drop-down list.
menu.

The Export folder window opens.

Choose folder for export

' RepartE xpart

rl ~®EerE-

Working with Reports

21X

File name:

Save as type:

=~

j i Save I

Canicel |

g

5. Enter the file’name.
6. Click the Save button.
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Medicare Remit Easy Print Working with Reports

How to Print the Adjusted Service Lines Report
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon

&

The Medicare Remit Easy Print Claim List tab opens.

OMedicare Remit EasyPrint ¥3.2 -10] x|
File Tab Wiew Report Search Tools Help

. ’ Impart: . A Archive

Payer Name
AREA IMSURAMNCE

( Search | Prink List
Q |

P Report - 3 Restore x Delete

Filens

K | |
Claim List Clairn Detajl I Remit Summary Data Yiew I Search I Glossary I

Marne [\ ACHT | Jan] | Biled Amount | paid amourt | From Date | ToDate | A
e, Sally 1111111 123456759012345 -910.50 -402,53 2{10/2004 2/10/2004 :
oae, Sally 1111111 12345675901 2345 910.50 587.28 2{10/2004 2j10/2004 :
Ooae, sally 1111111 123456759012345 38.20 12.50 2{11/2005 2/11/2005 :
Cright, samuel 1111111 123456759012345 237.60 159,36 3fz8/2005 3/28/2005 :
Ooae, sally 1111111 123456759012345 406.20 3267 z{10/2005 2/10/2005 :
Ooae, sally 1111111 123456759012345 148.80 92,42 3f9(2005 3(9(2005 :
Oright, samuel 111111 123456759012345 40,00 0,00 12f22j2003 12(22{2003 :
4 | B
L Print 4 Check all [ uncheck &l D Data \

Segment count = =206 \ 12f6f2011

\
2. Click the down arrow on the Report button.
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Medicare Remit Easy Print Working with Reports

The Report List appears.

Medicare Remit EasyPrint ¥3.2

L]

File Tab ‘iew Report Search Tools Help

~=lolx|

. f Impart

| P Report Iv

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List
f

Paryer Name D Filenz
COB | M OF Claims 3 0
Deductibld / COIMS Service Lines  » ]
Denied Setvice Lines 3
ISP | Mon-WSP Claims 3
COther Adjudtments 3
Entire Remit)‘ance
K | 2l
Claim List | \Claim Deekail I Rermit Summary Data Yiew I Search I Glossary I
Name \ | ACHT | IcH | Biled Amount | Paid Amourt | From Date ToDate | &
Ooce, salky 1111111 123456789012345 -910.50 -402.53 2(10{2004 2/10/2004 .
Ooce, saly 1111111 123456789012345 910,50 587,28 2(10/2004 2/10/2004 .
Oooe, sally 1111111 123456739012345 38.20 12,50 2{11{2005 2112005 .
D Right, Samuel 1111111 123456759012345 237.60 159.36 3{28{2005 3/28/2005 b
Oooe, sally 1111111 123456739012345 406.20 32,67 2{10/2005 2{10/2005 .
Oooe, sally 1111111 123456739012345 148.80 92,42 39(2005 3(9(2005 .
right, Samuel 1111111 123456739012345 40,00 0,00 12/22i2003 12222003 .
l | ©
Print EA Check al O Un*eck Al @ pata
Segment count = =206 \ 12/712011

\
3. Select Adjusted Service Lines.
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Medicare Remit Easy Print

The Print and Export options appear.

Working with Reports

.Medicare Remit EasyPrint ¥3.2 10l x|
File Tab Wiew Report Search Tools Help
'Import P Repart Iv M Archive . Restare X Delete | q Search | EPrint List
Payer Mame Adjusted Service Lines D i‘ueck Date | Check/EFT ... | checkferT ... | Claims | CheckiEFT Number | version | Fileriz
AREA TNSURAR  ©OB f Mon-COB Claims 4 B 423(05 451,71 7 12345 00S010X22181  AREA
Deductible | COINS Service Lines ¥
Denied Service Lines 3
MSP | Mon-MSP Claims 3
Cther Adjustrments 3
Erntire Remittance
| | i
Claim Detail I / Remit Summary Data Yiew Search I Glassary I
Narne | | Yans | jan] Billed Amount | Paid amourt | From Date | ToDate | A
Ooce, sally 111111 123456789012345 -910.,50 -402.53 2/10{2004 2}10/2004 v
Ooce, saly 11111 123456789012345 38,20 12.50 2/1142005 2j11j2005 .
right, samuel 1111111 123456759012345 40,00 0,00 124222003 12{22(2003 :
Ooae, sally 1111111 123456759012345 148,80 92,42 3492005 3492005 :
D Right, Samuel 1111111 123456759012345 237.60 159.36 3{28{2005 3/28/2005 b
Ooce, saly 1111111 123456789012345 406,20 32.67 2{10{2005 2{10/2005 :
Ooce, saly 1111111 123456789012345 310,50 587.28 2{10{2004 2/10/2004 :
| | ®H
L Print A check all / CJuncheck &l 1@ Data
/ 12{8(2011

[
4. Select Print. The Print remit listing window appears.

5. From the Print remit listing window, print the detail listing in one of the following ways:

C. Click Print to print the detail without previewing it.

Print remit lizting

Prewiew

Cancel
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Medicare Remit Easy Print Working with Reports

The Print dialog opens, for example:
Pint 21

— Frinter
Properties... |

Mame: ‘\papurush TCG

Status: Ready
Type: HP Lazerlet 4200 PS
“Where:  TC-E-020

Comment; [ Prirk to file
— Frint range Copie:
Lol | Murnber of copies: |1 3:

" Pages [rom:l _to:l 7 ol

v LCaollate
_ = Selection ﬂ ﬂ
1 Cancel |

If you need to chan
Click OK.

€ properties, click Properties and make changes as necessary.
icare Remit Easy Print prints the detail at your default printer.

D. Click Previjew to view a preview of the printed page before printing.

The Print Preview window opens.

il
50 - D@@BBB oo | ror |

Click printer button % at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.
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How to Export the Adjusted Service Lines Report
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon

&

The Medicare Remit Easy Print Claim List tab opens.

OMedicare Remit EasyPrint ¥3.2 -10] x|
File Tab Wiew Report Search Tools Help
. I t | R b - . Archi ITJRt . Delet ( Si h Prink Lisk
’ mpor | P Epar . B, srchive | R Restore | ¥ pelete q eartl | rint Lis
Payer Name Payee Mame Filens
AREA INSURANCE | ACME PHYSICLANS INC.
Kl | i
Claim List Clairn Detail \ I Remit Summary Data Yiew I Search I Glossary I
Marne | \  acuT | Jan] | Biled Amount | paid amourt | From Date | ToDate | A
Ooce, salky 1111111 123456789012345 -910.50 -402.53 2/10/2004 2/10/2004 :
Ooce, salky 1111111 123456789012345 310,50 587,28 2(10/2004 2}10/2004 .
Ooce, saly 11111 123456789012345 38,20 12.50 2/11{2005 2{11)2005 v
Oright, samuel 1N1111 123456789012345 237,60 159,36 3j28{2005 3j28/2005 v
Ooce, saly 111\111 123456789012345 406,20 32,67 2/10{2005 2{10/2005 v
Ooce, saly 1111\1 123456789012345 148,50 92,42 3i9(2005 3j9(2005 v
Oright, samuel 1111 123456789012345 40,00 0.00 12{22i2003 12{22{2003 v
dl | ©i
Pint 4 Check all [ uncheck &l D Data \
Segment count = =206 \ 12f6f2011

\
2. Click the down arrow on the Report button.
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Medicare Remit Easy Print

Working with Reports

The Report List appears.
B8 Medicare Remit EasyPrint v3.2 10l x|
File Tab ‘iew Report Search Tools Help
'Import P Repart Iv M Archive . Restare X Delete | q Search | EPrint List
f
Payer Mame Adjust: D Filenz
» -
.
»
MSP | Mon-MSP Claims 3
COther Adjustments 3
Erntire Remittance \
K | i
Claim List Clairn E}\atail I Rermit Summary Data Yiew I Search I Glossary I
Narne \ ACNT | jan] | Biled Amount | Paid amourt | From Date | ToDate | A
Ooce, sally 1111111 123456789012345 -910.,50 -402.53 2/10{2004 2}10/2004 v
Ooce, saly 1111111 123456789012345 910,50 557,28 2/10{2004 2}10/2004 .
Ooae, sally 1111111 123456759012345 38.20 12.50 2{11{2005 2/11{2005 :
D Right, Samuel 1111111 123456759012345 237.60 159.36 3{28{2005 3/28/2005 b
Ooae, sally 1111111 123456759012345 406,20 32,67 2{10{2005 2/10{2005 :
Ooae, sally 1111111 123456759012345 148,80 92,42 3i9/2005 3492005 :
COright, samuel 1111111 123456759012345 40,00 0,00 124222003 12{22/2003 :
| | ®H
L Print _ EA Check al _ [ UnCheck all ‘D\ Daka
Segment count = =206 \ 12/712011

\
3. Select Adjusted Service Lines.
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Medicare Remit Easy Print

The Print and Export options appear.

Working with Reports

B8 Medicare Remit EasyPrint v3.2 10l x|
File Tab Wiew Report Search Tools Help
flmport P Repart Iv B, Archive . Restare X Delete | q Search | EPrint List
[ N . I
Payer Mame 8 d  Frint eck Date | CheckfEFT ... | CheckiEFT ... | laims | CheckiEFT Mumber | version | Fileriz
AREA TNSURAR  ©OB f Mon-COB Claims 4 423(05 481.71 EFT 7 12345 00S010X22181  AREA
Deductible | COINS Service Lines ¥
Denied Service Lines 3
MSP | Mon-MSP Claims 3
COther Adjustments 3
Erntire Remittance
| | i
Claim List Clairn Detail I / Rermit Summary Data Yiew I Search I Glossary I
Narne | adnT | jan] | Biled Amount | Paid amourt | From Date | ToDate | A
Ooce, sally 1h1111 123456789012345 -910.50 -402.53 2/10/2004 2j10/2004 :
Ooce, saly 111111 123456789012345 38.20 12.50 2(11/2005 2j11/2005 .
Oright, Sarmuel 11111 123456789012345 40.00 0,00 12fz2{2003 12{22{2003 :
Ooce, saly 111111 123456789012345 148.30 az.42 3f9/2005 3f9/2005 :
D Right, Samuel 1111111 123456759012345 237.60 159.36 3{28{2005 3/28/2005 b
Ooce, saly 1111111 123456789012345 406,20 32.67 2{10{2005 2{10/2005 :
Ooce, saly 1111111 123456789012345 310,50 587.28 2{10{2004 2/10/2004 :
| | &
L Print A check all / CJuncheck &l 1@ Data
/ 12{5{2011

/
4. Select Export.
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Medicare Remit Easy Print

Hint:

When you
export, the
default folder
is the
ReportExport
folder in the
Medicare Remit
Easy Print
directory. You
can select
another
location using
the Save in
drop-down list.

The Export folder window opens.

Choose folder for export cd |
Save in: I 3 ReportE sport j = £ B
File: mame: II’ j Save
Save as type: /f /I Cancel |
%

5. Enter the file na
6. Click the Save button.
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Medicare Remit Easy Print Working with Reports

How to Print the Deductible Service Lines Report
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

&)

The Medicare Remit Easy Print Claim List tab opens.

OMedicare Remit EasyPrint ¥3.2 -10] x|
File Tab Wiew Report Search Tools Help

.’Import | | P Report - .AArchive

Payer Name

3 Restore x Delete q Search | Print Lisk

AREA INSURANCE | ACME PHYSICTANS INC,
K | |
Claim List Claim Deté\ I Remit Summarty Data Yigw | Search | Glossary |
Marne [\ ACHT | Jan] | Biled Amaunt | paid amourt | From Date | ToDate | A
Ooae, sally 1111111 1234567609012345 -910,50 402,53 2{10/2004 2}10/2004 :
Oooe, sally 1111111 123456769012345 910,50 587.28 2/10/2004 2}10/2004 :
Oooe, sally 1111111 123456769012345 38,20 12,50 2{11}2005 2j11/2005 :
Oright, samuel 1111111 123456769012345 237,60 159,36 3(28/2005 3j28/2005 :
Oooe, sally 1111111 123456769012345 406,20 32,67 2{10/2005 2}10/2005 :
Oooe, sally 111111 123456769012345 148,80 92,42 34972005 3/9/2005 :
O right, samuel 11111 123456769012345 40,00 0,00 124222003 12)22(2003 :
4| | H©
Print EA Check all CJuncheck Al i@ Data \
Segment count = =206 \ 12f6f2011

\
2. Click the down arrow on the Report button.
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Medicare Remit Easy Print

The Report List appears.

s ,Medicare Remit EasyPrint ¥3.2

File Tab ‘iew Report Search Tools Help

Working with Reports

~=lolx|

.'Import | P Report Iv

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List

Paryer Marme Adjusted Service Lines Check Date Check/EFT ... Check/EFT Murmber Filenz
COB  Nor-COB Claims i e [T
Deductible Deductible Lines 3
Denied Service Lines Coinsurance Lines »
MSP | Mon-MSP Claims Deductible & Coinsurance Lines  »
COther Adjustments
Erntire Remittance \
K | 2l
Claim List Clairn Detail \ I Rermit Summary Data Yiew I Search I Glossary I
Narne | | acur | jan] | Biled Amount | Paid Amourt | From Date ToDate | A
Ooae, saly 1111111 12345675901 2345 910,50 402,53 2}10{2004 21042004 .
Ooae, saly 1111111 12345675901 2345 910,50 557,25 2/10{2004 21042004 .
Oooae, saly 1111111 12345675901 2345 38,20 12,50 2{11{2005 2}11j2005 .
D Right, Samuel 1111111 123456759012345 237.60 159.36 3{28{2005 3/28/2005 b
Oooae, saly 1111111 12345675901 2345 406,20 32,67 2/10f2005 2}10/2005 .
Ooae, sally 1111111 123456759012345 148,80 92,42 3i9/2005 3492005 :
COright, samuel 1111111 123456759012345 40,00 0,00 124222003 12{22/2003 :
| | ®H
Print A check all Ol uncheck &l 1@ Data
Segment count = =206 \ 12/712011

3. Select Deductible/C\OINS Service Lines.
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Medicare Remit Easy Print

The Deductive/COINS Service Lines report options appear.

L]

File Tab ‘iew Report

Medicare Remit EasyPrint ¥3.2

Search Tools Help

Working with Reports

~=lolx|

. f Impart

| P Report Iv

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List
f

FEEmar MEmE Adjusted Service Lines 3 Filene
COB [ Mon-COE Claims 3
3
Denied Service Lines 3 Caoins ce Lines 3 Expork
MSP | Mon-MSP Claims 3 Deductiple & Coinsurance Lines  »
Cther Adjustrments 3 /
Erntire Remittance
K | 2l
Claim List Clairn Detail I R%it Summary Data Yiew I Search Glossary I
ame | | I | Billed Amount | Paid Amount | From Date To Date | A
Ooae, saly 12345675901 2345 910,50 402,53 2}10{2004 21042004 .
Ooae, saly 12345675901 2345 910,50 557,25 2/10{2004 21042004 .
Oooae, saly 12345675901 2345 38,20 12,50 2{11{2005 2}11j2005 .
Oright, samuel 12345675901 2345 237,60 159,36 3j28(2005 3}28/2005 .
Oooae, saly 12345675901 2345 406,20 32,67 2/10f2005 2}10/2005 .
Oooe, saly 12345675901 2345 148,80 92,42 3i9(2005 3/9(2005 .
Cright, samuel 12345675901 2345 40,00 0,00 12{22j2003 12{22}2003 .
| | ®H
Print A check all qUncheck Al @ pata
/ 12{7/2011

Segment count > =206

!
4, Select Deductible Lines:
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Medicare Remit Easy Print Working with Reports

Lo

Medicare Remit EasyPrint ¥3.2 =[]

File Tab Wiew Report Search Tools Help

_'Import | P Repart Iv | B, archive [ Restore | X Delete | q Search | EF'r*lnt List
— . . . I
Payer Name Adjusted Service Lines 'l | checkDate | CheckEFT ... | Check/erT ... | Claims | Check/EFT Number | version | Filens
AREA INSURap OB [ Mar-COE Claims > fes7a n4(73175 471 71FFT 7 12345 00S010%221A1  AREA
Deductible { COIMNS Service Li 3 Deductible Lines
Denied Service Lines L4 Coinsurance Lines L4 ork
MSP | Mon-M3SP Claims 4 Deductible & Coinsurance Lings  »
Other Adjustments 3 /
Entire Remittance
4 | |
Claim Detail I Remit Summary I / Data View I Search I Glossary I
Name | ACHT | 17 | Billed Amount | Paid smount [ FromDate | ToDate | A
Ooce, sally 111111 12345§759012345 -910,50 -402.53 2/10{2004 2}10/2004 .
Ooce, saly 111111 12348675901 2345 38,20 12.50 2/11f2005 2}11j2005 .
Cright, Samuel 111111 12345675901 2345 40,00 0.00 1242242003 12{22}2003 .
Ooce, saly 111111 17345675901 2345 145,80 92,42 349(2005 3/9(2005 .
Cright, samuel 111111 23456789012345 237,60 159,36 3}28{2005 3}28/2005 v
Oooce, saly 111111 12345675901 2345 408,20 32,67 2/10{2005 21102005 v
Ooce, saly 111111 123456758901 2345 910,50 557,28 2/10{2004 2}10/2004 v

|

| ©

- Prink | EA Check al | |7/Llncheck Al -!:D\ Data

/ 12j8/2011

/ . A .
5. Select Print. The Print remit listing window appears.

6. Print the detail listing in one of the following ways:

A. Click Print to print the detail without previewing it.

Print remit listing

Frewview LCancel
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Medicare Remit Easy Print Working with Reports

The Print dialog opens.
Pint 21

— Frinter
Properties... |

Mame: ‘\papurush TCG

Status: Ready
Type: HP Lazerlet 4200 PS
“Where:  TC-E-020

Comment; [ Prirk to file
— Frint range Copie:
Lol | Murnber of copies: |1 3:

" Pages [rom:l _to:l 7 ol
v LCaollate
_ = Selection ﬂ ﬂ

If you need to chan e properties, click Properties and make changes as necessary.

edicare Remit Easy Print prints the detail at your default printer.
E. Click Preview to view a preview of the printed page before printing.

H B X

The Print Preview window opens.

ﬂgPrint preview ;Iglil |
2 O - D@EE B | oo :

Click printer button = at the top of the window.
Medicare Remit Easy Print prints the detail at your default printer.
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How to Export the Deductible Service Lines Report
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon

&

The Medicare Remit Easy Print Claim List tab opens.

OMedicare Remit EasyPrint ¥3.2 -10] x|
File Tab Wiew Report Search Tools Help

. ’ Impart: . A Archive

Payer Name
AREA IMSURAMNCE

3 Restore x Delete q Search | Print Lisk

| P Repark -

Filens

K | |
Claim List Claim Detéq I Remit Summary Data Yiew I Search I Glossary I

Marne |\ ACHT | Jan] | Biled Amount | paid amourt | From Date | ToDate | A
e, Sally 1111111 123456759012345 -910.50 -402,53 2{10/2004 2/10/2004 :
oae, Sally 1111111 12345675901 2345 910.50 587.28 2{10/2004 2j10/2004 :
Ooae, sally 1111111 123456759012345 38.20 12.50 2{11/2005 2/11/2005 :
Cright, samuel 1111111 123456759012345 237.60 159,36 3fz8/2005 3/28/2005 :
Ooae, sally 1111111 123456759012345 406.20 3267 z{10/2005 2/10/2005 :
Ooae, sally 123456759012345 148.80 92,42 3f9(2005 3(9(2005 :
Oright, samuel 123456759012345 40,00 0,00 12f22j2003 12(22{2003 :
4 | B
L Print 4 Check all [ uncheck &l D Data \

Segment count = =206 \ 12f6f2011

\
2. Click the down arrow on the Report button.
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The Report List appears.

Medicare Remit EasyPrint ¥3.2 10l x|

L]

File Tab ‘iew Report Search Tools Help

. f Impart

Payer Name

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List

| P Report Iv

Adjusted Service Lines Check Date Check/EFT ... Check/EFT Mumber

COB | Mon-COB Claims [ paroaine | [err [ 7 Tt

Deductible : Lines Deductible Lines L4

Filenz

Denied Service Lines Coinsurance Lines »
ISP | Mon-MSPRY Taims Deductible & Coinsurance Lines  »
COther Adjustmerks
Entire Remittance\
K | 2l
Claim List | Clair\ Deekail I Rermit Summary Data Yiew I Search I Glossary I
Narne \ | ACNT | jan] | Biled Amount | Paid amourt | From Date | ToDate | A
Ooae, saly 1111111 12345675901 2345 910,50 402,53 2}10{2004 21042004 .
Ooae, saly 1111111 12345675901 2345 910,50 557,25 2/10{2004 21042004 .
Oooae, saly 1111111 12345675901 2345 38,20 12,50 2{11{2005 2}11j2005 .
D Right, Samuel 1111111 123456759012345 237.60 159.36 3{28{2005 3/28/2005 b
Oooae, saly 1111111 12345675901 2345 406,20 32,67 2/10f2005 2}10/2005 .
Ooae, sally 1111111 123456759012345 148,80 92,42 3i9/2005 3492005 :
COright, samuel 1111111 123456759012345 40,00 0,00 124222003 12{22/2003 :
| | ®H
L Print A check all O UnCheck\AII I pata
Segment count = =206 \ 12/712011

3. Select Deductible/COINS Service Lines.
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Medicare Remit Easy Print

L]

File Tab ‘iew Report Search Tools Help

The Deductible/COIN Service Lines report options appear.

Medicare Remit EasyPrint ¥3.2

Working with Reports

~=lolx|

. f Impart

Payer Name

| P Report Iv

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List
f

Adjusted Service Lines
COB [ Mon-COE Claims

Filenz

Denied Service Lines Expork
MSP | Mon-MSP Claims
COther Adjustments
Erntire Remittance
K | 2l
Claim List Clairn Detail I Ren/t Summary Data Yiew I Search Glossary I
Narne | acnt | | jan] | Biled Amount | Paid Amourt | From Date ToDate | A
Ooce, salky 1111111 123456789012345 -910.50 -402.53 2(10{2004 2/10/2004 .
Ooce, saly 1111111 123456789012345 910,50 587,28 2(10/2004 2/10/2004 .
Oooe, sally 1111111 123456739012345 38.20 12,50 2{11{2005 2112005 .
D Right, Samuel 1111111 123456759012345 237.60 159.36 3{28{2005 3/28/2005 b
Oooe, sally 123456739012345 406.20 32,67 2{10/2005 2{10/2005 .
Coce, sally 12345678901 2345 148.30 52,42 392005 392005 .
CIrigtt, Samuel 12345678901 2345 40,00 000 12/2242003 \2{z2}2003 .
4| | ®
L Print A check all Cuncheck &l 1D Data
Segment count = =206 I 12/712011

4, Select Deductible Lines.
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Medicare Remit Easy Print Working with Reports

cMedicare Remit EasyPrint ¥3.2 =[]
File Tab Wiew Report Search Tools Help

' Import | P Repart I A B, archive [ Restore | X Delete | q Search | - Print List
— . . . I
Payer Name Adjusted Service Lines 'l | checkDate | CheckEFT ... | Check/erT ... | Claims | Check/EFT Number | version | Filens
AREA INSURap OB [ Mar-COE Claims > fes7a n4(73175 481 71 FFT 7 12345 00S010%221A1  AREA
Deductible i 3 Deductible Lines
Denied Service Lines L4 Coinsurance Lines
MSP | Mon-M3SP Claims 4 Deductible & Coinsurance Lings  »
Other Adjustments 3
Entire Remittance
4 | |
Claim Detail I Remit Surnmary I A)ata Wigw I Search I Glossary I
Marne | ACHT | 1y | Biled Amount | Paid amourt | From Date | ToDate | &
[FlDae, Sally 1111111 12345670012345 -910,50 -402.53 2/10/2004 2/10/2004 :
Doe, Sally 1111111 123456//59012345 36,20 12.50 2{11}2005 2j11)2005 i
Oright, Samuel 1111111 1234%6759012345 40.00 0,00 124222003 12}22/2003 :
Dae, Sally 1111111 123A56759012345 148,50 97,42 3i9/2005 3482005 :
COright, samuel 1111111 17545675001 2345 237,60 159,36 3(28/2005 3/28/2005 .
Dae, Sally 1111111 3456759012345 406,20 32,67 2/10/2005 2}10{2005 .
Doe, Sally 1111111 123456780012345 910,50 58728 2/10/2004 2/10/2004 .
4 | B
Prink EA Check al (1 nCheck all -!:.]’\ Data
/ 12j8/2011

/

5. Select Export.
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Hint:

When you
export, the
default folder
is the
ReportExport
folder in the
Medicare Remit
Easy Print
directory. You
can select
another
location using
the Save in
drop-down list.

The Export folder window opens.

Choose folder for export cd |
Save in: I 3 ReportE sport j = EF -
File: name: || j
B D

Save as lype: /f

Cancel |

i

6. Enter the file name,
7. Click the Save button.
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How to Print the Coinsurance Service Lines Report
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

&)

The Medicare Remit Easy Print Claim List tab opens.

OMedicare Remit EasyPrint ¥3.2 -10] x|
File Tab Wiew Report Search Tools Help

.’Import | | P Report - .AArchive

3 Restore x Delete q Search | Print Lisk

Payer Name
BREA INSURANCE 45 INC, 5 0 4517 2345 :

K | |
Claim List Claim Det;( I Remit Summarty Data Yigw | Search | Glossary |
Marne |\ ACHT | Jan] | Biled Amaunt | paid amourt | From Date | ToDate | A
Oooe, salty 1111111 123456789012345 -510.50 -402.53 2{10/z004 2/10/z004 :
Ooce, saly 1111111 123456789012345 910,50 587,28 2{10/2004 2/10/2004 :
Ooce, saly 1111111 123456789012345 38,20 12.50 2{11/2005 2/11/2005 :
Oright, Samuel 1111111 123456789012345 237.60 159.36 3(28/2005 3/28/2005 :
Ooce, saly 123456789012345 406,20 32,67 2{10/2005 2/10/2005 :
Ooce, saly 123456789012345 148.80 92,42 3f9/2005 3/9/2005 :
right, Samuel 123456789012345 40.00 0.00 12§22}2003 12}22}2003 :
1 | ©H
Print EA Check all CJuncheck Al i@ Data \
Segment count = =206 \ 12f6f2011

\
F. Click the down arrow on the Report button.

© 2005 General Dynamics IT Company. All Rights Reserved.
This document contains GDIT confidential and proprietary information,
which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs.

135



Medicare Remit Easy Print Working with Reports

The Report List appears.

Medicare Remit EasyPrint ¥3.2 10l x|

L]

File Tab ‘iew Report Search Tools Help

. f Impart

Payer Name

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List

| P Report Iv

Adjusted Service Lines Check Date Check/EFT ... Check/EFT Mumber

COB | Mon-COB Claims [ paroaine | [err [ 7 Tt

Deductible : Lines Deductible Lines L4

Filenz

Denied Service Lines Coinsurance Lines »
MSP | Mon-MSP Claims Deductible & Coinsurance Lines  »
COther Adjustments
Erntire Remittance \
K | 2l
Claim List Clairn Detail\ I Rermit Summary Data Yiew I Search I Glossary I
Narne | | ACNT | jan] | Biled Amount | Paid amourt | From Date | ToDate | A
Ooae, saly 1111111 12345675901 2345 910,50 402,53 2}10{2004 21042004 .
Ooae, saly 1111111 12345675901 2345 910,50 557,25 2/10{2004 21042004 .
Oooae, saly 1111111 12345675901 2345 38,20 12,50 2{11{2005 2}11j2005 .
D Right, Samuel 1111111 123456759012345 237.60 159.36 3{28{2005 3/28/2005 b
Oooae, saly 1111111 12345675901 2345 406,20 32,67 2/10f2005 2}10/2005 .
Ooae, sally 1111111 123456759012345 148,80 92,42 3i9/2005 3492005 :
COright, samuel 1111111 123456759012345 40,00 0,00 124222003 12{22/2003 :
| | ®H
L Print A check all O Unchec\ Al @ pata
Segment count = =206 \ 12/712011

2. Select Deductible/‘COINS Service Lines.
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The Deductible/COINS Service Lines report options appear.

L]

File Tab ‘iew Report Search Tools Help

Medicare Remit EasyPrint ¥3.2

Working with Reports

~=lolx|

. f Impart

| P Report Iv

Payer Name

Deductible

COther Adjustments

Denied Service Lines
MSP | Mon-MSP Claims

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List
f

Adjusted Service Lines
COB [ Mon-COE Claims

Print
Expork

Filenz

Entire Remittance
K | 2l
Claim List Clairn Detail I RJmit Summary Data Yiew I Search Glossary I

Narne | acuT | | jan] | Biled Amount | Paid Amourt | From Date ToDate | A
Ooce, salky 1111111 123456789012345 -910.50 -402.53 2(10{2004 2/10/2004 .
Ooce, saly 1111111 123456789012345 910,50 587,28 2(10/2004 2/10/2004 .
Oooe, sally 1111111 123456739012345 38.20 12,50 2{11{2005 2112005 .
DRight, Samuel 1111111 123456789012345 237.60 159,36 3{28{2005 3/28/2005 b
Oooe, sally 1111111 123456739012345 406.20 32,67 2{10/2005 2{10/2005 .
Coce, sally 1111111 12345678901 2345 148.30 52,42 392005 392005 .
CIrigtt, Samuel 111111 12345678901 2345 40,00 000 12/2242003 \2{z2}2003 .
4 | >
L Print A check all [ Uncheck Al 1D Data

Segment count = =206 ' 12/712011

3. Select Coi

nsurance Lines.
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OMedicare Remit EasyPrint ¥3.2 =[]
File Tab Wiew Report Search Tools Help

_'Import | P Repart Iv | B, archive [ Restore | X Delete | q Search | EF'r*lnt List
. . . . [
Payer Name Adjusted Service Lines "D | checkDate | CheckierT ... | checkierT ... | Claims | CheckiEFT Mumber | version | Filens
AREA INSURAR _ (COB { Non-COB Claims i T n4i?3ins 481,71 EFT 7 12345 00SO10XZ2181  AREA
Deductible ice Li 4 Deductible Lines L4
Denied Service Lines 4
MSP | Mon-M3SP Claims 4 rt
Other Adjustments 4 /
Entire Remittance
1] | |
Claim List Claim Detail I Remit Summary I /éata Wiew I Search I Glassary I
Name | ACHT | 1cy/ | Billed Amount | Paid smount [ FromDate | ToDate | A
Ooce, saly 1111111 123456770012345 -910.50 -402.53 2110/2004 2/10/2004 :
Ooce, saly 1111111 123456439012345 38.20 12.50 21112005 2/11/2005 :
Oright, Sarmuel 1111111 123456739012345 40,00 0,00 12/22f2003 12/22/2003 :
Ooce, saly 1111111 123A56739012345 148.30 97,42 309/2005 3j9/2005 :
Oright, sarmuel 1111111 174456739012345 237.60 159.36 3(28/2005 3/28/2005 :
Ooce, saly 1111111 53456739012345 406.20 32.67 2{10/2005 2/10/2005 :
Ooce, saly 1111111 123456789012345 a10.50 587,28 2(10/2004 2/10/2004 :

|
- Prink | EA Check al | ?/Llncheck Al -!:D\ Data

| ©

/ 12j8/2011

4. Select Prét. The Print remit listing window appears.
5. Print the detail listing in one of the following ways:

G. From the Print remit listing window, click Print to print the detail without previewing
it.

Print remit listing

| Erint K Prewview LCancel
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The Print dialog opens.

2]

— Frinter

Mame: ‘\papurush TCG

Status: Ready
Type: HP Lazerlet 4200 PS
“Where:  TC-E-020

Comment:

Properties... |

[~ Print to file

— Frint range

= Al

= Selection

" Pages [rom:l_ _to:l_

Copie:

Number of copies: I'I 3:

ﬂ ﬂ I~ Caollate

»
v

oK

Cancel |

Working with Reports

If you nWoperties, click Properties and make changes as necessary.
Click OK. Medicare Remit Easy Print prints the detail at your default printer.

H. From the Print remit listing window, click Preview to view a preview of the printed

page before printing.

Print remit listing

Erint

i I"d
Preview

LCancel
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The Print Preview window opens.
SPL-0EEBE 6

\
B. Click printer button = at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.
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How to Export the Coinsurance Service Lines Report
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon

&

The Medicare Remit Easy Print Claim List tab opens.

OMedicare Remit EasyPrint ¥3.2 -10] x|

File Tab Wiew Report Search Tools Help

. I t | R b - . Archi .-_:-'JRt . Delet ( Si h| Prink Lisk

’ mpor | P Epar . B, srchive | R Restore | ¥ pelete q eartl rint Lis

Payer Name Check Date CheckiEFT ... Check/EFT Number Yersion Filens
AREA INSURANCE | ACME PHYSICTANS INC, 5 451.7 0050 B

K | |
Claim List Clairn Detajl I Remit Summary Data Yiew I Search I Glossary I

Marne [\ ACHT | Jan] | Biled Amount | paid amourt | From Date | ToDate | A
e, Sally 1111111 123456759012345 -910.50 -402,53 2{10/2004 2/10/2004 :
oae, Sally 1111111 12345675901 2345 910.50 587.28 2{10/2004 2j10/2004 :
Ooae, sally 1111111 123456759012345 38.20 12.50 2{11/2005 2/11/2005 :
Cright, samuel 1111111 123456759012345 237.60 159,36 3fz8/2005 3/28/2005 :
Ooae, sally 1111111 123456759012345 406.20 3267 z{10/2005 2/10/2005 :
Ooae, sally 1111111 123456759012345 148.80 92,42 3f9(2005 3(9(2005 :
Oright, samuel 111111 123456759012345 40,00 0,00 12f22j2003 12(22{2003 :
4 | B
L Print 4 Check all [ uncheck &l D Data \

Segment count = =206 \ 12f6f2011

\
2. Click the down arrow on the Report button.
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The Report List appears.

Medicare Remit EasyPrint ¥3.2 10l x|

L]

File Tab ‘iew Report Search Tools Help

. f Impart

Payer Name

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List

| P Report Iv

Adjusted Service Lines Check Date Check/EFT ... Check/EFT Mumber

COB | Mon-COB Claims [ paroaine | [err [ 7 Tt

Deductible : Lines Deductible Lines L4

Filenz

Denied Service Line: Coinsurance Lines »

MSP | Mon-MSP Clainm: Deductible & Coinsurance Lines  »

Cther Adjustrments

Erntire Remittance \

K | 2l
Claim List Clairn De&ail I Rermit Summary Data Yiew I Search I Glossary I

Name I\ ACHT | IcH | Biled Amount | PaidAmount | FromDate | ToDate | &
Ooae, saly 1111111 12345675901 2345 910,50 402,53 2}10{2004 21042004 .
Ooae, saly 1111111 12345675901 2345 910,50 557,25 2/10{2004 21042004 .
Oooae, saly 1111111 12345675901 2345 38,20 12,50 2{11{2005 2}11j2005 .
D Right, Samuel 1111111 123456759012345 237.60 159.36 3{28{2005 3/28/2005 b
Oooae, saly 1111111 12345675901 2345 406,20 32,67 2/10f2005 2}10/2005 .
Ooae, sally 1111111 123456759012345 148,80 92,42 3i9/2005 3492005 :
COright, samuel 1111111 123456759012345 40,00 0,00 124222003 12{22/2003 :
| | ®H

L Print _ EA Check al _ DUnCheck\nll ID\ Data

Segment count = =206 \ 12/712011

3. Select Deductible/é:OINS Service Lines.
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The Deductible/COIN report options appear.

L]

File Tab ‘iew Report

Medicare Remit EasyPrint ¥3.2

Search Tools Help

Working with Reports

~=lolx|

. f Impart

Payer Name

| P Report Iv

Adjusted Service Lines
COB [ Mon-COE Claims

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List
f

Deductible

Denied Service Lines
MSP | Mon-MSP Claims
COther Adjustments

Print
Expork

Filenz

Entire Remittance
K | 2l
Claim List Clairn Detail I IRemit Summary Data Yiew I Search Glossary I

Narne | acnt| | jan] | Biled Amount | Paid Amourt | From Date ToDate | A
Oobae, salty 123456789012345 -510.,50 -402.53 2{10/2004 2/10/2004 :
Ooae, saly 123456789012345 910,50 587,28 2{10/2004 2/10/2004 :
Ooce, saly 123456789012345 38,20 12.50 2{11/2005 2/11/2005 :
right, Samuel 123456789012345 237.60 159.36 328/2005 3/28/2005 :
Ooce, saly 123456789012345 406,20 32,67 2{10{2005 2/10/2005 :
Ooce, saly 123456789012345 148,80 92,42 3f9/2005 3f9/2005 :
Oright, Samuel 123456789012345 40,00 000 1zizzfendd 12j22}2003 :
4| | ®

L Print A check all O Unched{.o.ll I pata
| 12{7/2011

Segment count > =206

4. Select Coinsurange Lines.

© 2005 General Dynamics IT Company. All Rights Reserved.
This document contains GDIT confidential and proprietary information,
which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs.

143




Medicare Remit Easy Print

Working with Reports

cMedicare Remit EasyPrint ¥3.2 =[]
File Tab ‘iew Report Search Tools Help
_'Import | P Repart Iv | B, archive [ Restore | X Delete | q Search | EF'r*lnt List
. . . . [
Payer Name Adjusted Service Lines 'l | checkDate | CheckEFT ... | Check/erT ... | Claims | Check/EFT Number | version | Filens
AREA INSURap OB [ Mar-COE Claims > ler7n na4(73fn5 4R1.71 EFT 7 12345 00S010%221A1  AREA
Deductible vice Li 3 Deductible Lines 3
Denied Service Lines 4
MSP | Mon-M3SP Claims 4 Deductible & Coinsurance Lings  »
Other Adjustments 4
Entire Remittance
1 / | i
Claim Detail I Remit Summary I /éata Wiew I Search I Glossary I
Name | ACHT | 1cry/ | Billed Amount | Paid smount [ FromDate | ToDate | A
Ooce, sally 1111111 123456750012345 -910,50 -402.53 2/10/2004 2/10/2004 :
Ooce, sally 1111111 123456759012345 38.20 12.50 2/11/2005 2j11{2005 .
Oright, Samuel 1111111 123456759012345 40.00 0,00 124222003 12}22/2003 :
Oooe, sally 1111111 123456759012345 148,50 97,42 3i9/2005 3482005 :
COright, samuel 1111111 12445675001 2345 237,60 159,36 3(28/2005 3/28/2005 .
Ooce, sally 1111111 3456750012345 406,20 32,67 2/10/2005 2}10{2005 .
Ooee, sally 1111111 123456780012345 910,50 58728 2/10/2004 2/10/2004 .
| | ©
Prink EA Check al [ UnCheck al -!:.]’\ Data
/ 12j8/2011

/
5. Select Export.
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The Export folder window opens.

Choose folder for export cd |
Save in: Ia RepaortE spart j = EF -

Hint:

When you export,
the default folder is
the ReportExport
folder in the
Medicare Remit Easy
Print directory.

You can select
another location
using the Save in
drop-down list.

File: name: lh j

Save ag y,lpe:/l

Cancel |

i

6. Enter the file name,
7. Click the Save button.
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How to Print the Deductible/Coinsurance Service Lines Report
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

&)

The Medicare Remit Easy Print Claim List tab opens.

OMedicare Remit EasyPrint ¥3.2 -10] x|
File Tab Wiew Report Search Tools Help

.’Import | P Repark -

( Search | Prink List
q |

A Archive 7 Restore x Delete

Payer Name

AREA INSURANCE | ACME PHYSICIANS INC,
K | |
Claim List Claim De}?il I Remit Summarty Data Yigw | Search | Glossary |
Marne [\ ACHT | Jan] | Biled Amaunt | paid amourt | From Date | ToDate | A
Ooae, sally 1111111 1234567609012345 -910,50 402,53 2{10/2004 2}10/2004 :
Oooe, sally 1111111 123456769012345 910,50 587.28 2/10/2004 2}10/2004 :
Oooe, sally 1111111 123456769012345 38,20 12,50 2{11}2005 2j11/2005 :
Oright, samuel 1111111 123456769012345 237,60 159,36 3(28/2005 3j28/2005 :
Oooe, sally 1111111 123456769012345 406,20 32,67 2{10/2005 2}10/2005 :
Oooe, sally 1111111 123456769012345 148,80 92,42 34972005 3/9/2005 :
O right, samuel 1111111 123456769012345 40,00 0,00 124222003 12)22(2003 :
1 | ©H
Print EA Check all CJuncheck Al i@ Data \
Segment count = =206 \ 12f6f2011

\
2. Click the down arrow on the Report button.
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The Report List appears.

Medicare Remit EasyPrint ¥3.2 10l x|

L]

File Tab ‘iew Report Search Tools Help

. f Impart

Payer Name

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List

| P Report Iv

Adjusted Service Lines Check Date Check/EFT ... Check/EFT Mumber

COB | Mon-COB Claims [ paroaine | [err [ 7 Tt

Deductible : Lines Deductible Lines L4

Filenz

Denied Service Lines Coinsurance Lines »
MSP | Mon-MSP Claims Deductible & Coinsurance Lines  »
COther Adjustments
Erntire Remittance \
K | 2l
Claim List Clairn Detail \ I Rermit Summary Data Yiew I Search I Glossary I
Narne || ACNT | jan] | Biled Amount | Paid amourt | From Date | ToDate | A
Ooae, saly 1111111 12345675901 2345 910,50 402,53 2}10{2004 21042004 .
Ooae, saly 1111111 12345675901 2345 910,50 557,25 2/10{2004 21042004 .
Oooae, saly 1111111 12345675901 2345 38,20 12,50 2{11{2005 2}11j2005 .
D Right, Samuel 1111111 123456759012345 237.60 159.36 3{28{2005 3/28/2005 b
Oooae, saly 1111111 12345675901 2345 406,20 32,67 2/10f2005 2}10/2005 .
Ooae, sally 1111111 123456759012345 148,80 92,42 3i9/2005 3492005 :
COright, samuel 1111111 123456759012345 40,00 0,00 124222003 12{22/2003 :
| | ®H
L Print EA Check al ] uncheck ill I pata
Segment count = =206 ‘ 12/712011

[
3. Select Deductible/COINS Service Lines.
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Working with Reports

The Deductible/COIN report options appear.
=10l x|

Medicare Remit EasyPrint ¥3.2

L]

File Tab ‘iew Report Search Tools Help

. f Impart

| P Report Iv

Adjusted Service Lines
COB [ Mon-COE Claims
Deductible : Lines Deductible Lines L4
Coinsurance Lines »

Denied Service Lines
MSP | Mon-MSP Claims [ Print
COther Adjustments Export

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List
f

Filenz

Payer Name

Entire Remittance
K | |
Claim List Clairn Detail I Remi‘ Summary I Data Yiew I Search I Glossary I
Narne | acr || jan] | Biled Amount | Paid amourt | From Date | ToDate | A
Ooce, salky 1111111 123456789012345 -910.50 -402.53 2(10{2004 2/10/2004 .
Ooce, saly 1111111 123456789012345 910,50 587,28 2(10/2004 2/10/2004 .
Oooe, sally 1111111 123456739012345 38.20 12,50 2{11{2005 2112005 .
DRight, Samuel 1111111 123456789012345 237.60 159,36 3{28{2005 3/28/2005 b
Oooe, sally 1111111 123456739012345 406.20 32,67 2{10/2005 2{10/2005 .
Oooe, sally 1111111 123456739012345 148.80 92,42 39(2005 3(9(2005 .
right, Samuel 1111111 123456739012345 40,00 0,00 12/22i2003 12222003 .
4| | ®
L Print A Check all ] Uncheck &l /ﬂ?\ Data
Segment count = =206 ’ 12/712011

|
4. Select Deductible & Coinsurance Lines:
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OMedicare Remit EasyPrint ¥3.2 =[]

File Tab Wiew Report Search Tools Help

. ' Irnpart

| P Report Iv

_Anrchl\-'e [, Restore _XDeIete | q Search | EF'r*lnt List
f

Paver Mame Adjusted Service Lines Y eID Check Date | CheckfEFT ... | Check/EFT ... Claims Check/EFT Mumber Yersion Filenz

0B/ Non-C0B Claims > i A R AT

Deductible i 4 Deductible Lines L4

Denied Service Lines L4 Coinsurance Lines

MSP | Mon-M3SP Claims 3

Other Adjustments 4

Entire Remittance

L | i |
Claim List Claim Detail I Remit Summary I /Data Wigw I Search I Glossary I

Name | ACHT | 1) | Billed Amount | Paid smount [ FromDate | ToDate | A
Ooce, saly 1111111 123456769012345 -910.50 -402.53 2110/2004 2/10/2004 :
Ooce, saly 1111111 123454739012345 310,50 587.28 2110/2004 2/10/2004 :
Ooce, saly 1111111 123466739012345 38.20 12.50 2{11/2005 2J11/2005 :
Oright, Sarmuel 1111111 127456739012345 237.60 159.36 3(28/2005 3/28/2005 :
Ooce, saly 1111111 3456789012345 406.20 32.67 2{10/2005 2/10/2005 :
Ooce, saly 1111111 123456739012345 148.30 az.42 3(9/2005 3j9/2005 :
Oright, saruel 1111111 123456789012345 40,00 0,00 12f222003 12j22/2003 :
4 | B

L Print B Checkal _ﬁUncheck Al _i!i.l?\ Data

Segment count = >206 / 12/712011
/
5. Select Print.
The Print remit listing window appears.

1. Print the detail listing in one of the following ways:

A. From the Print remit listing window, click Print to print the detail without previewing
it.

Print remit lizting

© 2005 General Dynamics IT Company. All Rights Reserved.
This document contains GDIT confidential and proprietary information,
which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs.

149
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Pent 2| x|
— Frititer
Properties. .. |

M armne: hpapurush T CG

Statuz: Ready
Type: HPF Lazerlet 4200 FS
“Where:  TC-E-020

Caommert; [~ Print ta file
— Print range Copie
= Al Murmber of copies: |'| 3:
[ Fages _from:l to:l
[V Callate
. {7 Selection
f Ok I Cancel |

The Print dialog opens.____——"

Click OK. Medicare Remit Easy Print prints the detail at your default printer.

I.  From the Print remit listing window, click Preyiew to view a preview of the printed
page before printing.

Print remit lizting

o x|
§D'|Eﬂmm| Clase Page =

Click printer button = at the top of the window.
Medicare Remit Easy Print prints the detail at your default printer.
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Medicare Remit Easy Print Working with Reports

How to Export the Deductible/Coinsurance Service Lines Report
2. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon

&

The Medicare Remit Easy Print Claim List tab opens.

OMedicare Remit EasyPrint ¥3.2 -10] x|
File Tab ‘iew Report | Search Tools Help

. I t | R t '. Archi .E'Rt . Delet ( Si h| Prink Lisk

’ T | P epor] A rehive | [ Restore | ¥ pelete q eart rink Lis

Paryer Name I Payee Namé\ | Payee ID | Check Date | Check/EFT ... | Check/EFT ... | Claims | Check/EFT Mumber | Wersion | Filenz
AREA INSURAMCE  ACME PHYSTONANS INC, 12345675 04/23/05 481.71 EFT 7 12345 00S010x22141 ARESA

| i
Claim De%l I Remik Summary Data Yiew I Search I Glossary I
Marne |\ ACHT | Jan] | Biled Amount | paid amourt | From Date | ToDate | A
e, Sally 1111111 123456759012345 -910.50 -402,53 2{10/2004 2/10/2004 :
oae, Sally 1111111 12345675901 2345 38.20 12.50 2{11{2005 2112005 :
Cright, samuel 1111111 123456759012345 40,00 0,00 12f22j2003 12(22/2003 :
Ooae, sally 1111111 123456759012345 148.80 92,42 3f9/2005 3(9/2005 :
Oright, samuel 1111111 123456759012345 237.60 159,36 3f28/2005 328/2005 :
Ooae, sally 1111111 123456759012345 406.20 3267 z{10/2005 2/10/2005 :
Ooae, sally 111111 123456759012345 910.50 587.28 2{10/2004 2/10/2004 :
| | 2l
L Print 4 Check all [ uncheck &l D Data \
\ 12/8/2011

3. Click the down arrow on the Resort button.
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The Report List appears.

Medicare Remit EasyPrint ¥3.2 10l x|

L]

File Tab ‘iew Report Search Tools Help

. f Impart

Payer Name

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List

| P Report Iv

Adjusted Service Lines Check Date Check/EFT ... Check/EFT Mumber

COB | Mon-COB Claims [ paroaine | [err [ 7 Tt

Deductible : Lines Deductible Lines L4

Filenz

Denied Service Line: Coinsurance Lines »

MSP | Mon-MSP Claim Deductible & Coinsurance Lines  »

Cther Adjustrments

Erntire Remittance \

K | 2l
Claim List Clairn De\ail I Rermit Summary Data Yiew I Search I Glossary I

Name I ACHT | IcH | Biled Amount | PaidAmount | FromDate | ToDate | &
Ooae, saly 1111111 12345675901 2345 910,50 402,53 2}10{2004 21042004 .
Ooae, saly 1111111 12345675901 2345 910,50 557,25 2/10{2004 21042004 .
Oooae, saly 1111111 12345675901 2345 38,20 12,50 2{11{2005 2}11j2005 .
D Right, Samuel 1111111 123456759012345 237.60 159.36 3{28{2005 3/28/2005 b
Oooae, saly 1111111 12345675901 2345 406,20 32,67 2/10f2005 2}10/2005 .
Ooae, sally 1111111 123456759012345 148,80 92,42 3i9/2005 3492005 :
COright, samuel 1111111 123456759012345 40,00 0,00 124222003 12{22/2003 :
| | ®H

L Print _ EA Check al _ DUnCheck\qll ID\ Data

Segment count = =206 \ 12/712011

]
4, Select Deductible/COINS Service Lines.
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The Deductible/COINS report options appear.

Medicare Remit EasyPrint ¥3.2 10l x|

L]

File Tab ‘iew Report Search Tools Help

. f Impart

| P Report Iv

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List
f

FEEmar MEmE Adjusted Service Lines 3 Filene
COB [ Mon-COE Claims 3
Deductible 3 Deductible Lines 3
Denied Service Lines 4 Coinsurance Lines »
MSP | Mon-MSP Claims 3 Print
Cther Adjustrments 3 [ A Export
Erntire Remittance
K | 2l
Claim List Clairn Detail I Rermit [Fummary I Data Yiew I Search I Glossary I
Name | ACHT | IcH | Biled Amount | PaidAmount | FromDate | ToDate | &
Ooae, saly 1111111 12345675901 2345 910,50 402,53 2}10{2004 21042004 .
Ooae, saly 1111111 12345675901 2345 910,50 557,25 2/10{2004 21042004 .
Oooae, saly 1111111 12345675901 2345 38,20 12,50 2{11{2005 2}11j2005 .
D Right, Samuel 1111111 123456759012345 237.60 159.36 3{28{2005 3/28/2005 b
Oooae, saly 1111111 12345675901 2345 406,20 32,67 2/10f2005 2}10/2005 .
Ooae, sally 1111111 123456759012345 148,80 92,42 3i9/2005 3492005 :
COright, samuel 1111111 123456759012345 40,00 0,00 124222003 12{22/2003 :
| | ®H
Print A check all CJUncheck &l 1@ pat.
Seqgment count = =206 12/7[2011

5. Select the Deductible & Coinsurance Lines:
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cMedicare Remit EasyPrint ¥3.2 =[]

File Tab Wiew Report Search Tools Help

. ' Irnpart

| P Report Iv

_Anrchl\-'e [, Restore _XDeIete | q Search | EF'r*lnt List
f

Paver Mame Adjusted Service Lines Y Check/EFT Mumber Yersion Filenz
0B/ Non-C0B Claims > i A R AT e
Deductible 3 Deductible Lines 3
Denied Service Lines L4 Coinsurance Lines
MSP | Mon-M3SP Claims 3 ]
Other Adjustments 3
Entire Remittance
L | i |
Claim List Claim Detail I Remit Summary I Search I Glossary I
Name | ACHT | i/ | Billed Amount | Paid smount [ FromDate | ToDate | A
Ooce, saly 1111111 123456759012345 -910.50 -402.53 2110/2004 2/10/2004 :
Ooce, saly 1111111 1234567#9012345 310,50 587.28 2110/2004 2/10/2004 :
Ooce, saly 1111111 123456739012345 38.20 12.50 2{11/2005 2J11/2005 :
Oright, Sarmuel 1111111 123496739012345 237.60 159.36 3(28/2005 3/28/2005 :
Ooce, saly 1111111 123456789012345 406.20 32.67 2{10/2005 2/10/2005 :
Ooce, saly 1111111 17/3456789012345 148.30 az.42 3(9/2005 3j9/2005 :
Oright, saruel 1111111 23456789012345 40,00 0,00 12f222003 12j22/2003 :
<| T
Prink EA Check al (1 nCheck all -!:.]’\ Data
Segment count = >206 / 12/712011

/
6. Select Export.
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Medicare Remit

Hint:

When you export,
the default folder is
the ReportExport
folder in the
Medicare Remit

Easy Print directory.

You can select
another location
using the Save in
drop-down list.

Easy Print

The Export folder window opens.

Choose folder for export cd |

Save in: Ia RepaortE spart j = EF -

File: name: || /

Save as lype: /

6. Enter the file name
7. Click the Save button.
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How to Print the COB Claims Report

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

&)

The Medicare Remit Easy Print Claim List tab opens.

OMedicare Remit EasyPrint ¥3.2 -10] x|
File Tab “iew Report | Search Tools Help
’Import | P Report - A Archive 7 Restore x Delete Q Search | Prink List
Paver Mame | Payee ID | Check Date | Check/EFT ... | Check/EFT ... | Claims | Check/EFT Mumber | ersion | Filenz
AREA INSURAMCE  ACME PHYSICIANS INC, 12345675 04/23/05 481.71 EFT 7 12345 00S010x22141 ARESA
| i
Claim DeNiI I Remik Summary Data Yiew | Search | Glossary |
Marne |\ ACHT | Jan] | Biled Amaunt | paid amourt | From Date | ToDate | A
Ooae, saly 1111111 12345675901 2345 910,50 402,53 zi10/2004 2{10{2004 .
Ooae, saly 1111111 12345675901 2345 38,20 12.50 2}11}2005 2112005 .
Cright, samuel 1111111 12345675901 2345 40,00 0.00 1212212003 12222003 .
Ooae, saly 1111111 12345675901 2345 143,50 9z,42 349/2005 3/9/2005 .
D Right, Samuel 1111111 123456759012345 237.60 159.36 3/28/2005 3/28/2005 b
Ooae, saly 1111111 12345675901 2345 406,20 32,67 2}10{2005 21042005 .
Ooae, saly 111111 12345675901 2345 910,50 557,25 2}10{2004 210{2004 .
4| | H©
Print EA Check all CJuncheck Al i@ Data \
\ 12/8/2011

2. Click the down arrow on the Rep})rt button.
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The Report List appears.

Medicare Remit EasyPrint ¥3.2 10l x|

L]

File Tab ‘iew Report Search Tools Help

. f Impart

| P Report Iv

Adjusted Service Lines LT | rhack mat
COE Claims 3
MNon-COB Claims  #

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List
f

Filenz

Payer Name ‘ersion

Deductible | COINS Sers

3
3
Denied Service Lines »]
MSP | Mon-MSP Claims 3
COther Adjustments 3
Erntire Remittance
K | 2l
Claim List Clairn Detail I Rermit Summary Data Yiew I Search I Glossary I
Narne | ACNT | jan] | Biled Amount | Paid amourt | From Date | ToDate | A
Ooce, salky 1111111 123456789012345 -910.50 -402.53 2(10{2004 2/10/2004 .
Ooce, saly 1111111 123456789012345 910,50 587,28 2(10/2004 2/10/2004 .
Oooe, sally 1111111 123456739012345 38.20 12,50 2{11{2005 2112005 .
D Right, Samuel 1111111 123456789012345 237.60 159,36 3{28{2005 3/28/2005 b
Oooe, sally 1111111 123456739012345 406.20 32,67 2{10/2005 2{10/2005 .
Coce, sally 1111111 12345678901 2345 148.30 52,42 392005 392005 .
CIrigtt, Samuel 1111111 12345678901 2345 40,00 000 12/2242003 \2{z2}2003 .
l | ©
L Print A check all Cfuncheck &l 1@ Data
Seqgment count = =206 12/7[2011

3. Select COB/Non-COB Claims.
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Medicare Remit Easy Print

The Print and Export options appear.

Medicare Remit EasyPrint ¥3.2

L]

File Tab ‘iew | Report Search Tools Help

Adjusted Service Lines

. f Impart

Payer Name

Denied Service Lines
MMSP/Mon-MSP Claims
COther Adjustments

Deductible | COINS Service Lines

Working with Reports

~=lolx|

Entire Remittance
Prink Remit Lisk

Filenz

‘ersion

K | 2l
Claim List Clairn Detail I iemit Summary Data Yiew I Search I Glossary I
ame | | I | Billed Amount | Paid Amount | From Date To Date | A
Ooce, salky 123456789012345 -910.50 -402.53 2(10{2004 2/10/2004 .
Ooce, saly 123456789012345 910,50 587,28 2(10/2004 2/10/2004 .
Oooe, sally 123456739012345 38.20 12,50 2{11{2005 2112005 .
Oright, samuel 123456739012345 237.60 159,36 3/28/2005 328/2005 .
Oooe, sally 123456739012345 406.20 32,67 2{10/2005 2{10/2005 .
Coce, sally 12345678901 2345 148.30 52,42 392005 392005 .
CIrigtt, Samuel 12345678901 2345 40,00 000 12/2242003 \2{z2}2003 .
4| | ®
Print A check all [IIIUncheck Al @ pata
Segment count = =206 / 12/712011

4. Select COB/CIaims.

which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs.

© 2005 General Dynamics IT Company. All Rights Reserved.
This document contains GDIT confidential and proprietary information,

158



Medicare Remit Easy Print

Working with Reports

.Medicare Remit EasyPrint ¥3.2 =[]
File Tab Wiew Report Search Tools Help
_'Import | P Repart Iv | B, archive [ Restore | X Delete | q Search | EF'r*lnt List
— . . . I
Payer Name Adjusted Service Lines Phetn | orhecknare [ checkieer [ checkiEFT . | Claims | CheckiEFT mumber | version | Filens
AREA THSURAH R e *| OB Claims 4 71 EFT 12345 00S010%22181  AREA
Deductible { COIMNS Service Lines  # MNon-COB Claims  # Expork
Denied Service Lines 4
MSP | Mon-M3SP Claims 3
Other Adjustments 3
Entire Remittance
1] | |
Claim Detail I Renmit Summ%y I Data View I Search I Glossary I
Name | ACHT ! ICH | Billed Amount | Paid smount [ FromDate | ToDate | A
Ooce, sally 111111 123456759012345 -910,50 -402.53 2/10{2004 2}10/2004 .
Ooce, saly 111111 12345675901 2345 38,20 12.50 2/11f2005 2}11j2005 .
Cright, Samuel 111111 12345675901 2345 40,00 0.00 1242242003 12{22}2003 .
Ooce, saly 111111 12345675901 2345 145,80 92,42 349(2005 3/9(2005 .
Oright, samuel 1111111 123456759012345 23760 159,36 3f28/2005 3/28)2005 i
Oooce, saly 111111 12345675901 2345 408,20 32,67 2/10{2005 21102005 v
Ooce, saly 111111 123456758901 2345 910,50 557,28 2/10{2004 2}10/2004 v
| |
L Print  Edcheckal | ﬁ UnCheck Al _i!i.l?\ Data
/ 12j8/2011

/
5. Select Print.

The Print denied line report window opens.
6. Print the detail listing in one of the following ways:

A. From the Print denied line report window, click Print to print the detail without

previewing it.

Print denied line reporkt

Prewview

LCancel
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Medicare Remit Easy Print Working with Reports

The Print dialog opens.
Pint 21

— Frinter
Properties... |

Mame: ‘\papurush TCG

Status: Ready
Type: HP Lazerlet 4200 PS
“Where:  TC-E-020

Comment; [ Prirk to file
— Frint range Copie:
Lol | Murnber of copies: |1 3:
" Pages from:l to:l
E - ¥ Callate
_ = Selection
f 0K I Cancel |

If you need to e the properties, click Properties and make changes as necessary.
Click OK. Medicare Remit Easy Print prints the detail at your default printer.

J. From the Print denied line report window, click Preview to view a preview of the
printed page before printing.

H denied e repo _ﬁl

The Print Preview window opens.

OOB® 8 | oo

Click printer button = at the top of the window.
Medicare Remit Easy Print prints the detail at your default printer.
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How to Export the COB Claims Report
You export the report in .csv (comma separated values) format.

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon

&

The Medicare Remit Easy Print Claim List tab opens.

OMedicare Remit EasyPrint ¥3.2 =[]
File Tab Wiew Report Search Tools Help

. ' Irnpart

Payer Name k. Date
AREA INSURAMCE | ACME PHYSTCTANS INC, 2345675 04/23/05

_Anrchl\-'e [, Restore _XDeIete | q Search | EF'r*lnt List

| P Report -
_ IS

CheckiEFT ... CheckiEFT Number Filens

K | i |
Claim List Clairm Det\l I Remit Summary Daka Yiews I Search I Glossary I

Marne |\ ACHT | Jan] | Biled Amount | Paid amourt | From Date | ToDate | &
Ooce, saly 1111111 123456739012345 -910.50 -402.53 2110/2004 2/10/2004 :
Ooce, saly 1111111 123456739012345 310,50 587.28 2110/2004 2/10/2004 :
Ooce, saly 1111111 123456739012345 38.20 12.50 2{11/2005 2J11/2005 :
DRight, Samuel 1111111 123456759012345 23760 159.36 3/28{2005 3/28/2005 b
Ooce, saly 1111111 123456789012345 406.20 32.67 2{10/2005 2/10/2005 :
Ooce, saly 123456789012345 148.30 az.42 3(9/2005 3j9/2005 :
Oright, saruel 123456789012345 40,00 0,00 12f222003 12j22/2003 :
4 | B
L Print A Check Al [ Uncheck &l 1D Data \

Segment count = >206 \ 12/6/2011

2. Click the down arrow on the Rep})rt button.
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The Report List appears.

Medicare Remit EasyPrint ¥3.2 10l x|

L]

File Tab ‘iew Report Search Tools Help

. f Impart

| P Report Iv

Adjusted Service Lines LT | rhack mat
COE Claims 3

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List
f

Filenz

Payer Name ‘ersion

3
Deductible | COINS Service Lid 3 Mon-COB Claims  »
Denied Service Lines »]
MSP | Mon-MSP Claims 3
Cther Adjustrments 3
Erntire Remittance
K | 2l
Claim List Clairn Detai I Remit Surnmary Daka View I Search I Glossary I
Narne | ACNT | jan] | Biled Amount | Paid amourt | From Date | ToDate | A
Ooce, salky 1111111 123456789012345 -910.50 -402.53 2(10{2004 2/10/2004 .
Ooce, saly 1111111 123456789012345 910,50 587,28 2(10/2004 2/10/2004 .
Oooe, sally 1111111 123456739012345 38.20 12,50 2{11{2005 2112005 .
D Right, Samuel 1111111 123456759012345 237.60 159.36 3{28{2005 3/28/2005 b
Oooe, sally 1111111 123456739012345 406.20 32,67 2{10/2005 2{10/2005 .
Coce, sally 1111111 12345678901 2345 148.30 52,42 392005 392005 .
CIrigtt, Samuel 1111111 12345678901 2345 40,00 000 12/2242003 \2{z2}2003 .
4| | ®
L Print A check all O uncHeck &l |12 Data
Segment count = =206 12/712011

3. Select COB/Non-COB Claims.
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cMedicare Remit EasyPrint ¥3.2 =[]
File Tab Wiew | Report Search Tools Help

' [ Adjusted Service Lines

Irnpork |

L COB [ Mon-COB Claims

Paver Name Deductible | COINS Service Lines Version

Denied Service Lines
5P fMon-M3P Claims
Other Adjustments

* v v vRd ~

Entire Remittance
Print Rermit: List

| |
Claim List Claim Detail I Re/wit SUmmary Daka Yiews I Search I Glossary I
Name | achT [ | ICH | Billed Amount | Paid smount [ FromDate | ToDate | A
Oboe, sally 12345673901 2345 -910.,50 -402.53 2/10/2004 2/10/2004 :
Oooe, sally 12345673901 2345 910.50 557.28 2/10/2004 /102004 .
Oooe, sally 12345673901 2345 3820 12,50 2{11/2005 /112005 .
right, Samued 12345673901 2345 237.60 159.36 328/2005 3(28/2005 .
Oooe, sally 12345673901 2345 406.20 3267 2/10/2005 2{10/2005 :
Oooe, sally 12345673901 2345 142.80 92,42 39(2005 3(9(2005 :
right, Samuel 12345673901 2345 40.00 000 12i2zi2003 12{22(2003 :
| |
Prink EA Check al [ UnCheck all -!:.]’\ Data
Segment count = >206 / 12/712011

[
4, Select COB Claims.
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Medicare Remit Easy Print

The Print and Export options appear.

Working with Reports

B8 Medicare Remit EasyPrint v3.2 10l x|
File Tab Yiew Report Search Tools Help
flmport P Repart Iv B, Archive . Restare X Delete | q Search | Print List
[ . . . I
Payer Name Adjusted Service Lines P hatn | rhecknate [ okeckieer L [ checkiEFT ... | Claims | CheckiEFT Number | version | Fileriz
AREA TNSURAR b 4 Frint 71 EFT 7 12345 00S010%22181  AREA
Deductible | COINS Service Lines ¥ Mon-COB Claims  »
Denied Service Lines 3
MSP | Mon-MSP Claims 3
COther Adjustments 3
Entire Remittance
| | i
Claim List Clairn Detail I Remit Summary/ I Data Yiew I Search I Glossary I
Narne | ACNT |/ jan] | Biled Amount | Paid amourt | From Date | ToDate | A
Ooce, sally 1111111 123456789012345 -910.,50 -402.53 2/10{2004 2}10/2004 v
Ooce, saly 1111111 123456789012345 38,20 12.50 2/1142005 2j11j2005 .
right, samuel 1111111 123456759012345 40,00 0,00 124222003 12{22(2003 :
Ooae, sally 1111111 123456759012345 148,80 92,42 3492005 3492005 :
D Right, Samuel 1111111 123456759012345 237.60 159.36 3{28{2005 3/28/2005 b
Ooce, saly 1111111 123456789012345 406,20 32.67 2{10{2005 2{10/2005 :
Ooce, saly 1111111 123456789012345 310,50 587.28 2{10{2004 2/10/2004 :
l | ©
Print A check all )ﬁ Uncheck &l @ Data
/ 12{5{2011

/
5. Select Export.
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Medicare Remit Easy Print

Hint:

When you export,
the default folder is
the ReportExport
folder in the
Medicare Remit
Easy Print
directory. You can
select another
location using the
Save in drop-down
list. menu.

o o

The Export folder window opens.

Choose folder for export cd |
Save in: I 3 ReportE sport j = £ B
File name: II/ j Save
Save as type: I /' Cancel |
%

Enter the file name,

Click the Save button.
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Medicare Remit Easy Print

How to Print the Non-COB Claims Report
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

&)

The Medicare Remit Easy Print Claim List tab opens.

Working with Reports

OMedicare Remit EasyPrint ¥3.2 -10] x|
File Tab “iew Report | Search Tools Help
’Import | P Report k‘ A Archive 7 Restore x Delete Q Search | Prink List
Paryer Name I Payee Name\ | Payee ID | Check Date | Check/EFT ... | Check/EFT ... | Claims | Check/EFT Mumber | ersion | Filenz
AREA INSURAMCE  ACME PHYSIONANS INC, 12345675 04/23/05 481.71 EFT 7 12345 00S010x22141 ARESA
| i
Claim Detg(l I Remik Summary Data Yiew | Search | Glossary |
Marne [\ ACHT | Jan] | Biled Amaunt | paid amourt | From Date | ToDate | A
Ooae, saly 1111111 12345675901 2345 910,50 402,53 zi10/2004 2{10{2004 .
Ooae, saly 1111111 12345675901 2345 38,20 12.50 2}11}2005 2112005 .
Cright, samuel 1111111 12345675901 2345 40,00 0.00 1212212003 12222003 .
Ooae, saly 1111111 12345675901 2345 143,50 9z,42 349/2005 3/9/2005 .
D Right, Samuel 1111111 123456759012345 237.60 159.36 3/28/2005 3/28/2005 b
Ooae, saly 12345675901 2345 406,20 32,67 2}10{2005 21042005 .
Ooae, saly 12345675901 2345 910,50 557,25 2}10{2004 210{2004 .
4| | H©
Print EA Check all CJuncheck Al i@ Data \
\ 12/8/2011

K. Click the down arrow on the Report button.

\
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Medicare Remit Easy Print Working with Reports

The Report List appears.

Medicare Remit EasyPrint ¥3.2 10l x|

L]

File Tab ‘iew Report Search Tools Help

. f Impart

| P Report Iv

Adjusted Service Lines LT | rhack mat
COE Claims 3
MNon-COB Claims  #

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List
f

Filenz

Payer Name ‘ersion

Deductible | COINS Serwidh Lines

3
3
Denied Service Lines »]
MSP | Mon-MSP Clairns 3
Cther Adjustrments 3
Erntire Remittance
K | 2l
Claim List Clairn Detail I Rermit Summary Data Yiew I Search I Glossary I
Name | ACHT | IcH | Biled Amount | PaidAmount | FromDate | ToDate | &
Ooce, salky 1111111 123456789012345 -910.50 -402.53 2(10{2004 2/10/2004 .
Ooce, saly 1111111 123456789012345 910,50 587,28 2(10/2004 2/10/2004 .
Oooe, sally 1111111 123456739012345 38.20 12,50 2{11{2005 2112005 .
D Right, Samuel 1111111 123456789012345 237.60 159,36 3{28{2005 3/28/2005 b
Oooe, sally 1111111 123456739012345 406.20 32,67 2{10/2005 2{10/2005 .
Coce, sally 1111111 12345678901 2345 148.30 52,42 392005 392005 .
CIrigtt, Samuel 1111111 12345678901 2345 40,00 000 12/2242003 \2{z2}2003 .
| | &
L Print EA Check al ClUncheck &l 1D Data
Seqgment count = =206 12/7[2011
2. Select COB/Non-COB Claims.
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cMedicare Remit EasyPrint ¥3.2

File Tab Wiew Report Search Tools Help

~=lolx|

. ' Irnpart

_Anrchl\-'e [, Restore _XDeIete | q Search | EF'r*lnt List

| P Report Iv

Adjusted Service Lines 3 ip T |
 Mon-
Deductible { COT

Denied Service Lines
MSP | Mon-M3SP Claims
Other Adjustments

Pawer Name
lainns

M5 Service Lines

Entire Remittance
L | |
Claim List Claim Detail Daka Yiews I Search I Glossary I
Marne | achT [ | Jan] | Biled Amount | Paid Amourt | From Date ToDate | &
Oboe, sally 12345673901 2345 -910.,50 -402.53 2/10/2004 2/10/2004 :
Oooe, sally 12345673901 2345 910.50 557.28 2/10/2004 /102004 .
Oooe, sally 12345673901 2345 3820 12,50 2{11/2005 /112005 .
right, Samued 12345673901 2345 237.60 159.36 328/2005 3(28/2005 .
Oooe, sally 12345673901 2345 406.20 3267 2/10/2005 2{10/2005 :
Oooe, sally 12345673901 2345 142.80 92,42 39(2005 3(9(2005 :
right, Samuel 12345673901 2345 40.00 000 12i2zi2003 12{22(2003 :
| |
- Prirt | EA Check al | O Un/iheck All
Segment count = >206 I 12172011

3. Select Non-COB Claims.
The Print and Export options appear.
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OMedicare Remit EasyPrint ¥3.2 =[]

File Tab Wiew Report Search Tools Help

. ' Irnpart

_Anrchl\-'e [, Restore _XDeIete | q Search | EF'r*lnt List

| P Report Iv

i
Payer Name Adjusted Service Lines Pl I rheck nat CheckfEFT ... | Check/EFT ... Claims Check{EFT Mumber Version Filene
i 3 COE Claims 3
» im
Denied Service Lines 4 Expork
MSP | Mon-M3SP Claims 3
Other Adjustments 3
Entire Remittance
L | i |
Claim List Claim Detail I Remit Summay{ I Daka Yiews I Search I Glossary I
Marne | ACHT |/ Jan] | Biled Amount | Paid amourt | From Date | ToDate | &
Ooce, saly 1111111 123456739012345 -910.50 -402.53 2110/2004 2/10/2004 :
Ooce, saly 1111111 123456739012345 310,50 587.28 2110/2004 2/10/2004 :
Ooce, saly 1111111 123456739012345 38.20 12.50 2{11/2005 2J11/2005 :
D Right, Samuel 1111111 123456759012345 237.60 159,36 3f28/2005 3/28)2005 i
Ooce, saly 1111111 123456789012345 406.20 32.67 2{10/2005 2/10/2005 :
Ooce, saly 1111111 123456789012345 148.30 az.42 3(9/2005 3j9/2005 :
Oright, saruel 1111111 123456789012345 40,00 0,00 12f222003 12j22/2003 :

4 | B

L Print B Checkal )ﬁ UnCheck Al _i!i.l?\ Data

Segment count = >206 / 12/712011

4. Select Pr%t.
The Print denied line report window opens.

5. Print the detail listing in one of the following ways:

A. From the Print denied line report window, click Print to print the detail without
previewing it.

Print denied line report |

]
Frirt Presigw LCancel
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The Print dialog opens, for example:
Pint 21

— Frinter
Properties... |

Mame: ‘\papurush TCG

Status: Ready
Type: HP Lazerlet 4200 PS
“Where:  TC-E-020

Comment; [ Prirk to file
— Frint range Copie:
Lol | Murnber of copies: |1 3:
" Pages from:l to:l
E - ¥ Callate
_ = Selection
f 0K I Cancel |

If you need to ch e properties, click Properties and make changes as necessary.
Click OK. Medicare Remit Easy Print prints the detail at your default printer.

L. From the Print denied line report window, click Preview to view a preview of the
printed page before printing.

P e = E repo ﬂ

The Print Preview window opens.

5 0 - DD @@ B | oo |

A

Click printer button & at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.

© 2005 General Dynamics IT Company. All Rights Reserved.
This document contains GDIT confidential and proprietary information,
which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs.

170



Medicare Remit Easy Print

How to Export the Non-COB Claims Report

You export the report in .csv (comma separated values) format.

Working with Reports

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

&p)

The Medicare Remit Easy Print Claim List tab opens.

OMedicare Remit EasyPrint ¥3.2 =]
File Tab ‘Wiew Report | Search Tools Help
’ Import | | P Report: i B, 2rchive | 7 Restore | X pelete q Search | - Print Lisk
Payer Name I Payee Name\ | Payee ID | Check Date | Check/EFT ... | Check/EFT ... | Claims | Check/EFT Mumber | ‘ersion | Filenz
AREA INSURAMCE  ACME PHYSTCRANS INC, 12345678 04)23/05 451,71 EFT 7 12345 005010522141 AREA
| 0
Claim Det& I Remit Summary Data View | Search | Glossary |
Marne [\ ACHT | Jan] | Biled Amaunt | paid amourt | From Date ToDate | A
Ooce, sally 111111 123456758901 2345 -910,50 402,53 2/10{2004 2}10/2004 .
Ooce, saly 111111 12345675901 2345 38,20 12.50 2/112005 2}11j2005 .
Cright, samuel 111111 12345675901 2345 40,00 0.00 12{22}2003 12{22}2003 v
Ooce, saly 111111 123456758901 2345 143,50 92,42 349(2005 3/9(2005 v
Oright, samuel 1111111 123456789012345 237.60 159.36 3f28/2005 3/28)2005 i
Oooce, saly 12345675901 2345 406,20 32,67 2/10{2005 241042005 v
Oooce, saly 12345675901 2345 910,50 557,28 2/10{2004 2/10/2004 v
1] | ©
L Print A check Al [ Uncheck &l 1D Data \
\ 12/82011

2. Click the down arrow on the Rep\)rt button.
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The Report List appears.

Medicare Remit EasyPrint ¥3.2
File Tab ‘iew Report Search Tools Help

L]

~=lolx|

. f Impart

| P Report Iv

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List
f

Adjusted Service Lines LT | rhack mat

Payer Name

‘ersion

Filenz

3 COE Claims 3
Deductible | CQNS Service Lines ¥ Mon-COB Claims  »
Denied Service lines »]
ISP | Mon-MSP Claims 3
COther Adjustments 3
Entire Remittanc¥
K | 2l
Claim List | Cla‘ﬁ Deekail I Rermit Summary Data Yiew I Search I Glossary I
Name | | ACHT | IcH | Biled Amount | PaidAmount | FromDate | ToDate | &
Ooce, salky 1111111 123456789012345 -910.50 -402.53 2(10{2004 2/10/2004 .
Ooce, saly 1111111 123456789012345 910,50 587,28 2(10/2004 2/10/2004 .
Oooe, sally 1111111 123456739012345 38.20 12,50 2{11{2005 2112005 .
D Right, Samuel 1111111 123456759012345 237.60 159.36 3{28{2005 3/28/2005 b
Oooe, sally 1111111 123456739012345 406.20 32,67 2{10/2005 2{10/2005 .
Oooe, sally 1111111 123456739012345 148.80 92,42 39(2005 3(9(2005 .
right, Samuel 1111111 123456739012345 40,00 0,00 12/22i2003 12222003 .
| | &
L Print A check all O UNChBCk Al @ pata
Segment count = =206 \ 12/712011

|
3. Select COB/Non-COB Claims.
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cMedicare Remit EasyPrint ¥3.2

File Tab Wiew Report Search Tools Help

~=lolx|

. ' Irnpart

| P Report Iv

_Anrchl\-'e [, Restore _XDeIete | q Search | EF'r*lnt List

L
Paver Name Adjusted Service Lines L3 =, I

Mon-
Deductible { COT
Denied Service Lines
MSP | Mon-M3SP Claims
Other Adjustments

lairns

M5 Service Lines

Entire Remittance

Kl | |
Claim List Claim Detail Daka Yiews I Search I Glossary I

Mame | ICH | Eilled Amount | Paid Amount | From Dake To Date | Al
Ooce, sally 123456759012345 -910,50 -402.53 2/10/2004 2/10/2004 :
Ooce, sally 123456759012345 910,50 587,25 2/10/2004 2}10{2004 .
Oooe, sally 123456759012345 38.20 12.50 2/11/2005 2}11{2005 :
Oright, Samuel 123456759012345 237,60 159.36 3/28/2005 3/28/2005 :
Ooce, sally 123456750012345 406,20 32,67 2/10/2005 2}10{2005 .
Ooce, sally 123456750012345 148,80 97,42 3492005 3492005 .
Oright, Saruel 123456780012345 40,00 0,00 124222003 12}22(2003 .
4 | B
L Prink _ EA Check al _ O L/-.check all

Segment count = >206 I 12/712011

/
4. Select Non-COB Claims.
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The Print and Export options appear.

B Medicare Remit EasyPrint v3.2 10l x|
File Tab ‘iew Report Search Tools Help

.'Import | P Report Iv

Payver Namme Adjusted Service Lines 3 T

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List
f

Filenz

Deductible | COINS Service Lines
Denied Service Lines

MSP | Mon-MSP Claims

COther Adjustments

Entire Remittance
K | 2l
Claim List Clairn Detail I Remit Summar/ I Data Yiew I Search I Glossary I
Narne | ACNT |/ jan] | Biled Amount | Paid amourt | From Date | ToDate | A
Ooce, salky 1111111 123456789012345 -910.50 -402.53 2(10{2004 2/10/2004 .
Ooce, saly 1111111 123456789012345 910,50 587,28 2(10/2004 2/10/2004 .
Oooe, sally 1111111 123456739012345 38.20 12,50 2{11{2005 2112005 .
DRight, Samuel 1111111 123456789012345 237.60 159,36 3{28{2005 3/28/2005 b
Oooe, sally 1111111 123456739012345 406.20 32,67 2{10/2005 2{10/2005 .
Oooe, sally 1111111 123456739012345 148.80 92,42 39(2005 3(9(2005 .
right, Samuel 1111111 123456739012345 40,00 0,00 12/22i2003 12222003 .
4| | ®
Print A check all ¢ Uncheck &l @ Data
Segment count = =206 / 12/712011

5. Select Exéort.
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Hint:

When you
export, the
default folder
is the
ReportExport
folder in the
Medicare Remit
Easy Print
directory. You
can select
another
location using
the Save in
drop-down list.

The Export folder window opens.

Choose folder for export cd |
Save in: Ia RepaortE spart j = EF -
File: mame: II) j Save

Save as lype: /T

6. Enter the file name.
7. Click the Save button.
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How to Print the MSP Claims Report
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

&)

The Medicare Remit Easy Print Claim List tab opens.

OMedicare Remit EasyPrint ¥3.2 -10] x|
File Tab Wiew Report|Search Tools  Help

’Import | P Report vJ A Archive 7 Restore x Delete Q Search | Print Lisk
Paryer Name I Payee Namé | Payee ID | Check Date | Check/EFT ... | Check/EFT ... | Claims | Check/EFT Mumber | ersion | Filenz

AREA INSURAMCE  ACME PHYSTOTANS IMC, 12345678 04/23/05 451.71 EFT 7 12345 005010522181 AREA

| i
Claim Det\il I Remik Summary Data Yiew | Search | Glossary |
Marne |\ ACHT | Jan] | Biled Amaunt | paid amourt | From Date | ToDate | A
[bae, sally 1111111 123456759012345 -910.50 -402,53 2{10/2004 2/10/2004 :
Ooae, sally 1111111 123456759012345 38.20 12.50 2{11/2005 /112005 :
Oright, samuel 1111111 123456759012345 40,00 0,00 12f22j2003 12(22{2003 :
Ooae, sally 1111111 123456759012345 148.80 92,42 3f9(2005 3(9(2005 :
Oright, samuel 1111111 123456759012345 237.60 159,36 3f28/2005 328/2005 :
Ooae, sally 1111111 123456759012345 406.20 3267 z{10/2005 2/10/2005 :
Ooae, sally 1111111 123456759012345 910.50 587.28 2{10/2004 2/10/2004 :
4 | H
Print EA Check all CJuncheck Al i@ Data \

\ 12/8/z011

2. Click the down arrow on the Re})ort button.
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L]

The Report List appears.

Medicare Remit EasyPrint ¥3.2

Working with Reports

~=lolx|

File Tab ‘iew Report Search Tools Help
W It P Report Iv

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List

Paryer Marme Adjusted Service Lines 4 Yersion Filenz
COB [ Mon-COE Claims 3
Deductible | COINS Service Lines ¥
Denied Service Lines 3
MSP Claims 3
Other Adjustments A 3 Mon-MSP Claims  »
Erntire Remittance [
| | i
Claim List Clairn Datai I Remit Surnmary I Daka View I Search I Glossary I
Narne ACNT | jan] | Biled Amount | Paid Amourt | From Date ToDate | A
Ooce, sally 1111111 123456789012345 -910.50 -402.53 2/10/2004 2j10/2004 :
Ooce, saly 1111111 123456789012345 910,50 55728 2/10/2004 2/10/2004 .
Ooce, saly 111111 123456789012345 38.20 12.50 2112005 /112005 :
D Right, Samuel 1111111 123456759012345 237.60 159.36 3{28{2005 3/28/2005 b
Ooce, saly 111111 123456789012345 406.20 32.67 2{10{2005 2{10/2005 :
Oooe, sally 1111111 123456739012345 148.80 92,42 39(2005 3(9(2005 .
right, Samuel 1111111 123456739012345 40,00 0,00 12/22i2003 12222003 .
l | ©
Print EA Check al I fncheck &l 1D Data
Seqgment count = =206 12/7[2011

3. Select MSP/Non-MSP Claims.
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cMedicare Remit EasyPrint ¥3.2 =[]

File Tab Wiew Report Search Tools Help

. ' Irnpart

| P Report Iv

Adjusted Service Lines
COB | Mon-COE Claims
Deductible { COINS Service Lines

_Anrchl\-'e [, Restore _XDeIete | q Search | EF'r*lnt List
f

‘Wersion

Pawer Name

Prink
Export

HongSP Claims  »

Entire Remittance [ /
Kl | |
Claim List Claim Detail I P#mit SUmmary I Daka Yiews I Search I Glossary I
Mame | | ICH | Eilled Amount | Paid Amount | From Dake I To Date | Al
Ooce, sally 123456759012345 -910,50 -402.53 2/10/2004 2/10/2004 :
Ooce, sally 123456759012345 910,50 587,25 2/10/2004 2}10{2004 .
Oooe, sally 123456759012345 38.20 12.50 2/11/2005 2}11{2005 :
Oright, Samuel 123456759012345 237,60 159.36 3/28/2005 3/28/2005 :
Ooce, sally 123456750012345 406,20 32,67 2/10/2005 2}10{2005 .
Ooce, sally 123456750012345 148,80 97,42 3492005 3492005 .
Oright, Saruel 123456780012345 40,00 0,00 124222003 12}22(2003 .
4 | B
L Print  Edcheckal | 5[] UnCheck Al _i!i.l?\ Data
Segment count = >206 / 12172011

4, Select MSFl Claims.
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The Print and Export options appear.

S Medicare Remit EasyPrint ¥3.2 10l x|

L]

File Tab ‘iew Report Search Tools Help

. f Impart

P Report Iv .

B, Archive [}, Restore _XDeIete | q Search | EPrlnt List
f

Pa_ yer Name Adjusted Service Lines Flen | checkDate | checkierT ... | checkiErT ... | laims | CheckiEFT Mumber | version | Fileriz
AREA TNSURAR  ©OB f Mon-COB Claims Y fsers 04/23/05 481.71 EFT 7 12345 00S010X22181  AREA
Deductible | COINS Service Lines ¥
Denied Service Lines 3
MSP | Non-MSF ¢ 3 ;
COther Adjustments 3 Mon-MSP Claims  » ‘Export
i | Erntire Remittance [ | _'I
Claim List Clairn Detail I Remit Summary/ I Data Yiew I Search I Glossary I
Narne | ACNT |/ jan] | Biled Amount | Paid amourt | From Date | ToDate | A
Ooce, sally 1111111 123456789012345 -910.50 -402.53 2/10/2004 2j10/2004 :
Ooce, saly 1111111 123456789012345 38.20 12.50 2(11/2005 2j11/2005 .
Oright, Sarmuel 111111 123456789012345 40.00 0,00 12fz2{2003 12{22{2003 :
Ooce, saly 111111 123456789012345 148.30 az.42 3f9/2005 3f9/2005 :
D Right, Samuel 1111111 123456759012345 237.60 159.36 3{28{2005 3/28/2005 b
Oooe, sally 1111111 123456739012345 406.20 3267 2/10/2005 2{10/2005 .
Oooe, sally 1111111 123456739012345 910,50 5a7.28 2{10/2004 2{10/2004 .

4]
L Print B Checkal )ﬁ UnCheck al _i!i!?\ Data

| ©

/ 12{5{2011

5. Select Pr{nt.
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The Print denied line report window opens.

6. Print the detail listing in one of the following ways:

Working with Reports

M. From the Print denied line report window, click Print to print the detail without

previewing it.

Print denied line report

Preview

Cancel

The Print dialog opens.

r Printer

2]

Mame: oapbrush TG

Status: Fieady
Type: HF Lazerlet 4200 FS

“Where:  TC-E-020
Comment:

Properties... |

[~ Print ta file

— Print range

&

= Selection

{7 Pages [rom:l— _to:l—

Copie

MNumber of copies: |'| 3:

ﬂ ﬁ ¥ Callate

.l; oK I Cancel |

If you need to ¢ e the properties, click Properties and make changes as necessary.
Click OK. Medicare Remit Easy Print prints the detail at your default printer.

B. From the Print denied line report window, click Preview to view a preview of the

printed page before pri

Print denied line repork

nting.

Preview

Cancel
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The Print Preview window opens.

Click printer button = at the top of the window.
Medicare Remit Easy Print prints the detail at your default printer.
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How to Export the MSP Claims Report

You export the report in .csv (comma separated values) format.

Working with Reports

1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

&p)

The Medicare Remit Easy Print Claim List tab opens.

OMedicare Remit EasyPrint ¥3.2 =]
File Tab ‘Wiew Report | Search Tools Help
’ Impork P Repart - ' Restore x Delete q Search | Print Lisk
Payer Name I Payee Namé | Payee ID | Check Date | Check/EFT ... | Check/EFT ... | Claims | Check/EFT Mumber | ‘ersion | Filenz
AREA INSURAMCE  ACME PHYSTATANS INC, 12345678 04)23/05 451,71 EFT 7 12345 005010522141 AREA
| 0
I Remit Summary Data View | Search | Glossary |
Marne ACHT | Jan] | Biled Amaunt | paid amourt | From Date [ ToDate | A
Ooce, sally 111111 123456758901 2345 -910,50 402,53 2/10{2004 2}10/2004 .
Ooce, saly 111111 12345675901 2345 38,20 12.50 2/112005 2}11j2005 .
Cright, samuel 111111 12345675901 2345 40,00 0.00 12{22}2003 12{22}2003 v
Ooce, saly 111111 123456758901 2345 143,50 92,42 349(2005 3/9(2005 v
Oright, samuel 1111111 123456789012345 237.60 159.36 3f28/2005 3/28)2005 i
Oooce, saly 111111 12345675901 2345 406,20 32,67 2/10{2005 241042005 v
Oooce, saly 1111111 12345675901 2345 910,50 557,28 2/10{2004 2/10/2004 v
1] | ©
L Print A check Al [ Uncheck &l 1D Data \
\ 12/82011

2. Click the down arrow on the Re\)ort button.
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The Report List appears.

Medicare Remit EasyPrint ¥3.2

L]

File Tab ‘iew Report Search Tools Help

~=lolx|

.'Import | P Report Iv

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List

FEEmar MEmE Adjusted Service Lines
COB [ Mon-COE Claims
Deductible | COINS Service Lines
Denied Service Lines

‘ersion

Filenz

MSP Claims 3
COther Ad]ustn‘*nts Mon-MSP Claims  #
Entire Remittan‘e [
K | 2l
Claim List | Clkirn Detail I Rermit Summary I Data Yiew I Search I Glossary I
Narne | ACNT | jan] | Biled Amount | Paid Amourt | From Date ToDate | A
Ooce, salky 1111111 123456789012345 -910.50 -402.53 2(10{2004 2/10/2004 .
Ooce, saly 1111111 123456789012345 910,50 587,28 2(10/2004 2/10/2004 .
Oooe, sally 1111111 123456739012345 38.20 12,50 2{11{2005 2112005 .
D Right, Samuel 1111111 123456789012345 237.60 159,36 3{28{2005 3/28/2005 b
Oooe, sally 1111111 123456739012345 406.20 32,67 2{10/2005 2{10/2005 .
Coce, sally 1111111 12345678901 2345 148.30 52,42 392005 392005 .
CIrigtt, Samuel 1111111 12345678901 2345 40,00 000 12/2242003 \2{z2}2003 .
4| | ®
L Print EA Check al O %ncheck Al @ pata
Segment count = =206 \ 12/712011

|
3. Select MSP/Non-MSP Claims.
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cMedicare Remit EasyPrint ¥3.2 =[]

File Tab Wiew Report Search Tools Help

. ' Irnpart

| P Report Iv

Adjusted Service Lines
COB | Mon-COE Claims
Deductible { COINS Service Lines

_Anrchl\-'e [, Restore _XDeIete | q Search | EF'r*lnt List
f

Pawer Name ‘Wersion

ms Prink
Claims ¥ Export

. A I Entire Remittance [ / I ﬂ
Claim List Claim Detail I Relwit SUmmary I Daka Yiews I Search I Glossary I
Name | achT [ | ICH | Billed Amount | Paid smount [ FromDate | ToDate | A
Oboe, sally 12345673901 2345 -910.,50 -402.53 2/10/2004 2/10/2004 :
Oooe, sally 12345673901 2345 910.50 557.28 2/10/2004 /102004 .
Oooe, sally 12345673901 2345 3820 12,50 2{11/2005 /112005 .
right, Samued 12345673901 2345 237.60 159.36 328/2005 3(28/2005 .
Oooe, sally 12345673901 2345 406.20 3267 2/10/2005 2{10/2005 :
Oooe, sally 12345673901 2345 142.80 92,42 39(2005 3(9(2005 :
right, Samuel 12345673901 2345 40.00 000 12i2zi2003 12{22(2003 :

4 | B

- Prink | EA Check al | D/lncheck Al -!:.]’\ Data

Segment count = >206 / 12/712011

/
4. Select MSP Claims.
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The Print and Export options appear.

BB Medicare Remit EasyPrint ¥3.2 =of x|

L]

File Tab ‘iew Report Search Tools Help

.flmport | P Report Iv

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List
f

Payer Mame Adjusted Service Lines e ID | checkDate | checkierT ... | checkiErT ... | laims | CheckiEFT Mumber | version | Fileriz
AREA INSURAN OO [ Mon-COE Claims E67E 04/23(05 481,71 EFT 7 12345 005010%22141 AREA

Deductible | COINS Service Lines
Denied Service Lines
ISP | Mon-MSP ¢

3
3
3
3
3
3

COther Adjustments Mon-MSP Claims  #

Erntire Remittance [
| | i
Claim List Clairn Detail I Rermit Summary / I Data Yiew I Search I Glossary I

Narne | ACNT |/ jan] | Biled Amount | Paid amourt | From Date | ToDate | A
Clooe, Sally 1111111 12345675901 2345 -910.,50 -402.53 /1072004 2{10/2004 .
Clooe, sally 1111111 12345675901 2345 38,20 12,50 (1142005 (112005 .
CIrigtt, Samuel 111111 12345678901 2345 40,00 000 12f2242003 \2{Z2}2003 .
Coce, sally 111111 12345678901 2345 148.30 52,42 392005 392005 .
DRight, Samuel 1111111 123456789012345 237.60 159,36 3{28{2005 3/28/2005 b
Coce, sally 1111111 12345678901 2345 406,20 3267 2/10/2005 2/10/2005 .
Coce, sally 1111111 12345678901 2345 910,50 Sa7.28 | 21042004 2/10/2004 .
4| | ®

L Print Edcheckal | ¢Uncheck all _i!i!?\ Data

/ 12{5{2011

5. Select Exp{ort.
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Hint:

When you export,
the default folder is
the ReportExport
folder in the
Medicare Remit
Easy Print
directory. You can
select another
location using the
Save in drop-down
list. menu.

o o

The Export folder window opens.

Choose folder for export cd |
Save in: I 3 ReportE sport j = £ B
File: name: j Save
Save as type: /' Cancel |
%

Enter the file name,

Click the Save button.
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How to Print the Non-MSP Claims Report
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

&)

The Medicare Remit Easy Print Claim List tab opens.

OMedicare Remit EasyPrint ¥3.2 -10] x|
File Tab Wiew Report|Search Tools  Help

.’Import | P Repark -
: _ Lo

A Archive 7 Restore x Delete Q Search | Prink List

Paver Mame | Payee ID | Check Date | Check/EFT ... | Check/EFT ... | Claims | Check/EFT Mumber | ersion | Filenz
AREA INSURAMCE  ACME PHYSINIANS INC, 12345675 04/23/05 481.71 EFT 7 12345 00S010x22141 ARESA
| 0
Claim De\@il I Remik Summary Data Yiew | Search | Glossary |

Marne [\ ACHT | Jan] | Biled Amaunt | paid amourt | From Date | ToDate | A
Ooce, sally 1111111 123456789012345 -910.,50 -402.53 2/10{2004 2}10/2004 v
Ooce, saly 1111111 123456789012345 38,20 12.50 2/11{2005 2{11)2005 v
Oright, samuel 1111111 123456789012345 40,00 0.00 12{22i2003 12{22{2003 v
Ooce, saly 1111111 123456789012345 148,50 92,42 3i9(2005 3j9(2005 v
D Right, Samuel 1111111 123456759012345 237.60 159.36 3/28/2005 3/28/2005 b
Ooce, saly 1111111 123456789012345 406,20 32,67 2/10{2005 2{10/2005 v
Ooce, saly 1111111 123456789012345 910,50 557,28 2/10{2004 2}10/2004 v

4| | B

o, Print  EAcheckal | []uncheck &l ﬂ?\ Data \

\ 12/8/2011

1. Click the down arrow on the Re\port button.
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The Report List appears.

Medicare Remit EasyPrint ¥3.2

L]

File Tab ‘iew Report Search Tools Help

~=lolx|

.'Import | P Report Iv

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List

FEEmar MEmE Adjusted Service Lines
COB [ Mon-COE Claims
Deductible | COINS Service Lines
Denied Service Lines

MSP Claims 3 I

‘ersion

Filenz

COther Adjustments Mon-MSP Claims  #
Erntire Remittance [
K | 2l
Claim List Clairn Detail I Rermit Summary I Data Yiew I Search I Glossary I
Narne | ACNT | jan] | Biled Amount | Paid Amourt | From Date ToDate | A
Ooce, salky 1111111 123456789012345 -910.50 -402.53 2(10{2004 2/10/2004 .
Ooce, saly 1111111 123456789012345 910,50 587,28 2(10/2004 2/10/2004 .
Oooe, sally 1111111 123456739012345 38.20 12,50 2{11{2005 2112005 .
D Right, Samuel 1111111 123456789012345 237.60 159,36 3{28{2005 3/28/2005 b
Oooe, sally 1111111 123456739012345 406.20 32,67 2{10/2005 2{10/2005 .
Coce, sally 1111111 12345678901 2345 148.30 52,42 392005 392005 .
CIrigtt, Samuel 1111111 12345678901 2345 40,00 000 12/2242003 \2{z2}2003 .
l | ©
L Print EA Check al O undheck &l 1D Data
Segment count = =206 12/712011

2. Select MSP/Non-MSP Claims.
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cMedicare Remit EasyPrint ¥3.2 =[]

File Tab Wiew Report Search Tools Help

. ' Irnpart

| P Report Iv

Adjusted Service Lines
COB | Mon-COE Claims
Deductible { COINS Service Lines

_Anrchl\-'e [, Restore _XDeIete | q Search | EF'r*lnt List
f

Pawer Name ‘Wersion

A

Har-[ aims Print
e — Expart
ntire Kemittance
I 7 | i

L

Claim List Claim Detail ik SUMMary I Daka Yiews I Search I Glossary I
Mame | | ICH | Eilled Amount | Paid Amount | From Dake I To Date | Al
Ooce, saly 123456739012345 -910.50 -402.53 2110/2004 2/10/2004 :
Ooce, saly 123456739012345 310,50 587.28 2110/2004 2/10/2004 :
Ooce, saly 123456739012345 38.20 12.50 2{11/2005 2J11/2005 :
Oright, Sarmuel 123456739012345 237.60 159.36 3(28/2005 3/28/2005 :
Ooce, saly 123456789012345 406.20 32.67 2{10/2005 2/10/2005 :
Ooce, saly 123456789012345 148.30 az.42 3(9/2005 3j9/2005 :
Oright, saruel 123456789012345 40,00 0,00 12f222003 12j22/2003 :

4 | B

- Prink | EA Check al | DUI"?I"ECk Al -!:.]’\ Data

Segment count = >206 I 12/712011

|
3. Select Non-MSP Claims.
The Print and Export options appear.
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OMedicare Remit EasyPrint ¥3.2 =[]
File Tab Wiew Report Search Tools Help

.'Import | P Repart Iv

Paver Name Adjusted Service Lines

COB | Mon-COE Claims
Deductible { COINS Service Lines
Denied Service Lines
MSP | Mo ‘
Other Adjustments

_Anrchl\-'e [, Restore _XDeIete | q Search | EF'r*lnt List
f

CheckiEFT ... CheckiEFT Number Yersion

00501

~Bd > v v »

. ; xpark
Entire Remittance

L | i |
Claim List Claim Detail I Remit Summary / I Daka Yiews I Search I Glossary I
Name | ACHT |/ ICH | Billed Amount | Paid smount [ FromDate | ToDate | A
Oboe, sally 1111111 12345673901 2345 -910.,50 -402.53 2/10/2004 2/10/2004 :
Oooe, sally 1111111 12345673901 2345 910.50 557.28 2/10/2004 /102004 .
Oooe, sally 1111111 12345673901 2345 3820 12,50 2{11/2005 /112005 .
DRight, Samuel 1111111 123456759012345 237.60 159,36 3f28/2005 3/28)2005 i
Oooe, sally 1111111 12345673901 2345 406.20 3267 2/10/2005 2{10/2005 :
Oooe, sally 1111111 12345673901 2345 142.80 92,42 39(2005 3(9(2005 :
right, Samuel 1111111 12345673901 2345 40.00 000 12i2zi2003 12{22(2003 :
4 | B

L Print | (A Check all / [ UnCheck &l 'i!i.l?\ Data

Segment count = >206 / 12/712011

/
4. Select Print.
The Print denied line report window opens.
5. Print the detail listing in one of the following ways:

N. From the Print denied line report window, click Print to print the detail without
previewing it.

Print denied line repork

Prewview LCancel
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The Print dialog opens.
Pint 21

— Frinter
Properties... |

Mame: ‘\papurush TCG

Status: Ready
Type: HP Lazerlet 4200 PS
“Where:  TC-E-020

Cornment: [ Prirk to file
— Frint range Copie:
Lol | Murnber of copies: |1 3:
" Pages from:l to:l
E - ¥ Callate
_ = Selection
f 0K I Cancel |

v

If you need to ch
Click OK=

e properties, click Properties and make changes as necessary.
edicare Remit Easy Print prints the detail at your default printer.

O. From the Print remit listing window, click Preview to view a preview of the printed
page before printing.

Print denied line report A

The Print Preview window opens.

SO - 0DBEEB| oo | e

Click printer button = at the top of the window.
Medicare Remit Easy Print prints the detail at your default printer.
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How to Export the Non-MSP Claims Report
You export the report in .csv (comma separated values) format.
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

&p)

The Medicare Remit Easy Print Claim List tab opens.

OMedicare Remit EasyPrint ¥3.2 =]

File Tab Wiew Report Search Tools Help

. ’ Impart

Paver Name
AREA INSURAMNCE | ACME PHYSTICTANS INC,

| P Report: vJ . B, 2rchive . 7 Restore . X pelete

q Search | EF'r'int Lisk

K | ol
Claim List Clairm Det\l I Remit Summary Daka Yiews | Search | Glossary |

Marne |\ ACHT | Jan] | Biled Amaunt | paid amourt | From Date [ ToDate | A
Ooce, saly 1111111 123456739012345 -910.50 -402.53 2/10/2004 2/10/2004 :
Ooce, saly 1111111 123456739012345 310,50 587.28 2{10/2004 2/10/2004 :
Ooce, saly 1111111 123456789012345 38.20 12.50 2{11/2005 2J11/2005 :
DRight, Samuel 1111111 123456739012345 23760 159,36 3/28/2005 3/28/2005 b
Ooce, saly 1111111 123456789012345 406.20 32.67 2{10/2005 2/10/2005 :
Ooce, saly 111111 123456789012345 148.80 az.42 349/2005 3/9/2005 .
Oright, sarmuel 11111 123456789012345 40,00 0,00 12422/2003 12}22}2003 .
4] | 2
L Print A check Al [ Uncheck &l 1D Data \

Segment count =>206 \ 12/6/2011

2. Click the down arrow on the Reé)ort button.
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The Report List appears.

Medicare Remit EasyPrint ¥3.2 10l x|

L]

File Tab ‘iew Report Search Tools Help

. f Impart

Payer Name

| P Report Iv

Adjusted Service Lines
COB [ Mon-COE Claims
Deductible | COINS Service Lines
Denied Service Lines

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List

Filenz

‘ersion

MSP Claims 3 I

COther Adjustments Mon-MSP Claims  #
Erntire Remittance [
K | 2l
Claim List Clairn Ditail I Rermit Summary I Data Yiew I Search I Glossary I
Narne | ACNT | jan] | Biled Amount | Paid amourt | From Date | ToDate | A
Ooce, salky 1111111 123456789012345 -910.50 -402.53 2(10{2004 2/10/2004 .
Ooce, saly 1111111 123456789012345 910,50 587,28 2(10/2004 2/10/2004 .
Oooe, sally 1111111 123456739012345 38.20 12,50 2{11{2005 2112005 .
DRight, Samuel 1111111 123456789012345 237.60 159,36 3{28{2005 3/28/2005 b
Oooe, sally 1111111 123456739012345 406.20 32,67 2{10/2005 2{10/2005 .
Coce, sally 1111111 12345678901 2345 148.30 52,42 392005 392005 .
CIrigtt, Samuel 1111111 12345678901 2345 40,00 000 12/2242003 \2{z2}2003 .
4| | ®
L Print A check all CJl Uncheck &l 1D Data
Segment count = =206 12/712011

3. Select MSP/Non-MSP Claims.
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cMedicare Remit EasyPrint ¥3.2 =[]

File Tab Wiew Report Search Tools Help

. ' Irnpart

| P Report Iv

Adjusted Service Lines
COB | Mon-COE Claims
Deductible { COINS Service Lines

_Anrchl\-'e [, Restore _XDeIete | q Search | EF'r*lnt List
f

Pawer Name ‘Wersion

Entire Remittance
L | i |
Claim List Claim Detail I Rerﬁt SUmmary I Daka Yiews I Search I Glossary I

Marne | achT [ | Jan] | Biled Amount | Paid amourt | From Date | ToDate | &
Oboe, sally 1111111 12345673901 2345 -910.,50 -402.53 2/10/2004 2/10/2004 :
Oooe, sally 12345673901 2345 910.50 557.28 2/10/2004 /102004 .
Oooe, sally 12345673901 2345 3820 12,50 2{11/2005 /112005 .
right, Samued 12345673901 2345 237.60 159.36 328/2005 3(28/2005 .
Oooe, sally 12345673901 2345 406.20 3267 2/10/2005 2{10/2005 :
Oooe, sally 12345673901 2345 142.80 92,42 39(2005 3(9(2005 :
right, Samuel 12345673901 2345 40.00 000 12i2zi2003 12{22(2003 :
N i

- Prink | EA Check al | D/Incheck Al -!:.]’\ Data

Segment count = >206 / 12/712011

/
4. Select Non-MSP Claims.
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The Print and Export options appear.

=10l x|
File Tab Wiew Report Search Tools Help
'Import P Repart Iv M Archive . Restare X Delete | q Search | EPrint List
f
Adjusted Service Lines Check/EFT Murmber Yersion Filenz
COB | Mon-COE Claims 00501
Deductible | COINS Service Lines
Denied Service Lines
MSP | Mon-MSP Claims
Cther Adjustrments
Erntire Remittance
K | 2l
Claim List Clairn Detail I Rermit Summary / Data Yiew I Search I Glossary I
Narne | ACNT | /[ 1n | Biled Amount | Paid amourt | From Date | ToDate | A
Ooce, sally 1111111 125456789012345 -910.,50 -402.53 2/10{2004 2}10/2004 v
Ooce, saly 1111111 3456739012345 910,50 557,28 2/10{2004 2}10/2004 .
Ooae, sally 1111111 2356759012345 38.20 12.50 2{11{2005 2/11{2005 :
D Right, Samuel 1111111 123456759012345 237.60 159.36 3{28{2005 3/28/2005 b
Ooae, sally 1111111 123456759012345 406,20 32,67 2{10{2005 2/10{2005 :
Ooae, sally 1111111 123456759012345 148,80 92,42 3i9/2005 3492005 :
COright, samuel 1111111 123456759012345 40,00 0,00 124222003 12{22/2003 :
| | ®H
L Print A check all O Unc%k Al @ pata
Segment count = =206 / 12fa/2011

/
5. Select Export.
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Hint:

When you export,
the default folder is
the ReportExport
folder in the
Medicare Remit Easy
Print directory. You
can select another
location using the
Save in drop-down
list.

The Export folder window opens.

Choose folder for export

Save in: I 3 ReportE sport

x| = @EekE-

File: name:

| ¢

Save as lype: /f

Enter the file Hame.

Click the Saveé button.
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How to Print the Other Adjustments Report
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

&)

The Medicare Remit Easy Print Claim List tab opens.

OMedicare Remit EasyPrint ¥3.2 -10] x|
File Tab Wiew Report Search Tools Help

.’Import | P Repark -

Payer Name
BREA INSURANCE 45 INC, 5 0 4517 2345 :

A Archive 7 Restore x Delete

( Search | Prink List
q |

K | |
Claim List Claim DetXI I Remit Summarty Data Yigw | Search | Glossary |
Marne [\ ACHT | Jan] | Biled Amaunt | paid amourt | From Date | ToDate | A
Oooe, salty 1111111 123456789012345 -510.50 -402.53 2{10/z004 2/10/z004 :
Ooce, saly 1111111 123456789012345 910,50 587,28 2{10/2004 2/10/2004 :
Ooce, saly 1111111 123456789012345 38,20 12.50 2{11/2005 2/11/2005 :
Oright, Samuel 1111111 123456789012345 237.60 159.36 3(28/2005 3/28/2005 :
Ooce, saly 1111111 123456789012345 406,20 32,67 2{10/2005 2/10/2005 :
Ooce, saly 123456789012345 148.80 92,42 3f9/2005 3/9/2005 :
right, Samuel 123456789012345 40.00 0.00 12§22}2003 12}22}2003 :
1 | ©H
Print EA Check all CJuncheck Al i@ Data \
Segment count = =206 \ 12f6f2011

. \
2. Click the down arrow on the Report button.
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The Report List appears.

Medicare Remit EasyPrint ¥3.2 10l x|

L]

File Tab ‘iew | Report Search Tools Help

. f Impart

I | Adjusted Service Lines

COB [ Mon-COE Claims
Deductible | COINS Service Lines
Denied Service Lines
MMSP/Mon-MSP Claims

tore | 3K Delets |q Search | EPrint List

Payer Name ‘ersion Filenz

fd * v v ¥ ¥

Print Report

Export Report
Entire Remittance A P i
Prink Remit Lisk
K | 2l
Claim List Clairn Detail I Rermit Summary Data Yiew I Search I Glossary I
Name | ACHT | IcH | Biled Amount | PaidAmount | FromDate | ToDate | &
Ooce, salky 1111111 123456789012345 -910.50 -402.53 2(10{2004 2/10/2004 .
Ooce, saly 1111111 123456789012345 910,50 587,28 2(10/2004 2/10/2004 .
Oooe, sally 1111111 123456739012345 38.20 12,50 2{11{2005 2112005 .
D Right, Samuel 1111111 123456789012345 237.60 159,36 3{28{2005 3/28/2005 b
Oooe, sally 1111111 123456739012345 406.20 32,67 2{10/2005 2{10/2005 .
Coce, sally 1111111 12345678901 2345 148.30 52,42 392005 392005 .
CIrigtt, Samuel 1111111 12345678901 2345 40,00 000 12/2242003 \2{z2}2003 .
4| | ®
L Print EA Check al Ol ungheck &l 1D Data
Seqgment count = =206 1zfg/z011

3. Select Other Adjustments.
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The Print and Export options appear.

Working with Reports

.Medicare Remit EasyPrint ¥3.2 10l x|
File Tab Wiew Report Search Tools Help
'Import P Report  + | | ) Archive . Restare X Delete | q Search | EPrint List
Payer Mame Adjusted Service Lines P e ID | checkDate | checkierT ... | checkiErT ... | Claims | CheckiEFT Mumber | version | Filens
AREA INSURAR  COB [ Mon-COB Claims ¥ fse7s 04/23/05 481.71 EFT 7 12345 005010522141 AREA
Deductible | COINS Service Lines ¥
Denied Service Lines 3
MSP | Mon-MSP Claims 3
COther Adjustments »
Enfire Remitt Export
ntire Remittance
| | i
Claim Detail I / Remit Summary Data Yiew I Search I Glassary I
Name | AT | IcH | Biled Amount | PaidAmount | FromDate | ToDate | &
Ooae, saly 111111 12345675901 2345 910,50 402,53 2}10{2004 21042004 .
Ooae, saly 11111 12345675901 2345 38,20 12.50 2{11}2005 2112005 .
Oright, samuel 11111 12345675901 2345 40,00 0,00 12{22j2003 12{22}2003 .
Oooae, saly 11111 12345675901 2345 148,60 92,42 3i9(2005 3j8(2005 .
D Right, Samuel 1111111 123456759012345 237.60 159.36 3{28{2005 3/28/2005 b
Oooe, saly 111111 12345675901 2345 408,20 32,67 2/10f2005 2}10/2005 .
Oooe, saly 111111 12345675901 2345 910,50 567,28 2/10f2004 2}10j2004 .
| | ®
L Print A check all / CJuncheck &l 1@ Data
/ 12{5{2011

|
4, Select Print.

The Print denied line report window opens.

5. Print the detail listing in one of the following ways:

P. From the Print denied line report window, click Print to print the detail without

previewing it.

Print denied line repork

Prewiew

LCancel
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The Print dialog opens.
print S

r Printer
Properties... |

Mare: \oapurush TCG

Status: Ready
Type: HF Laserlet 4200 PS
Where:  TC-5-020

Commetit: I™ Fiint to file
— Print range Copies
Al MNumber of copies: I'I 3:

€ Pages _from:l Ln:l  Colat
allate

) Selection ﬂl ﬂl
; ak. I Cancel |

e properties, click Properties and make changes as necessary.

If you need to ch
Click OK”Medicare Remit Easy Print prints the detail at your default printer.

Q. From the Print denied line report window, click Preview to view a preview of the
printed page before printing.

Print denied line repork A

The Print Preview window opens.

i
LO-DEEBEBB | cos | Page | =

Click printer button = at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.
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How to Export the Other Adjustments Report
You export the report in .csv (comma separated values) format.
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

&p)

The Medicare Remit Easy Print Claim List tab opens.

OMedicare Remit EasyPrint ¥3.2 =]
File Tab Wiew Report Search Tools Help

.’Import | P Report v«‘ . B Archive . 7 Restore . X pelete

Payer Name Check Date
AREA INSURAMNCE | ACME PHYSTCTANS INC, 04123/05

q Search | EF'r'int Lisk

CheckiEFT ...

CheckiEFT Number Yersion

L | |
Claim List Claim Dretail I Remit Summary Daka Yiews | Search | Glossary |
Name I\ ACNT | ICH |___Billed Amount | Paid mount | FromDake | ToDake | &
Cboe, sally 1111111 12345673901 2345 -910.50 -402.53 2/10/2004 /102004 :
Oooe, sally 1111111 12345673901 2345 910.50 557.28 2/10/2004 /102004 .
Oooe, sally 1111111 12345673901 2345 3820 12,50 2{11/2005 {11 /2005 :
DRight, Sarmuel 1111111 123456789012345 237.60 159.36 3f28/2005 3/28)2005 i
Oooe, sally 1111111 12345673901 2345 406.20 267 2/10/2005 /1042005 :
Oooe, sally 1111111 12345673901 2345 142,80 92,42 3/9/2005 3f9/2005 .
Oright, Samuel 111111 12345673901 2345 40,00 000 12422i2003 12{22(2003 .
1] | ©

L Print  BAcheckal | []uUncheck &l 'i!i.l?\ Data \

Segment count =>206 \ 12/6/2011

2. Click the down arrow on the Re}>ort button.
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The Report List appears.

Medicare Remit EasyPrint ¥3.2 10l x|

L]

File Tab ‘iew | Report Search Tools Help

. f Impart

I | Adjusted Service Lines

COB [ Mon-COE Claims
Deductible | COINS Service Lines
Denied Service Lines
MMSP/Mon-MSP Claims

tore | 3K Delets |q Search | EPrint List

Payer Name ‘ersion Filenz

fd * v v ¥ ¥

Print Report

) ) Export Repork
Entire Remittance
Prink Remit Lisk
K | 2l
Claim List Clairn Detail I Rermit Summary Data Yiew I Search I Glossary I
Name | ACHT | IcH | Biled Amount | PaidAmount | FromDate | ToDate | &
Ooce, salky 1111111 123456789012345 -910.50 -402.53 2(10{2004 2/10/2004 .
Ooce, saly 1111111 123456789012345 910,50 587,28 2(10/2004 2/10/2004 .
Oooe, sally 1111111 123456739012345 38.20 12,50 2{11{2005 2112005 .
D Right, Samuel 1111111 123456789012345 237.60 159,36 3{28{2005 3/28/2005 b
Oooe, sally 1111111 123456739012345 406.20 32,67 2{10/2005 2{10/2005 .
Coce, sally 1111111 12345678901 2345 148.30 52,42 392005 392005 .
CIrigtt, Samuel 1111111 12345678901 2345 40,00 000 12/2242003 \2{z2}2003 .
l | ©
L Print A check all O uncheck &l 1@ Data
Segment count = =206 12fa/2011

3. Select Other Adjustments.
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The Print and Export options appear.

Working with Reports

B8 Medicare Remit EasyPrint v3.2 10l x|
File Tab ‘iew | Report Search Tools Help
[ I Adjusted Service Lines 3 [ | ’ | A
f Impart: tore Delete Search Print List
L D | COB [ Mon-COE Claims 3 8 x q ==
Payer Mame Deductible { COINS Service Lines » [ | checkDate | checkierT ... | checkiErT ... | Claims | CheckiEFT Mumber | version | Filens
AREA INSURANCE  Denied Service Lines [ ] 04/23/05 481,71 EFT 7 12345 005010522141 AREA
MMSP/Mon-MSP Claims 3
3 Print Report
Entire Remittance
Prink Remit Lisk
| | i
Claim List Clairn Detail I RJmit Summary Data Yiew I Search I Glossary I
Narne | acnt | | jan] | Biled Amount | Paid amourt | From Date | ToDate | A
Ooae, saly 12345675901 2345 910,50 402,53 2}10{2004 21042004 .
Ooae, saly 12345675901 2345 38,20 12.50 2{11}2005 2112005 .
Oright, samuel 12345675901 2345 40,00 0,00 12{22j2003 12{22}2003 .
Oooae, saly 12345675901 2345 148,60 92,42 3i9(2005 3j8(2005 .
Oright, samuel 12345675901 2345 237,60 159,36 3j28(2005 3}28/2005 .
Ooae, sally 123456759012345 406,20 32,67 2{10{2005 2/10{2005 :
Ooae, sally 123456759012345 910,50 587,25 2/10{2004 2/10{2004 :
4| | ®
L Print A check all O U/Check Al @ pata
/ 12{5{2011

4. Select Export/Report.
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Hint:

When you export, the
default folder is the
ReportExport folder in
the Medicare Remit
Easy Print directory.

You can select
another location using
the Save in drop-
down list menu.

5.
6.

The Export folder window opens.

Choose folder for export cd |

Save in: Ia RepaortE spart j = EF -

File: name: ||)

Save ag y,lpe/l

Enter the file name,
Click the Save button.
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How to Print the Entire Remittance Report
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

&)

The Medicare Remit Easy Print Claim List tab opens.

OMedicare Remit EasyPrint ¥3.2 -10] x|
File Tab Wiew Report Search Tools Help

.’Import | | P Report vJ . A Archive . 7 Restore . x Delete

Payer Name
ARESA IMSURAMCE | ACME PHYSICTANS INC,

( Search | Prink List
q |

K | |
Claim List Claim DetXI I Remit Summarty Data Yigw | Search | Glossary |
Marne [\ ACHT | Jan] | Biled Amaunt | paid amourt | From Date | ToDate | A
Dae, Sally 1111111 123456789012345 -510.50 -402.53 2{10/z004 2/10/z004 :
Ooce, saly 1111111 123456789012345 910,50 587,28 2{10/2004 2/10/2004 :
Ooce, saly 1111111 123456789012345 38,20 12.50 2{11/2005 2/11/2005 :
Oright, Samuel 1111111 123456789012345 237.60 159.36 3(28/2005 3/28/2005 :
Dae, Sally 1111111 123456789012345 406,20 32,67 2{10/2005 2/10/2005 :
Dae, Sally 1111111 123456789012345 148.80 92,42 3f9/2005 3/9/2005 :
right, Samuel 111111 123456789012345 40.00 0.00 12§22}2003 12}22}2003 :
4| | H©
Print EA Check all CJuncheck Al i@ Data \
Segment count = =206 \ 12f6f2011

2. Click the down arrow on the Re\port button.

© 2005 General Dynamics IT Company. All Rights Reserved.
This document contains GDIT confidential and proprietary information,
which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs.

205



Medicare Remit Easy Print Working with Reports

The Report List appears.

Medicare Remit EasyPrint ¥3.2 10l x|

L]

File Tab ‘iew Report Search Tools Help

. f Impart

| P Report Iv

Adjusted Service Lines

COB [ Mon-COE Claims
Deductible | COINS Service Lines
Denied Service Lines

MSP | Mon-MSP Claims

COther Adjustments

_Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List
f

Paryer Name Check{EFT Number Filenz

e ID Check Date | CheckfEFT ... | Check/EFT ...

0+ =

‘ersion
0as0

* r T v owrow

Entire Remittance
| |
Claim List Clairn Detail I Rermit Summary Data Yiew I Search I Glossary I
Narne | ACNT | jan] | Biled Amount | Paid amourt | From Date | ToDate | A
Ooce, salky 1111111 123456789012345 -910.50 -402.53 2(10{2004 2/10/2004 .
Ooce, saly 1111111 123456789012345 910,50 587,28 2(10/2004 2/10/2004 .
Oooe, sally 1111111 123456739012345 38.20 12,50 2{11{2005 2112005 .
DRight, Samuel 1111111 123456789012345 237.60 159,36 3{28{2005 3/28/2005 b
Oooe, sally 1111111 123456739012345 406.20 32,67 2{10/2005 2{10/2005 .
Oooe, sally 1111111 123456739012345 148.80 92,42 39(2005 3(9(2005 .
right, Samuel 1111111 123456739012345 40,00 0,00 12/22i2003 12222003 .
4| | ®
L Print A check all Cunfcheck &l 1D Data
Segment count = =206 12fa/2011

3. Select Entire Remittance.
The Print remit listing window appears.
4. Print the detail listing in one of the following ways:

R. From the Print remit listing window, click Print to print the detail without previewing
it.

Print remit listing

L1
Print Preview Cancel
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The Print dialog opens.

Pint 21|
— Frinter
Mame: ‘\papurush TCG Properties... |
Status: Ready
Type: HP Lazerlet 4200 PS
“Where:  TC-E-020
Commert: I~ Pint to fils
— Frint range Copie:
Lol | Murnber of copies: |1 3:
 Pages from: I b I
: E |7'Egﬂme
= Selection

Lo

Cancel |

If you need to

Working with Reports

e the properties, click Properties and make changes as necessary.

Click OK. Medicare Remit Easy Print prints the detail at your default printer.

S. From the Print Remit listing window, click Preview to view a preview of the printed
page before printing.

Print remi

t listing

Print

Preview /

Cancel

The Print Preview window opens.

S0O- BDBEB [coe | P

Click printer button = at the top of the window.

Medicare Remit Easy Print prints the detail at your default printer.
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Housekeeping for the Import Files

Housekeeping includes:
* Archiving files
* Restoring files
* Deleting files

Archiving Import Files

Medicare Remit Easy Print does NOT automatically archive any Import file, and Import files
can slow down the processing time of the PC.

Therefore, Medicare Remit Easy Print lets you archive Import files. The location you choose
for the archive must have adequate security to protect PHI.

How to Archive Import files
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon

&
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The Medicare Remit Easy Print Claim List tab opens.

.Medicare Remit EasyPrint ¥3.2 10l x|

File Tab ‘iew Report Search Tools Help

. f Impart

Payer Name Payee Mame
ARESA INSURAMNCE TakS INC,

_PReport - _Anrchlve [}, Restore _XDeIete | q Search | EPrlnt List

Filenz

‘ersion

K | 2l
Claim List Clairn Eletail I Rermit Summary Data Yiew I Search I Glossary I

Narne [ ACNT | jan] | Biled Amount | Paid amourt | From Date | ToDate | A
Oobae, salty 1111111 123456789012345 -510.,50 -402.53 2{10/2004 2/10/2004 :
Ooae, saly 1111111 123456789012345 910,50 587,28 2{10/2004 2/10/2004 :
Ooce, saly 1111111 123456789012345 38,20 12.50 2{11/2005 2/11/2005 :
right, Samuel 1111111 123456789012345 237.60 159.36 328/2005 3/28/2005 :
Ooce, saly 1111111 123456789012345 406,20 32,67 2{10{2005 2/10/2005 :
Ooce, saly 1111111 123456789012345 148,80 92,42 3f9/2005 3f9/2005 :
Oright, Samuel 1111111 123456789012345 40,00 0,00 1242242003 12j22}2003 :
4| | ®
L Print B4 Che{k all CJuncheck &l 1@ Data

Segment count = =206 I 12/6/2011

2. On the top of the window, select the file that you want to archive and click the Archive
button.
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The Archive Imported Files window opens.
Pathname for

the Archive . Archive Imported Files =1Ol x|
folder Folder : |C:\Plogram Files'edicare Remit E azpPrintudrchivet, | Browse |
Paver Mame I Paves hame I Payee IO I Check Date I Check/EFT ... I Check/EFT ... | ¥ Check Al
F\REF\ IMSUR,,, | ACME PHYSICIAMNS IMC, 12345675 04/23/05 451,71 EFT

Hint:

You can use the
Browse button to
specify another
location for the
archived file.

1 |

1 item zelected Far archiving.

Hint:
When you need to archive
all the payers in the list,

. you can place a checkmark
4. Click the Archive button. in the Check All box to

Medicare Remit Easy Print moves the file to the Archive folder. ~ archive all the claim files.

3. Select the file(s) you want to archive by checking the box(es).
This activates the Archive button.

When you check that option
a checkmark is placed in
front of all claims in the list.
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Restoring Import files
You can restore an Import file after you have archived it.

For information about archiving Import files, see Archiving Import Files.

How to Restore Import files
1. Open Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon

.

The Medicare Remit Easy Print Claim List tab opens.

OMedicare Remit EasyPrint ¥3.2 - | E||1|
File Tab Wiew Report Search Tools Help

'Import P Rreport - | | M Archive 7 Restore X pelete q Search | Print List

| L | | » | | ==

Payer Mame Payes Mame Payes (D Check Dake | Check/EFT ... | Check/EFT ... Claims CheckiEFT Murber Yersion Filens

AREA INSURANCE | ACME PHYSICIANS INC.
L | ]|
Claim List Claim Detail I Rem\ SUmmary Daka Yiews I Search I Glossary I
harme | ACHT \ | Jan] | Biled Amount | Paid amourt | From Date | ToDate | &
Ooboe, salky 1111111 123456789012345 -910.50 -402.53 2(10{2004 2{10/2004 :
Ooce, saly 1111111 123456780012345 910,50 587,28 2(10/2004 2{10/2004 :
Ooce, saly 1111111 123456780012345 38,20 12.50 2(11/2005 2{11/2005 :
Oright, Samuel 1111111 123456730012345 237,60 159,36 3f28/2005 3/28/2005 :
Obce, Saly 1111111 123456730012345 406.20 32,67 2/10/2005 2/10/2005 :
Obce, Saly 1111111 123456730012345 148,80 92,42 3(9/2005 3/9/2005 :
Oright, Samuel 1111111 123456789012345 40.00 0.00 12j22}2003 12}22}2003 :
| | B
L, Print _ EA check all
Segment count =>206 1z/efz011

2. On the top of the window, click the Reétore button.
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The Restore Imported Files window opens.

Restore Impotted Files i ] 4
Pathname for the
Archive folder Folder : | C:\Program Files\Medicare Fiemit EaspPrintiarchivel | Brawse |
Hint: Payer Mare I Payes Marne | Payes 1D I Check Date | CheckfEFT ... | Check/EFT ... | I~ Check Al
! ) AREA INSUR... | ACME PHYSICIANS IMC. 12345675 04/23/05 451.7

To archive all the
claim files on the list,
place a checkmark in
the Check All box
When you check that
box places a
checkmark in front of
all the claims in the
list.

Restore
Cancel

il

1 item selected for restore,

3. Select the file(s) you want to restore by checking the box(es).
This activates the Restore button.
4. Click the Restore button.
Medicare Remit Easy Print moves the file from the Archive folder to the Import folder.

The file is now available for viewing on your C drive at C:\Program Files\Medicare Remit
EasyPrint\Import.

@ C:".Program Files',Medicare Remit EasyPrint,Import

File Edit \View Favorites Tools  Help |0 - gd T ',LT | P |—|_"‘| 2 [ 3
Address |[5) C:\Progran Files\Medicare Remit EasyPrinti Import

Folders X || Mame

= lﬂ Medicare Remit EasyPrint ;I BF’.REH INSURAMCE 12345 X835
| Archive
=)
| Makived3s
|5 RepartExpart
[5) Resource

Deleting Import files

If you delete an Import file by mistake, you must re-import the HIPAA 835 file. You cannot
restore the Import file.

How to Delete an Import file
1. E_pjen Medicare Remit Easy Print by double-clicking the Medicare Remit Easy Print icon.

Fl

The Medicare Remit Easy Print Claim List tab opens.
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Medicare Remit EasyPrint ¥3.2 -10] x|
File Tab Wiew Report Search Tools Help
’Import P Report - A Archive 3 Restore x Delete q Search | Prink List
| L | | | A | —

Payes Name Check Date

Payer Name
AREA IMSURAMNCE

L | i
Claim List Clairn Detail I Remit Summary \ I Data Yiew I Search I Glossary I
Name | ACNT R |___Billed Amount | Paid amount | FromDate | ToDate | &
boe, sally 1111111 S4EA739012345 -910.,50 -402.53 2/10/2004 2/10/2004 .
Oooe, sally 1111111 1ba4Ea75001 2345 910,50 £57.28 241072004 2i10/2004 .
Oooe, sally 1111111 14345675001 2345 38,20 12,50 2{11/2005 20112005 .
Oright, sarmuel 1111111 133456789012345 237.60 159.36 3(28/2005 3/28/2005 .
Ooce, saly 1111111 12h456789012345 406.20 32.67 2(10{2005 241042005 .
Ooce, saly 1111111 123456789012345 148,50 az.42 349/2005 3/9/2005 .
Oright, sarmuel 1111111 123456789012345 40,00 0,00 12iz2fP003 12}22}2003 .

| | 2l

L Print EAcheckal | []uncheck &l ﬂ’\ Data

Segment count = =206 12f6f2011

2. On the top of the window, click the Del\ete button.
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The Delete selected import file(s) window opens.

Hint:
To delete all the claim o
files on the list, place a

H Payer Name Payes Name Paxes o} I Check Date Chac&EFT IChe:lS:EFT Claims I ™ Check 4l
checkmark in the Check o ACIE PHYSTCIANS THC 235E7S 04j23105 lerr |7 [1z3] e

All box. When you
check that box
checkmark is placed in
front of all the claims in

the list.
: | | _’I Lancel
1 item selected for deletion, 4

3. Select the file(s) you want to delete by checking the box(es
This activates the Delete button.
4. Click the Delete button.
Medicare Remit Easy Print deletes the file(s).

© 2005 General Dynamics IT Company. All Rights Reserved.
This document contains GDIT confidential and proprietary information,
which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs.

214



Medicare Remit Easy Print Using Keystroke Shortcuts

Using Keystroke Shortcuts

You can use a series of keystrokes to complete a number of tasks.

To Do This... Use This
Combination...
Import a HIPAA 835 file Alt+F +1
View a list of claims Alt+V +L
View claim detail Alt+V+D
View totals Alt+V +S
View the way the data is stored in the file Alt+V+V
Search the Remittance Advice Alt+V+E Or
Alt+S+S
View the CARC and RARC codes for the Remittance Advice Alt+V+G
Look up the meaning of a CARC/RARC code Alt+T+C
Print the Denied Service Lines Report Alt+R+D+P
Export the Denied Service Lines Report Alt+R+D+E
Print the Adjusted Service Lines Report Alt+R+A+P
Export Adjusted Service Lines Report Alt+R+A+E
Print the Deductible Service Lines Report At+R+E+P
Export the Deductible Service Lines Report At+R+E+E
Print the Entire Remittance Report Alt+R+R + P
Archive Import files Alt+T+A
Restore archived Import files Alt+T+R
Delete Import files Alt+T+D
With the Claim List Tab Selected:
Print Claim List At+B+P
Check all claims in the list Alt+B+C
Uncheck all claims in the list Alt+B+ U
Claim display (single line format) Alt+B+D
* Claim must be highlighted

With the Claim Detail Tab Selected:
Print Claim Detail Alt+B+ P
Zoom In Alt+B + 1
Zoom Out At+B+0O
Reset Zoom At+B+R
Show Glossary ( check box ) Alt+B+S
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Using Keystroke Shortcuts

To Do This... Use This
Combination...

With the Remit Summary Tab Selected:
Print Summary Alt+B+ P
Zoom In Alt+B +1
Zoom Out Alt+B+0O
Reset Zoom Alt+B+R
With the Search Tab Selected:
Print Results Alt+B+ P
Results Claim Detail Alt+B+C
With the Glossary Tab Selected:
Zoom In Alt+B +1
Zoom Out Alt+B+0O
Reset Zoom At+B+R
Codes At+B+C
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Appendix A: MREP RA/HIPAA 835v5010 Segment Field
Crosswalk

This information can help you if you need to troubleshoot the Import file.

Note: This appendix represents the fields of an 835v5010 electronic remittance advice. However, MREP can
also print or display remittances in the 4010Alformat. Fields marked with an asterisk (*) below are not
found on the 4010A1 format and do not appear when printed or shown.

Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments
Payer (Contractor) Name 1000A N102 N101 = ‘PR’
Payer (Contractor) Address 1000A N301 N101 = ‘PR’, ADDR1
N302 N101 = ‘PR’, ADDR2
Payer (Contractor) City 1000A N401 N101 = ‘PR’
Payer (Contractor) State 1000A N402 N101 = ‘PR’
Payer (Contractor) Zip 1000A N403 N101 = ‘PR’
* PAYER'S WEB SITE: 1000A PERO4 PERO1 ="‘IC
* PAYER BUSINESS 1000A PERO1=‘'CX
CONTACT INFORMATION:
* Name PERO2
* Email Address (up to 50 PERO04 or PERO6 PERO3 or PEROS = ‘EM’
positions) (respectively)
* Telephone Number PERO04 and PERO6 PERO3 = ‘TE’ and PERO5 = ‘EX’
PERO06 and PERO8 PERO5 = ‘TE’ and PERO7 = 'EX’
* PAYER TECHNICAL 1000A PERO1=‘BL’
CONTACT INFORMATION:
Payee (Provider) Name 1000B N102 N101 = ‘PE’
Payee (Provider) Address 1000B N301 N101 = ‘PE’, ADDR1
N302 N101 = ‘PE’, ADDR2
Payee (Provider) City 1000B N401 N101 = ‘PE’
Payee (Provider) State 1000B N402 N101 = ‘PE’
Payee (Provider) Zip 1000B N403 N101 = ‘PE’
PROVIDER # 1000B N104 N101 = ‘PE’ & N103 = ‘XX’
&rPI # (I;rEFOZ Payee level REF01 = ‘1C’
Date BPR16
CHECKI/EFT # TRNO2 BPR04 = ‘CHK’ or ‘EFT’ or ‘NON’
Assigned claims LX01 = ‘1’, pertains only to
Medicare
NAME 2100 NM103 NM101 = ‘QC’
(Patient Last Name)
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Remittance Advice Field

Appendix A: MREP RA/HIPAA 835v5010 Segment Field Crosswalk

835 Loop ID

835 Segment Field

Identification/Comments

(Coinsurance Amount)

CASQ9 or CAS12 or
CAS15 or CAS18

NAME 2100 NM104 NM101 = ‘QC’ / NM102 = ‘1’
(Patient First Name)
NAME 2100 NM105 NM101 = ‘QC’ / NM102 = ‘1’
(Patient Middle Name)
HIC 2100 NM109 NM108 = ‘HN’
(Patient ID)
ACNT 2100 CLPO1
(Patient Account Number)
ICN CLPO7
(Claim Control Number)
ASG 2000 Hard-coded Y’ for Medicare when
(Claim Assignment) LX01="1
MOA 2100 MOAO03, MOAO04,
i MOAO5, MOAOS,
(Claim Level Remark Codes) MOAQ7
REND PROV 2110 REF02 REFO1 = HPI or
(Rendering Provider) REF01 =‘1C’
2100 NM109 or NM108 = ‘XX’ or
REF02 REFO01 = ‘1C’
1000B N104 or N103 = ‘XX or

REFO02 or REFO01 = ‘XX’

spaces
SERV-DATE 2110 DTMO02 Line level DTMO1 = ‘150’ or ‘472’
(From Service Date) else Claim level DTMO1 = ‘232’
SERV-DATE 2110 DTMO02 Line level DTMO1 = ‘151’ or ‘472’
(To Service Date) else Claim level DTMO01 = ‘233’
POS 2110 REF02 REFO1 = ‘LU’
(Place of Service)
PD-NOS 2110 SVCO05
(Paid Number of Services)
PD-PROC 2110 SVC01-2 SVCO01-1 = 'HC’ or ‘N4’
(Procedure code — paid and if
down-coded then the original
procedure appears under
SUB-PROC.)
MODS 2110 SVCO01-3, SVC01-4, SVCO01-1 = ‘HC’ or ‘N4’
(Procedure Code Modifiers) SVCO01-5, SVC01-6
BILLED 2110 SvCo02
(Billed Amount)
ALLOWED 2110 AMTO2 AMTO1 = 'B6’
(Allowed Amount)
DEDUCT 2110 CASO03 or CAS06 or CASO1 = ‘PR’ & (CAS02 = ‘1" or
(Deductible Amount) CASQ9 or CAS12 or CASO05 =1’ or CAS08 =1’ or

CAS15 or CAS18 CAS11 ='1" or CAS14 =‘1"or

CAS17 ='1")

COINS 2110 CASO03 or CAS06 or CASO1 = ‘PR’ & (CAS02 = ‘2’ or

CASO05 = 2" or CAS08 =2’ or
CAS11 =2 or CAS14 ='2" or
CAS17 ='2)
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835 Loop ID

835 Segment Field

Identification/Comments

(Billed Amount)

GRP/CARC 2110 CAS01-CAS02, CAS05, | Do not print CASO1 = ‘PR’ and

(Group/Claim Adjustment CASO08, CAS11, CAS14, | ((CAS02 ='1" or ‘2") or (CASO05 =

Reason Code) CAS17 ‘1’ or ‘2") or (CAS08 ‘1’ or ‘2') or
(CAS11="1"or‘2") or (CAS14="1"
or '2") or (CAS17 ‘1’ or ‘2")); hard-
code dash between group code
and reason code

CARC-AMT 2110 CASO03 or CAS06 or Do not print CASO1 = ‘PR’ and

(Claim Adjustment Reason CASOQ09 or CAS12 or ((CAS02 =1 or '2") or (CASO5 =

Code Amount) CAS15 or CAS18 ‘1’ or ‘2’) or (CAS08 ‘1’ or ‘2') or
(CAS11="1"or‘2") or (CAS14 =1’
or ‘2) or (CAS17 ‘1’ or ‘29)

ADJ-QTY 2110 CASO04 or CASO7 or Do not print CASO1 = ‘PR’ and

(Adjustment Quantity) CAS10 or CAS13 or ((CAS02 =1’ or ‘2’) or (CAS05 =

CAS16 or CAS19 ‘1’ or ‘2’) or (CASO08 ‘1’ or ‘2') or

(CAS11="1"or‘2") or (CAS14="1"
or ‘2) or (CAS17 ‘1’ or ‘29)

BS Based on the CARC

(CAQH CORE-defined

Business Scenario)

PROV-PD 2110 SVCO03

(Provider Paid Amount)

SUB-NOS : 2110 SvCo7 If paid units of service (SVCO05) do

(Submitted Number of not equal submitted units of

Services) service

SUB-PROC 2110 SVC06-2, SVCO06-3,

(Submitted Procedure Code) SVC06-4, SVC06-5,

SVCO06-6

RARC 2110 LQO2 LQO1 = ‘HE’

(Line Level Remark Codes)

* CNTL #: 2110 REF02 REF01 = ‘6R’

(Line Item Control Number)

* HCPI: 2110 REF02 REFO01 = ‘0K’ (zero K)

(HealthCare Policy

Information)

PT RESP 2100 CLPO5

(Patient Responsibility)

CARC Sum of all lines CAS monetary

(Total of all Claim Adjustment amounts, except those associated

Reason Code amounts) with adjustment reason codes ‘1’
and ‘2’ (Group code PR)

CLAIM TOTALS 2100 CLPO3

CLAIM TOTALS
(Allowed Amount)

Sum of all lines AMT02, when
AMTO1 = ‘B6’

CLAIM TOTALS
(Deductible Amount)

Sum of all lines CAS monetary
amounts, when CASO1 = ‘PR’ and
the corresponding adjustment
reason code equals ‘1’

CLAIM TOTALS
(Coinsurance Amount)

Sum of all lines CAS monetary
amounts, when CASO1 = ‘PR’ and
the corresponding adjustment
reason code equals ‘2’
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835 Loop ID

835 Segment Field

Identification/Comments

Identification Number)

CLAIM TOTALS 2100 CLPO4

(Provider Paid Amount)

ADJ TO TOTALS: PREV PD Not available

(Adjustment to Totals:

Previous Paid Amount)

ADJ TO TOTALS: INTEREST | 2100 AMTO2 Claim level AMTO1 = ‘I’

(Adjustment to Totals: Interest

Amount)

ADJ TO TOTALS: LATE 2110 Sum of all line level AMTO02, when

FILING CHARGE AMTO1 = ‘KH’

(Adjustment to Totals: Late

Filing Charge)

NET Sum of all the line level provider
paid amts plus adj to totals:
interest minus adj to totals: late
filing charge

GRP/CARC 2100 CAS01-CAS02, CASO05, | Do not print CAS01-CAS02,

(Group Code/Claim CASO08, CAS11, CAS14, | CAS05, CAS08, CAS11, CAS14,

Adjustment Reason Code) CAS17 CAS17

CARC-AMT 2100 CASO03 or CASO06 or Do not print CAS03 or CAS06 or

Claim Adiustment R CASQ9 or CAS12 or CASQ9 or CAS12 or CAS15 or

o Ao ent Reason CAS15 or CAS18 CAS18

BS Based on the CARC

(CAQH CORE-defined

Business Scenario)

CLAIM INFORMATION 2100 NM101 =TT

FORWARDED TO:

(Crossover Carrier Name) NM103 NM102 = ‘2’

* (Crossover Carrier Identifier) NM109 NM108 = ‘PI' or ‘XV’

* CORRECTED PRIORITY 2100 NM101 = ‘PR’

PAYER INFO:

* (Corrected Priority Payer NM103 NM102 = ‘2’

Name)

* (Corrected Priority Payer NM109 NM108 = ‘PI' or ‘XV’

TOTALS: # OF CLAIMS

Number of CLP segments within a
LX

TOTALS: BILLED AMT
(Total — Billed Amount)

Sum of CLP03

TOTALS: ALLOWED AMT
(Total — Allowed Amount)

Sum of AMT02 when AMTO1 =
‘B6'

TOTALS: DEDUCT AMT
(Total — Deductible Amount)

Sum of CAS monetary amts, when
CASO01 = ‘PR’ and the
corresponding adjustment reason
code equals ‘1’

TOTALS: COINS AMT
(Total — Coinsurance Amount)

Sum of CAS monetary amts, when
CASO01 = ‘PR’ and the
corresponding adjustment reason
code equals ‘2’
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835 Loop ID

835 Segment Field

Identification/Comments

TOTAL: CARC-AMT

(Total — Claim Adjustment
Reason Code Amount)

Sum of CAS monetary amounts,
excepting those associated with
adjustment reason codes ‘1’ and
o

TOTALS: PROV-PD AMT

(Total — Provider Paid
Amount)

Sum of CLP04

TOTALS: PROV ADJ AMT
(Total — Provider Adjustment

Sum of AMT02 when AMTO1 =
‘B6’ and ‘KH’

Amount) (The sum of the details (amount) in
the PROVIDER ADJ DETAILS
section.)

CHECK AMT BPRO2

(Check Amount)

Provider Adjustment Details

PLB REASON CODE

PLBO03-1, PLB05-1,
PLBO7-1, PLB09-1,
PLB11-1, PLB13-1

FCN/OTHER IDENTIFIER

Positions 1-50 of

PLB03-2, PLB05-2,
PLBO0O7-2, PLB09-2,
PLB11-2, PLB13-2

AMOUNT

PLBO4, PLBO6, PLBO08S,
PLB10, PLB12, PLB14

Summary of non-assigned clai

ms

LX01 = ‘0’, pertains only to
Medicare

(Claim Level Remark Codes)

MOAOQ5, MOAOG,
MOAQ7

NAME 2100 NM103 NM101 = ‘QC’

(Patient Last Name)

NAME 2100 NM104 NM101 = ‘QC’ / NM102 = ‘1’
(Patient First Name)

NAME 2100 NM105 NM101 = ‘QC’' / NM102 = ‘1’
(Patient Middle Name)

HIC 2100 NM109 NM108 = ‘HN’

(Patient ID)

ACNT 2100 CLPO1

(Patient Account Number)

ICN CLPO7

(Claim Control Number)

ASG 2000 Hard-coded ‘N’ for Medicare when
(Claim Assignment) LX01="0r

MOA 2100 MOAO03, MOA04,
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835 Loop ID

835 Segment Field

Identification/Comments

(Adjusted Quantity)

CAS10 or CAS13 or
CAS16 or CAS19

REND PROV 2110 REF02 REFO1 = HPI or
(Rendering Provider) REFO1 = ‘1C’
2100 NM109 or NM108 = ‘XX or
REF02 REFO1 = ‘1C’
1000B N104 or N103 = ‘XX or
REFO2 or REFO01 = ‘XX’
spaces
SERV-DATE 2110 DTMO02 Line level DTMO1 = ‘150’ or ‘472’
(From Service Date) else Claim level DTMO1 = ‘232’
SERV-DATE 2110 DTMO02 Line level DTMO1 = ‘151’ or ‘472’
(To Service Date) else Claim level DTMO1 = ‘233’
POS 2110 REF02 REFO1 = ‘LU’
(Place of Service)
PD-NOS 2110 SVCO05
(Paid Number of Services)
PD-PROC 2110 SVC01-2 SVCO01-1 = 'HC’ or ‘N4’
(Procedure code — paid and if
down-coded then the original
procedure appears.)
MODS 2110 SVCO01-3, SVC01-4, SVCO01-1 = ‘HC’ or ‘N4’
(Procedure code modifiers) SVCO01-5, SVC01-6
BILLED 2110 SvCo02
(Billed Amount)
ALLOWED 2110 AMTO02 AMTO1 = ‘B6’
(Allowed Amount)
DEDUCT 2110 CASO03 or CASO06 or CASO01 = ‘PR’ & (CAS02 ='1" or
(Deductible Amount) CASQ9 or CAS12 or CASO05 =1’ or CAS08 =1’ or
CAS15 or CAS18 CAS11 ='1"or CAS14 ="1"or
CAS17 ='1")
COINS 2110 CASO03 or CAS06 or CASO1 = ‘PR’ & (CAS02 =2 or
(Coinsurance Amount) CASQ9 or CAS12 or CASO05 = ‘2" or CAS08 =2’ or
CAS15 or CAS18 CAS11 ='2"or CAS14 ="2"or
CAS17 ='2))
GRP/CARC 2110 CAS01-CAS02, CASO05, | Do not print CASO1 = ‘PR’ and
(Group Code/ Claim CASO08, CAS11, CAS14, | ((CAS02 ='1"or ‘2") or (CAS05 =
Adjustment Reason Code) CAS17 ‘1’ or ‘2") or (CASO08 ‘1’ or ‘2') or
(CAS11="1"or ‘2) or (CAS14 =1
or ‘2") or (CAS17 ‘1’ or ‘2")); hard-
code dash between group code
and reason code
CARC-AMT 2110 CASO03 or CAS06 or Do not print CASO1 = ‘PR’ and
(Claim Adjustment Reason CASOQ09 or CAS12 or ((CAS02 =1 or '2") or (CASO5 =
Code Amount) CAS15 or CAS18 ‘1’ or ‘2") or (CASO08 ‘1’ or ‘2') or
(CAS11="1"or ‘2) or (CAS14 =1
or ‘2") or (CAS17 ‘1’ or ‘'2"))
ADJ-QTY 2110 CASO04 or CASO7 or Do not print CASO1 = ‘PR’ and

((CAS02 = ‘1’ or ‘2') or (CAS05 =
‘1’ or ‘2") or (CASO08 ‘1’ or ‘2') or
(CAS11 =1 or ‘2") or (CAS14 =1’
or ‘2") or (CAS17 ‘1’ or ‘'2")

BS

(CAQH CORE-defined
Business Scenario)

Based on the CARC
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835 Loop ID

835 Segment Field

Identification/Comments

(Claim Adjustment Reason
Code Amount)

CASQ9 or CAS12 or
CAS15 or CAS18

PROV-PD 2110 SVCO03

(Provider Paid Amount)

SUB-NOS 2110 SVCo7 If paid units of service (SVCO05) do

(Submitted Number of not equal submitted units of

Services) service

SUB-PROC 2110 SVCO06-2, SVC06-3,

(Submitted procedure code) SVCO06-4, SVC06-5,

SVC06-6

RARC 2110 LQ02 LQO1 = ‘HE’

(Line Level Remark Codes)

PT RESP 2100 CLPO5

(Patient Responsibility)

CARC Sum of all lines CAS monetary

(Total of all Claim Adjustment amounts, except those associated

Reason Code amounts) with adjustment reason codes ‘1’
and ‘2’ (Group code PR)

CLAIM TOTAL 2100 CLPO3

(Billed Amount)

CLAIM TOTAL Sum of all lines AMTO02, when

(Allowed Amount) AMTO1 = B6.

CLAIM TOTAL Sum of all lines CAS monetary

(Deductible Amount) amounts, when CASO1 = ‘PR’ and
the corresponding adjustment
reason code equals ‘1’

CLAIM TOTAL Sum of all lines CAS monetary

(Coinsurance Amount) amounts, when CASO1 = ‘PR’ and
the corresponding adjustment
reason code equals ‘2’

CLAIM TOTAL 2100 CLPO4

(Provider Paid Amount)

ADJ TO TOTALS: PREV PD Not available

(Adjustment to Totals:

Previous Paid Amount)

ADJ TO TOTALS: INTEREST | 2100 AMTO2 Claim level AMTO1 = ‘I’

(Adjustment to Totals: Interest

Amount)

ADJ TO TOTALS: LATE 2110 Sum of all line level AMTO02, when

FILING CHARGE AMTO1 = ‘KH’

(Adjustment to Totals: Late

Filing Charge)

NET Sum of all the line level provider
paid amts plus adj to totals:
interest minus adj to totals: late
filing charge

GRP/CARC 2100 CAS01-CAS02, CAS05, | Do not print CAS01-CAS02,

(Group Code/Claim CASO08, CAS11, CAS14, | CASO05, CAS08, CAS11, CAS14,

Adjustment Reason Code) CAS17 CAS17

CARC-AMT 2100 CASO03 or CASO06 or Do not print CAS03 or CAS06 or

CASQ09 or CAS12 or CAS15 or
CAS18
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Remittance Advice Field 835 Loop ID 835 Segment Field Identification/Comments

BS Based on the CARC
(CAQH CORE Code-defined
Business Scenario)

CLAIM INFORMATION 2100 NM101 =TT
FORWARDED TO:
* (Crossover Carrier Name) NM103 NM102 = ‘2’
* (Crossover Carrier Identifier) NM109 NM108 = ‘PI' or ‘XV’
* CORRECTED PRIORITY 2100 NM101 = ‘PR’
PAYER INFO :
* (Corrected Priority Payer NM103 NM102 = 2’
Name)
* (Corrected Priority Payer NM109 NM108 = ‘PI' or ‘XV’
Identification Number)
* OTHER CLAIM REL 2100 REF02 when
IDENTIFICATION REFO1="1L", ‘1W’, '28’,

‘6P, ‘9A’, ‘9C’,

‘BB’, ‘CE’, ‘EA’, 'F8’,
‘Gl’, ‘G3, 'IG’ OR 'SY’

GLOSSARY MOAO03, MOAO4, If there are duplicates, only print
MOAO05, MOAO0S6, once

MOAO07, CASO01,
CAS02, CAS05, CASO08,
CAS11, CAS14, CAS17,
BS
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Appendix B: Abbreviation and Acronym Glossary

The following two column table provides the abbreviations or acronym values in the first
column, and the second column contains the descriptions.

Abbreviation or Acronym Description
Value

ACNT Account
ADJ Adjustment
ADJ-QTY Adjustment Quantity
Adjst Adjustment
AMT Amount
ASG Assignment of claim
Bene Beneficiary
BS CAQH CORE-defined Business Scenario
CARC Claim Adjustment Reason Code
CARC-AMT Claim Adjustment Reason Code Amount
CNTL# Control Number
CcOB Coordination of Benefits
COIN Coinsurance
Coins Coinsurance
Deduct Deductible
DMERC Durable Medical Equipment Resource Center
ERA Electronic Remittance Advice
EFT Electronic Funds Transfer
GRP/CARC Group and Claim Adjustment Reason Codes
HCPCS Health Care Procedure Codes
HCPI Health Care Policy Information
HIC Health Insurance Claim Number
HICN Health Insurance Claim Number
HIPAA Health Insurance Portability and Accountability Act
ID Identifier
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Abbreviation or Acronym Description

Value

ICN Internal Control Number

MOA Medicare Outpatient Adjudication
MODS Modifiers

MREP Medicare Remit Easy Print

MSP Medicare Secondary Payer

NDC National Drug Code

NPI National Provider Identifier

NOS Number of Services

Orig Original

PD-NOS Number of Services — Paid
PD-PROC Procedure Code — Paid

PHI Personal Health Information

PLB Provider Level Balancing

POS Place of Service

PREV PD Previous Paid

PROC Procedure Code

PROV Provider

PROV-PD Provider Paid

PT RESP Patient Responsibility

RARC Remittance Advice Remark Code
Remit Remittance Advice
REND-PROV Rendering Provider
SERV-DATE Service Dates

SPR Standard Paper Remittance advice
SUB-NOS Submitted Number of Services
SUB-PROC Submitted HCPCS Procedure Code
Zip ZIP Code

© 2005 General Dynamics IT Company. All Rights Reserved.
This document contains GDIT confidential and proprietary information,

which shall not be used, disclosed, or reproduced for any purpose other than the conduct of GDIT business affairs.

226




	Table of Contents
	About Medicare Remit Easy Print
	What’s New
	Informational
	Differences between MREP Remittance Advices and Shared System SPRs
	About This Guide
	Need Assistance?
	PC Requirements
	Operating System Requirements
	How Does Medicare Remit Easy Print Get Medicare Remittance Info?
	Information for Administrators
	Network Installations
	Pre-Installation Checklist for Installation on a Network
	Installing Medicare Remit Easy Print on a Network
	Before You Install Medicare Remit Easy Print on a Network
	How to Install Medicare Remit Easy Print on the Network

	Installing the Medicare Remit Easy Print Group Code on the PC
	How to Install the Medicare Remit Easy Print Group Code
	How to Know that the Medicare Remit Easy Print Group Code Install Completed Successfully


	PC Installations
	Getting Started
	Pre-Installation Checklist for Installation on a PC
	Installing Medicare Remit Easy Print
	Before You Install Medicare Remit Easy Print
	How to Install Medicare Remit Easy Print on Your PC

	Starting Medicare Remit Easy Print
	Before You Start Medicare Remit Easy Print
	How to Start Medicare Remit Easy Print


	Locating MREP and MREP File Locations on Your PC/Network
	Locating the MREP Application on Your PC/Network – Icon Available
	Locating the MREP Application on Your PC/Network – Icon not Available
	Identifying Easy Print File Locations

	Uninstalling Medicare Remit EasyPrint
	Online Help System
	How to Access the Online Help System
	How to Use the Contents Tab
	How to Use the Index Tab
	How to Use the Search Tab
	How to Close the Medicare Remit Easy Print Help Window


	Importing HIPAA 835 files
	Before You Import the HIPAA 835 File
	Import File Name Format
	How to Import the HIPAA 835 File
	How to Automatically Import the HIPAA 835 File
	What to Do with an Import Error Message
	Import Exception Summary Window/Report

	Working with MREP Remittance Advices
	How to View a List of Claims for an MREP Remittance Advice
	How to View the Detail for a Claim
	How to View the Total Amounts for a Remittance Advice
	How to View the Data in the Import File
	How to View the CARC and RARC Codes
	How to Look up a CARC/RARC Code, Group Code, or CORE Business Scenario
	How to Update (Import) the CARC/RARC Codes, Group Codes, and CORE Business Scenarios
	How to Print a List of Claims
	How to Print the Detail for a Claim
	How to Print the Remittance Advice Summary
	Searching Payment Information
	How to Search Payment Information

	Making Sense of the Claim List Tab
	Display Claim(s)

	Making Sense of the Claim Detail Tab
	Making Sense of the Remit Summary Tab
	Making Sense of the Data View Tab
	Making Sense of the Search Tab
	Making Sense of the Glossary Tab

	Working with Reports
	Making Sense of the Denied Service Lines Report
	Making Sense of the Adjusted Service Lines Report
	Making Sense of the Deductible Service Lines Report
	Making Sense of the Coinsurance Service Lines Report
	Making Sense of the Deductible/Coinsurance Service Lines Report
	Making Sense of the COB Claims Report
	Making Sense of the Non-COB Claims Report
	Making Sense of the MSP Claims Report
	Making Sense of the Non-MSP Claims Report
	Making Sense of the Other Adjustments Report
	How to Print the Denied Service Lines Report
	How to Export the Denied Service Lines Report
	How to Print the Adjusted Service Lines Report
	How to Export the Adjusted Service Lines Report
	How to Print the Deductible Service Lines Report
	How to Export the Deductible Service Lines Report
	How to Print the Coinsurance Service Lines Report
	How to Export the Coinsurance Service Lines Report
	How to Print the Deductible/Coinsurance Service Lines Report
	How to Export the Deductible/Coinsurance Service Lines Report
	How to Print the COB Claims Report
	How to Export the COB Claims Report
	How to Print the Non-COB Claims Report
	How to Export the Non-COB Claims Report
	How to Print the MSP Claims Report
	How to Export the MSP Claims Report
	How to Print the Non-MSP Claims Report
	How to Export the Non-MSP Claims Report
	How to Print the Other Adjustments Report
	How to Export the Other Adjustments Report
	How to Print the Entire Remittance Report

	Housekeeping for the Import Files
	Archiving Import Files
	How to Archive Import files

	Restoring Import files
	How to Restore Import files

	Deleting Import files
	How to Delete an Import file


	Using Keystroke Shortcuts
	Appendix A: MREP RA/HIPAA 835v5010 Segment Field Crosswalk
	Appendix B:  Abbreviation and Acronym Glossary

